
8
The Color Page



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

358

The Color page is the heart of DaVinci Resolve. Within the Color page are all of the controls 
available for manipulating color and contrast, reducing noise, creating limited secondary color 
corrections, building image effects of different kinds, adjusting clip geometry, and making many 
other corrective and stylistic adjustments.
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In this chapter, you’ll learn how to understand the Color page interface, how to customize it, and 
how to work within it to play through and navigate your project’s timeline. You’ll also learn how to 
analyze and compare clips in preparation for grading using stills, playheads, and DaVinci Resolve’s 
own internal video scopes.
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The Color page is divided into seven main areas that work together to let you build a grade. This 
section provides an overview of what these areas are and how they function.

The default layout of the Color Page

Viewer

The Viewer shows the frame at the current position of the playhead in the Timeline. At the top of 
the Viewer is a header that displays the Project and Timeline names, as well as a Viewer Timecode 
display that shows the source timecode of each clip by default. The Timeline name is also a pop-
up display that lets you switch to any other timeline in the project. A scrubber bar underneath the 
image lets you drag the playhead across the entire duration of the clip, while transport controls 
underneath that let you control playback. Additional controls let you loop playback, switch Unmix 
mode on and off, turn audio playback on and off, and choose which on-screen controls are currently 
displayed. More information about using the Viewer appears later in this chapter.

Viewer with transport controls

The Color Page Interface
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Gallery

The Gallery is used for storing still frames to use as reference, and grades you might like to copy; 
stills and grades are stored together. A button lets you open up the Album browser, used for 
organizing your stills. At the bottom of the Gallery, Memories let you store grade information that 
you can apply using a control surface or keyboard shortcuts. The Gallery on the Color page mirrors 
the contents of the Gallery page. For more information on the Gallery page, see Chapter 7, “Using 
the Gallery.”

The Gallery has Memories, Stills saved in Albums and your PowerGrades
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Node Editor

The Node Editor is where you assemble one or more individual corrections (nodes) together into 
a complete multi-correction grade (node tree). This is a powerful way of assembling grades, since 
different types of nodes let you create different combinations of corrections and very specific 
adjustments by reordering operations, combining keys, or changing the layer order of different 
adjustments. More information about the Node Editor appears in “Node Editor Basics.”

Node Editor to construct your grade processing signal flow
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Timeline

The Timeline provides several ways of navigating the clips in your project, as well as keeping track 
of what has been done to which clips. The Timeline is divided into three parts, each of which shows 
different information and provides differing controls.

A Timeline Ruler at the top lets you scrub the playhead across multiple clips, and can be zoomed 
out enough to show every clip in your entire program. 

The Thumbnail timeline with a Mini-Timeline above

Underneath, the Mini-Timeline shows a small representation of the Timeline in the Edit page wherein 
each clip is as long as its actual duration. The currently selected clip is orange, and you can click 
any clip to select it. A scroll bar at the bottom lets you navigate to the left and right, while using the 
scroll wheel of your mouse zooms in and out. The Mini-Timeline shows at most six tracks of video. 
If your project has more tracks than that, you can scroll up and down to reveal the hidden tracks. 

At the bottom of the Timeline is the Thumbnail timeline, in which each clip is represented by a 
single frame. The currently selected clip is outlined in orange, and information appears above and 
below each thumbnail such as each clip’s source timecode, clip number and track number, version 
name, whether it’s been graded, whether it’s been tracked, if it’s been flagged, and so on.

Clip Thumbnail

More information about working with the Timeline appears later in this chapter.
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Left Palettes

A series of palettes at the bottom left of the Color page provide access to different sets of grading 
tools, used principally for manipulating color, contrast, and raw media format settings. Each 
individual palette is opened by clicking the corresponding icon at the top of the Palette panel.

Left palette selection buttons

The four available palettes are the Camera Raw palette (for making metadata adjustments to raw 
media formats), the Color Wheels (graphical color balance controls and master wheels), the Primary 
controls (sliders for adjusting YRGB Lift/Gamma/Gain), the RGB Mixer (for mixing color channels 
into one another), and the Motion Effects palette (with controls for noise reduction and artificial 
motion blur).

These palettes can be used individually or together depending on what you’re trying to accomplish. 
More information about each color palette appears in “Color Controls.”

Center Palettes

At 1920x1080 resolution or higher, a second set of palettes is organized at the bottom center of the 
Color page. These palettes span a wide range of functionality, and the adjustments you make with 
them can be combined with those made using the Color palettes.

Center palette selection buttons

Note: At lower resolutions, the Left and Center palettes are merged to fit the Resolve interface into 
a smaller area.

The nine available Center palettes include the Curves palette, the Qualifiers palette, the Power 
Windows palette, and Tracker palette, the Blur palette, the Key palette, the Sizing and Stereoscopic 
3D palettes, and the Data Burn-In palette.
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Keyframes Editor

The Keyframes Editor provides an interface for animating Color, Sizing, and Stereo Format 
adjustments over time.

Keyframe Editor displaying dynamic grade changes

Each node in the Nodes Editor corresponds to a track in the Keyframes Editor, which lets you 
animate each node’s adjustments independently. Furthermore, each node’s track can be opened 
up to reveal Parameter Groups, so that you can animate subsets of an individual node’s functions 
independently of other functions within the same node.

More information about working with the Keyframes Editor can be found in “Keyframing.”
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The various sections of the Color page can be resized, hidden, and rearranged as needed to 
accommodate different working styles. This section covers all of the methods that are available for 
Color page customization.

You can easily resize the Viewer, Gallery, and Nodes Editor relative to one another to make the 
Viewer larger, expand the width of the Nodes Editor to have more workspace, or to create more or 
less room for stills in the Gallery.

To resize the Viewer, Gallery, and Node Editor:

 >Move the pointer over the vertical divider between any two areas. When the resize icon 
appears, drag the divider to the left or right to make one area larger while making the other 
smaller.

You can also fully expand the Gallery, the Memories, the Nodes Editor, and the Keyframe Editor to 
replace completely whichever interface area is adjacent.

To expand the Node Editor, and Keyframe Editor:

 > Click the Expand control at the bottom left of whichever interface area you want to expand. 
Once expanded, clicking the Expand control again will collapse that interface area back to 
its original size, revealing whatever was hidden.

In Display mode, you can completely hide the Viewer, pushing the Gallery all the way to the right 
side of the Resolve window, and expanding the Nodes Editor to take the rest of the space.

To toggle Display mode, do one of the following:

 > Right-click in the empty area of the Nodes Editor, and choose Display Mode from the 
contextual menu. Do this again to toggle Display Mode off and return the interface to the 
way it was.

 > Press SHIFT UP and DISPLAY/CURSOR, above the fourth trackball of the Center panel of 
the DaVinci control surface.

To return all pages to their default layout:

1. Choose View > Reset UI Layout

Customizing the Color Page



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

371

The Viewer is your window into the Timeline. The clip and frame at the current position of the 
playhead appears in the Viewer. The Viewer also provides a workspace for picking colors, adjusting 
Power Windows, using split-screen stills for reference, and many other display-oriented tasks. If you 
have a video out interface connected to a broadcast display or projector, then the contents of the 
Viewer are typically mirrored by the video output.

On-Screen Controls and External Displays

DaVinci Resolve has been designed for use with calibrated external displays connected to video 
output interfaces, and for most colorists working on broadcast or theatrical programs, this is the 
recommended way to work for color critical evaluation. 

Because of this, many of the on-screen controls associated with tasks such as color sampling, 
window adjustment, and key manipulation are mirrored to your video output, making it possible to 
hide the Viewer on your computer’s monitor and work with only an external display.

To choose whether on-screen controls are mirrored to video out, or disabled:

 > Choose an option from the View > Window Outline submenu. There are three options:

 >Off: Hides the window outline on both the external display and the Viewer.

 >On: The default, shows the window outline on both the external display and the Viewer.

 >Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

To show or hide window on-screen controls using the DaVinci control surface:

 > Press SHIFT UP and then DISPLAY/CURSOR, above the fourth trackball on the Center panel. 
This command is a three-way toggle. The first use of this command hides the window outline 
on your external display, but leaves it in the Viewer. The second use of this command hides 
the window outline on both the external display and Viewer. The third use of this command 
shows the window outline on both the external display and Viewer.

Using the Viewer
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Grading With the Viewer on a Computer Display

Since most computer displays do not operate at the color critical tolerances or specifications 
required for broadcast or theatrical delivery, you’ll likely need an external broadcast display of some 
type. However, it’s worth noting that the Viewer displays each clip’s image data as it is handled by 
the calibration that your operating system applies to your computer display, making it eminently 
suitable for monitoring projects destined for the sRGB standard of the web if you have a high-
quality, sRGB-calibrated computer monitor.

Additionally, you can apply a dedicated Viewer LUT using the 1D/3D Color Viewer Lookup Table 
pop-up menu, found in the Look Up Tables panel of the Settings window. This lets you calibrate 
a computer display in the same way you would calibrate an external display, using a probe and 
color management software, and apply the resulting calibration LUT in Resolve. Keep in mind that 
monitor calibration can only make a high-quality display standards compliant, it cannot make up for 
a display gamut that’s too small. For more information, see the “Look Up Tables” section of Chapter 
2, “Logging In, The Project Manager, and Settings.”

The On-Screen Control (OSC) Menu

The On-Screen Control pop-up menu lets you choose which on-screen control you want to display 
in the Viewer. There are four choices:

The on-screen control menu for the Viewer

 >None: All on-screen controls are hidden from view, giving you an unimpeded display of the 
image in the Viewer.

 >Qualifier: Turns on the Color Sample cursor, which lets you choose a color using the fourth 
trackball of the DaVinci control surface. For more about using Color Sample controls, see 
“Secondary Qualifiers.” 

 > Power Window: Turns the Power Windows on-screen control on and off. For more about 
adjusting windows in the Viewer, see “Power Windows.”
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 > Image Wipe: Toggles mouse control of dragging the split screen directly on the Viewer on 
and off. For more about working with split screens, see “Comparing clips in the Viewer.”

 > Dust Removal Tool: Activates the interactive Dirt and Dust tool. For more information, see 
later in this chapter.

 >OpenFX: Shows and hides whatever on-screen controls are exposed by an OpenFX plugin 
in the currently selected node.

Zooming into the Viewer

When using the Viewer to sample tricky colors or draw a detailed PowerCurve, it can be advantageous 
to zoom into the image.

To zoom into or out of the Viewer, do one of the following:

 >Make sure that View > Allow Mouse Zoom is on, then move the pointer to within the Viewer, 
and then roll the scroll wheel to zoom in or out of the image.

 > Press Command-Equal to zoom in, or Command-Minus to zoom out.

To pan around the Viewer:

 >Move the pointer to within the Viewer, then middle-click and drag to pan around the image.

To reset the size of the viewer image:

 > Choose View > Actual Size (Option-Shift-Z)

 > Choose View > Zoom to Fit (Shift-Z)

 > Right-click anywhere within the Viewer, and then choose one of the following options from 
the contextual menu:

 > Actual Size: Zooms to the native resolution of the clip. If the clip is larger than the 
Viewer, it will be cut off around the edges.

 > Zoom to Fit: Zooms so that the entire image fits within the Viewer.

Using the Scubber Bar and Transport Controls

One of the principal uses of the Viewer is to control playback. The scrubber bar, directly underneath 
the image in the Viewer, contains a playhead that you can drag to the left and right to navigate 
quickly through the currently selected clip as fast as you can move the pointer. The playhead in the 
scrubber bar is locked to the playheads found in the Timeline and Keyframes Editor. Moving one 
playhead moves all three.

How much of the Timeline the scrubber bar navigates depends on whether the Nodes Editor is set 
to Clip or Track mode. In Clip mode, the scrubber bar width equals the duration of the currently 
selected clip. In Track mode, the scrubber bar width equals the total duration of the entire timeline. 
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A row of transport controls below the scrubber bar provides more specific control over timeline 
playback.

 > Previous clip: Moves the playhead to the first frame of the previous clip.

 > Reverse: Initiates 100% playback in reverse.

 > Stop: Stops playback.

 > Play: Initiates 100% playback.

 >Next clip: Moves the playhead to the first frame of the next clip.

 > Loop: Lets you restrict playback to the current clip, looping to the first frame if you’re playing 
forward to the end of a clip, or looping to the last frame if you’re playing in reverse to the 
beginning of a clip.

Two other buttons let you control playback and display in the Viewer:

 > Unmix: Turning on Unmix disables all transitions, composited superimpositions, and effects 
that mix two or more clips together. Unmix allows you to judge the appearance of a clip 
without distraction whenever you need to make an adjustment based on how the clip looks 
on its own, or whenever you need to make changes based on frames that would otherwise 
be hidden underneath a transition such as a dissolve or fade from black. When you’re ready 
to see how your grades work in context with transitions and composites again, turn Unmix off.

 >Mute: Lets you turn audio playback off and on if you’ve loaded an Audio Chase Track for 
the current edit.

Controlling Playback Using the Spacebar and JKL Keys

You can also use the spacebar to start and stop playback. However, DaVinci Resolve now uses a 
simple version of the JKL keyboard shortcut convention for controlling playback, where J plays in 
reverse, K stops playback, and L plays forward.

Navigating Using the DaVinci Control Surface

It’s also possible to navigate the Timeline using the DaVinci control panel. A set of buttons on the 
Transport panel include:

 > PREV/NEXT SCENE: Moves the playhead among the first frame of each clip.

 > STEP REV/FWD: Moves the playhead from frame to frame.

 > FIRST FRAME/LAST FRAME: Jumps the playhead to the first and last frame of any given clip.

 > RWD/FFWD: Moves the playhead in rewind of fast forward.

 > REV/STOP/FWD: The standard play reverse, stop, and play forward commands.
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Another set of navigation controls is available by pressing the MODE button above the fourth 
trackball on the Center panel, and then pressing the CUE MODE soft key.

You can also use the jog wheel and shuttle control on the Transport panel. The jog wheel lets you scrub 
frame by frame, while the shuttle control moves among preset rewind and fast forward speeds.

Note: If a Gallery still is turned on for split screen comparison, the shuttle control will adjust the split 
screen center, and not the playhead position. Turning Reference Wipe off again frees up the shuttle 
control to affect playback again.

Finally, there are two additional methods of navigating using the DaVinci Control Panel that make it 
easy to jump to a specific clip or timecode value.

To move the playhead to the first frame of a specifically numbered clip:

 >On the Transport panel, enter a clip number using the number pad, then press TAKE ENTER.

To move the playhead relative to its current position:

1. Press + or – on the number pad.

2. Enter either a number of frames, or a timecode value using colons to divide each pair of digits 
(for example +01:00:23:12). 

3. Press TAKE ENTER.

To move the playhead to an exact timecode value:

1. Using the number pad, enter a timecode value, using colons to divide each pair of digits (for 
example 01:00:23:12). 

2. Press TAKE ENTER.
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Understanding the GPU Status Display

A frame-per-second (FPS) meter and GPU status graph appears at the top left-hand corner of the 
Viewer whenever playback is initiated. Since DaVinci Resolve uses one or more GPUs (graphics 
processing units) to handle all image processing and effects, the GPU status graph shows you how 
much processing power is being used by whichever grade is playing. 

Frame rate and GPU indication, green is good

A long green graph shows there is plenty of GPU processing headroom available. As the GPU 
resources is increasingly taxed, this green graph becomes shorter. Eventually, it turns red to show 
that the available GPU power is insufficient for consistent real time playback. 

Slower frame rate matches red GPU indication

Eventually, as you add more and more corrections, you’ll reach the limits of available performance, 
forcing DaVinci Resolve to play video at a slower speed in order to maintain high image quality (as 
shown by the FPS indicator).

Using Proxies or Clip Cache When GPU Status Is in the Red

When the GPU Status indicator is in the red, you may continue playing your project at slower than 
real time speed, or you can turn on the Use the Proxies On The Fly option in the Image Scaling 
section of the Settings to enable DaVinci Resolve to generate proxy source images in real time. 
Proxies reduce processing demands by temporarily lowering the resolution of your clips, thereby 
increasing real time playback performance.

To turn Proxies on and off, do one of the following:

 > Choose View > Proxy On The Fly (Command-P).

 > Press PROXY ON/OFF on the T-bar panel of the DaVinci control surface.
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Alternately, you can use the Mark Clip for Render Cache command to cache specific clips with 
processor-intensive grades. In cache mode, frames of each marked clip are cached as they play. 
Once cached, these clips play back in real time until they’re modified.

To turn on Clip Cache mode, do one of the following:

 > Choose Color > Render Cache Mode (Option-R) to cycle among the various options.

 > Press CACHE MODE on the T-bar panel of the DaVinci control surface.

More information about using the Render Cache appears later in this chapter.

Project Settings for Improving Real Time Performance

In addition to working with proxies, there are six options in the Project Settings window that you 
can use to improve real time performance if you’re working on an underpowered computer, at the 
expense of lower image quality while you work. These settings can then be changed back to higher 
quality modes prior to rendering.

 > Set timeline resolution to: (Master Project Settings, Timeline Format) DaVinci Resolve is 
resolution independent, so you can change the resolution at any time and all windows, 
tracks, sizing changes, and keyframe data will be automatically recalculated to fit the 
new size. Lowering the timeline resolution while you’re grading will improve real time 
performance by reducing the amount of data being processed, but you’ll want to increase 
timeline resolution to the desired size prior to rendering.

 > Enable video field processing: (Master Project Settings, Timeline Format) You can leave 
this option turned off even if you’re working on interlaced material to improve real time 
performance. When you’re finished, you can turn this setting back on prior to rendering. 
However, whether or not it’s necessary to turn field processing on depends on what kinds 
of corrections you’re making. If you’re applying any filtering or sizing operations such as 
blur, sharpen, pan, tilt, zoom, or rotate, then field processing should be on for rendering. If 
you’re only applying adjustments to color and contrast, field processing is not necessary.

 > Video bit depth: (Master Project Settings, Video Monitoring) Monitoring at 8-bit 
improves real time performance, at the expense of possibly introducing banding to the 
monitored image.

 > Use optimized display mode during playback: (Master Project Settings, Video Monitoring) 
Enabling this setting improves real time performance by hiding on-screen controls such as 
the cursor, Power Window outlines, and split-screen views during playback. When playback 
is stopped, onscreen controls reappear.

 > Uses Bilinear filter: (Image Scaling) A lower quality image transform setting that is less 
processor intensive. A “Force sizing highest quality” checkbox in the Render Settings list 
of the Deliver page helps make sure you don’t accidentally render your final media at this 
lower quality setting.
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 > Decode Quality: (Camera Raw) Camera raw formats such as R3D and F65 can be debayered 
at different levels of quality. For higher real time performance, you can choose a lower 
quality setting while you work, and then switch to a higher quality when rendering the final 
output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the 
Deliver page makes it easy to follow this workflow.

 > Play Quality: (Camera Raw settings) This option provides the additional ability to set a 
lower resolution for debayering during playback then for when the playhead is stopped. By 
default playback uses the same setting as the Decode Quality pop-up menu.

For more information on these settings, see Chapter 2 “Project Settings,” and “Camera Raw 
Decoding” in Chapter 3 “Media.”

Viewer and Transport Timecode Displays

The Viewer has two timecode displays, each of which defaults to a different timecode setting. 

A timecode display at the top, the Header Timecode Display, shows the Source timecode by 
default. The timecode display at the bottom, the Transport Timecode Display, shows the Record 
timecode by default. The bottom timecode display can be changed to show one of four different 
options, which are similar to those found in the Data Burn In palette.

The bottom timecode display can be changed to show one of four different options, which are 
similar to those found in the Data Burn In palette.

To change a timecode display to a different setting:

 > Click the timecode display. Each time you click, that timecode display rotates through one 
of the following four different options.

 > Record Timecode: The timecode corresponding to the playhead’s position in the 
overall Timeline.

 > Source Timecode: The timecode corresponding to the playhead’s position relative to 
the currently selected clip.

 > Record Frame Number: The frame count corresponding to the playhead’s position in 
the overall Timeline.

 > Source Frame Number: Source Frame Number: The frame count corresponding to the 
playhead’s position relative to the currently selected clip.

In the same way, the top timecode display can alternately be changed to show keykode if it’s 
available within a DPX media file’s header.
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Enhanced Viewing, Full Viewing, and Cinema Viewing

A button at the upper right-hand corner of the Viewer lets you expand the Viewer into Enhanced 
Viewing mode. Alternately, you can choose View > Enhanced Viewer mode (Option-F), or you can 
press CURRENT/VIEWER on the T-bar panel of the DaVinci control surface.

In Enhanced Viewing mode, the Viewer works exactly as it does at its regular size, but it expands 
to fill up the entire area of the screen above the palettes and Keyframe Editor. To exit Enhanced 
Viewing mode, click the lower right-hand corner button again.

Enhanced Viewer button

This can be useful if you need a closer view of the image for purposes of making detailed 
corrections, examining noise patterns up close, making a tricky color selection, or drawing a 
complicated PowerCurve.

Color page in Enhanced viewer mode
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In Full Viewing mode, the Viewer takes up even more room by hiding the palette controls, but 
leaves room for the transport controls, the On-screen Control pop-up menu, the timecode display, 
and the page buttons along the bottom of the Resolve UI. This mode is useful when you need an 
even closer look at the image, but you still want access to a minimal set of on-screen controls.

Color page in Full Viewer mode

Another option, Cinema mode, allows for full-screen viewing. Cinema mode is available by choosing 
View > Cinema Mode (Command-F). In Cinema mode, the menu bar is hidden, and the image is 
presented full screen without any of the ordinary on-screen controls. Moving the pointer over the 
screen reveals a set of hidden on-screen controls that include a play button, scrubber bar, mute 
button, and exit button (which lets you turn off Cinema mode).
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Color page in Cinema mode

Cinema mode is useful for doing detailed reviews of media in on-set and digital dailies workflows 
when working remotely without a secondary video display.

Tip: If you’d like to superimpose timecode over the image in Cinema mode for reference, you can 
use the controls within the Data Burn-In palette to set up whatever information you’d like to display 
during playback.
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Safe Area Markers in the Viewer

You can show or hide a series of safe area markers in the Viewer. All safe area marker options are 
found in the View > Safe Area menu. Each safe area marker option can be individually enabled or 
disabled from this menu.

Viewer displaying extents, center, safe, action and title area markers

 >On/Off: Turns all currently selected safe area marker options on or off at once.

 > Extents: An outline showing the exact outer edge of the frame. Especially useful when the 
safe markers are set to an aspect ratio other than that currently used by the Viewer.

 > Action: An outline showing the outer 90% action safe area of the frame.

 > Title: An outline showing the outer 80% title safe area of the frame.

 > Center: A crosshairs showing the center of the frame.

 > Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect ratio 
of the safe area markers. You can choose among the following aspect ratios: 1.33 (a.k.a. 4:3), 
1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

You can also access these options directly using the DaVinci control surface.

To customize safe area markers using the DaVinci control surface:

1. Press MODES, above the fourth trackball on the Center panel.

2. Press the SAFE AREA soft key. The Center panel soft keys are remapped with all of the available 
safe area options.

3. When you’re finished, press EXIT.
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Monitor Calibration

If you use LightSpace CMS, from Light Illusion, for display calibration, you can now use DaVinci 
Resolve as a pattern generator that can be synced to LightSpace. This means that you can use 
Resolve to output color patches, synchronized by LightSpace, to your display through whichever 
video interface is connected to your computer. These synchronized color patches will be analyzed 
by a monitor probe that’s also controlled by LightSpace, which stores the probe data and compares 
it to the original color values of the output color values in order to characterize that display.

To use this feature, you must first have a licensed copy of LightSpace CMS, which is a Windows 
application. Synchronization depends on a wired or wireless LAN being available to connect the 
LightSpace application with Resolve.

To synchronize LightSpace CMS to DaVinci Resolve as a pattern generator client:

1. Open LightSpace on the Windows computer that’s running it.

2.  When LightSpace is open, click the Network Manager button. A window appears displaying 
the two network IP addresses used by LightSpace. Note these, and click the Enable button.

The Network Manager dialog in LightSpace CMS 

3.  In DaVinci Resolve, choose Monitor Calibration > LightSpace. 

4. When the LightSpace dialog opens, enter the second of the two network IP addresses 
LightSpace lists into the Remote Machine field, and make sure the Port number matches. Then 
click the Connect button.
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The Calibration dialog in Resolve, connected to LightSpace CMS via WiFi

 If everything is working correctly, the LightSpace dialog in Resolve should show the word 
“Connected,” and the Network Manager dialog in LightSpace should show that there is “1 
available client/s.” 

 You can now close the Network Manager dialog in LightSpace and follow the procedures 
outlined in the LightSpace CMS documentation for characterizing your display and building 
and exporting a display LUT (in the .cube format) that you can use as a display LUT in Resolve. 
Alternately, you can export a display LUT from LightSpace that can be loaded onto an outboard 
video processing device connected between your video

5. When you’re finished, click Disconnect in the LightSpace dialog, and then click Cancel to close 

the window.
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The ability to compare different clips to one another is an important part of the color correction 
process. DaVinci Resolve provides three different ways of doing so. You can use the Gallery to 
display two clips for split-screen comparison. You can also use different reference modes to see a 
timeline clip or reference movie directly as part of a split-screen comparison. Finally, you can use 
the playhead’s interface to display up to four clips simultaneously using a two, three, or four-up 
arrangement in the Viewer.

Gallery Basics

The Gallery on the Color page provides fast access to stills that you’ve saved from various clips in the 
Timeline. While the dedicated Gallery page provides a more comprehensive interface for browsing 
pre-saved “Looks,” as well as for importing stills from other projects, you can save, organize, and 
browse stills directly within the Gallery of the Color page.

Stills are saved in the DPX file format. Once you’ve saved one or more stills, you can set up split-
screen wipes in the Viewer, which will be mirrored to your external display. 

Stills from the Gallery can be compared to the current shot making it easier to match grades

This section provides an abbreviated summary of still store and split-screen functionality to get you 
started quickly.

Comparing Clips in the Viewer
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To save a still, do one of the following:

 > Choose View > Grab Still (Option-Command-G).

 > Right-click on the Viewer and choose Grab Still.

 > Press GRAB STILL on the Transport Panel of the DaVinci control surface.

To split screen a still, do one of the following:

 > Select a still in the Gallery, and choose View > Wipe On/Off (Command-W), or right-click in 
the Viewer and choose Toggle Wipe.

 > Double-click a still in the Gallery.

 > Press PREV STILL or NEXT STILL on the Transport Panel of the DaVinci control surface to 
select a still, then press PLAY STILL.

To adjust a wipe in the Viewer, do one of the following:

 > Drag the pointer within the Viewer to move the wipe.

 > Push the T-bar control up and down on the T-bar panel of the DaVinci control surface.

To customize a split screen in the Viewer: 

 > Choose one of the following from either the View menu or the Viewer contextual menu:

 >Wipe Type: Cycles among the Vertical Wipe, Horizontal Wipe, Blend Wipe, and Alpha 
Wipe modes.

 > Invert Wipe: Reverses each half of the wipe.

Stills also store the grade from the clip they came from, and can be used to copy grades from one 
clip to another, or to store grades that you might want to use later.

To copy a grade from a still to a clip, do one of the following:

 > Select a clip in the Timeline, then right-click a still in the Gallery and choose Add Correction.

 > Select a clip in the Timeline, then middle-click a still in the Gallery.

When you copy a still in this way, the saved grade completely overwrites the grade 
in the target clip, unless you’ve used the “Preserve number of nodes” option, found in 
the contextual menu of the Gallery. For more information, see Chapter 7, “Copying and 
Managing Grades.”

For more detailed information on using the Gallery, including options for organizing the Gallery 
browser, instructions for using Albums, and other options, see Chapter 7, “Using the Gallery.”
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Different Viewer Reference Modes

While it’s common to use the Gallery to split screen reference stills, by changing the reference 
mode you can create a split screen against a clip in the Timeline, or against an offline video, if one 
has been assigned to the current Timeline.

To change the Viewer reference mode, do one of the following:

 > Choose an option from the View > Reference Wipe Mode submenu.

 > Right-click the Viewer and choose Toggle Ref Mode from the contextual menu.

 >On the T-bar panel of the DaVinci control surface, press REF ON/OFF to toggle the 
reference mode immediately to Offline mode and back again, in order to split screen the 
current clip against an offline video.

There are three Reference Modes:

 > Gallery: The default reference mode. Lets you split screen the current clip against a 
Gallery still.

 > Timeline: Lets you split screen the current clip against another clip in the Timeline using the 
Wipe Timeline Clip command (see below).

 >Offline: Lets you split screen the current clip against an offline video that’s been assigned 
to the current Timeline.

If you want to split screen the current clip against another clip in the Timeline, without saving a still 
to the Gallery first, there’s a special procedure you can follow.

To split screen two clips using the Timeline reference mode:

1. Click the thumbnail of the first clip you want to compare.

2. Right-click the thumbnail of the second clip you want to compare against, and choose Wipe 
Timeline Clip from the contextual menu.

 Both clips appear split screened against one another.

 Note: Wipe Timeline Clip only appears in the contextual menu if you right-click on a thumbnail 
in the Timeline that has not been selected.
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Using Split Screen Modes

A set of Split Screen modes, available from the View > Split Screen submenu, provides additional 
ways of comparing multiple images in the Viewer. These provide side-by-side and grid comparisons 
of multiple shots and multiple versions, all of which are output to video for monitoring on your 
external video display. For example, you can use the Split Screen Versions mode to display every 
single version that’s applied to the current clip in a grid, for easy evaluation. The currently selected 
clip in the timeline is highlighted in gray, so you can keep track of what you’re doing.

Four shots shown in a grid using the Split Screen > Selected Clips mode

Note: When any of the Split Screen modes are selected, you cannot see any other on-screen 
controls in the Viewer, such as Power Window shapes, until you first disable Split Screen.

Available Split Screen modes, and their effects:

 > Versions: Shows up to sixteen versions for the current clip, all at once, making it easy to 
evaluate a series of different versions in relation to one another. If you have more then 
sixteen versions, you deserve some manner of award.
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 > Versions and Original: Shows up to the first fifteen versions for the current clip, along with 
the original ungraded clip at the upper left-hand corner.

 >Group: Shows up to sixteen clips that share the same group as the current clip.

 > Selected Clips: Shows all currently selected clips in the Timeline, up to sixteen at one time.

 >Neighbor Clips: Shows four clips that immediately surround the current clip. The previous 
two clips appear as the upper left- and right-hand clips, the current clip appears at the 
lower left-hand corner, and the next clip appears at the lower right.

 >Gallery Grades: When you choose this option, the act of selecting stills in the Gallery of the 
Color page shows each of the grades associated with those stills as they appear applied to 
the current clip, in a split screen arrangement.
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DaVinci Resolve has a set of four video scopes that you can use to monitor the internal data levels 
of clips in your project. These include the WFM (waveform monitor), Parade (RGB parade scope), 
Vectorscope, and Histogram (RGB parade histogram). All four video scopes can be displayed either 
together, or individually, within the customizable Scopes window.

Video Scopes shown in their default four-up state

Because you’re evaluating the internal state of the image data, the scales of the WFM and Parade 
scopes always reflect 10-bit full range data from 0-1023, regardless of your project’s Colorspace 
Conversion settings. This gives you a window into how the image is being processed by Resolve 
prior to being output via your computer’s video interface.

Methods of customizing the Scopes window:

 > To change the aspect ratio of the Scopes window: Click either the 16:9 or 4:3 buttons at the 
upper left-hand corner of the window.

 > To change the size of the Scopes window: Drag the lower right-hand corner to resize the 
Scopes window to any size and aspect ratio.

 > To change how many scopes are displayed at once: Click the Layout pop-up in the upper 
right-hand corner of the Scopes window, and choose 1-up, 2-up, or 4-up.

 > To change which scopes appear in which pane: Click the Option pop-up menu at the 
upper right-hand corner of any Scope pane, and choose a different scope from the Switch 
View submenu.

 > To change whether a scope appears in color or monochrome: Click the Option pop-up 
menu at the upper right-hand corner of any Scope pane, and choose Color to toggle color 
display on and off for that scope.

You can set low and high reference level markers for any scope but the Vectorscope by  
selecting the Option pop-up menu at the upper right-hand corner of the Waveform, Parade and 
Histogram displays.

Using Video Scopes
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The Vectorscope display can include a skin tone indicator. Select the Option pop-up menu at the 
upper right-hand corner of the Vectorscope pane and choose, Show Skin Tone Indicator.

Once open, you can resize the Scopes window to make it as large or small as you require, positioning 
on a second display if you want to make it even larger. Additionally, each video scope has different 
display options.

1. Click the Option pop-up menu at the upper right-hand corner of any Scope pane, and choose 
Option to open that scope’s Custom Controls window.

Adjust the waveform and graticule brightness independently

2. Click anywhere outside of the custom controls window to make it disappear.

These custom controls include:

 >Waveform: A slider that makes that scope’s graph brighter or dimmer. Brighter graphs 
make it easier to see fine detail, but harder to see which parts of the graph are stronger 
and weaker.

 >Graticule: Makes that scope’s scale brighter or dimmer, making it more or less visible (or 
distracting) relative to the graph.

Note: Because they analyze every line of the image, the video scopes require a certain amount 
of video processing power to operate. Whenever you open any of the video scopes, you may 
notice your real time processing capabilities slightly diminish. Closing the video scopes frees up all 
processing for color correction and effects.
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The Timeline in the Color page is primarily used for navigating the current arrangement of clips, and 
for keeping track of clip properties such as whether they’re graded and ungraded, whether they use 
tracking, which version they’re using, and so on. 

Color page timelines

The Timeline consists of three parts.

 > Timeline Ruler: Contains the playhead, displays the record timecode of the current edit, 
and acts as a scrubber bar that spans multiple clips. The scroll wheel of your mouse lets 
you zoom in and out of your edit, and if you zoom all the way out you can fit every clip in 
the Mini-Timeline into the available width of the ruler, letting you scrub through every clip 
in the Timeline quickly. Clicking anywhere within the ruler instantly jumps the playhead to 
that frame. 

 >Mini-Timeline: Shows a miniature representation of the Timeline in the Edit page, where 
each clip’s width is proportional to its duration. The Mini-Timeline can show a maximum 
of six video tracks; if your edit uses more, a scroll bar lets you change which tracks are 
displayed. If a track has been disabled in the Edit page, it will appear grayed out in the 
Mini-Timeline. Clicking a clip in the Mini-Timeline both selects it and moves the playhead 
to its first frame. The scroll bar for the Mini-Timeline is independent of the scroll bar for the 
Thumbnail timeline, and both can be set to show different ranges of clips.

 > Thumbnail Timeline: Provides a concise visual representation of your project where each clip 
is a single thumbnail, regardless of its duration. Clicking a thumbnail moves the playhead to 
the first frame of that clip. Whichever clip is at the current position of the playhead appears 
with its thumbnail outlined in orange. Each thumbnail displays a variety of information 
above and below it, and differently colored outlines indicate clip groups, where existent.

Show Current Clip With Handles

If you’re working on a project that’s part of a round-trip workflow, and you know you’ll be rendering 
handles for each clip, it can be useful to temporarily expose these handles while you grade, so that 
you can apply tracking or keyframing effects to the full frame range of each clip.

To show or hide clip handles in the Mini-Timeline of the Color page:

 > Choose View > Show Current Clip With Handles.

Navigating Using the Color Page Timeline
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While this mode is enabled, Unmix is turned on and cannot be disabled, in order to let you view the 
overlapping handles of each clip clearly. The duration of handles that are exposed is defined by the 
Default Handles Length parameter of the Editing panel in the Project Settings. Clip Handles can be 
shown or hidden at any time.

Thumbnail Info

The thumbnails make it easy to find the clips you’re looking for visually, and they always show the 
media as it’s currently graded. The most obvious piece of information is the frame that’s used for 
each clip’s thumbnail. If you feel that a particular clip’s thumbnail isn’t representative of its content, 
you can change it.

To change the current thumbnail:

 >Move the pointer over a thumbnail, drag to the left or right to scrub through the clip, and 
stop when you find a frame you want to use as the new thumbnail.

If media is replaced in the middle of a color correction timeline, or if you copy or ripple a grade to a 
range of clips, the thumbnails may not immediately update to accurately represent the current state 
of each clip. In this case, you can manually refresh the thumbnails.

To refresh all thumbnails in the Timeline:

 > Right-click anywhere in the Thumbnail timeline and choose Update All Thumbnails.

You can also choose to display the codec used by each clip in the Timeline.

To switch the Thumbnail timeline between showing clip names and codecs:

 > Double-click the thumbnail clip name of any clip to display each clip’s codec, and vice versa.

Additional information appears above and below each thumbnail, providing a way of keeping track 
of which clips have been graded, which clips are using different versions, which clips have been 
cached, and so on.

Each clip thumbnail has a number of valuable indications permitting quick comparison to other shots.
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The following list explains each piece of information that can appear above, within, or below the 
thumbnails in the Timeline.

 > Flag icon: If a clip has been flagged, a flag icon of the appropriate color appears at the upper-
left of its thumbnail. If a clip has multiple flags, they’ll appear along the left of the thumbnail.

 > Source Timecode: The source timecode from the first frame of each clip appears on top of 
each thumbnail.

 > Linked media icon: If multiple clips share the same source media file, then by default their 
remote version 1 grade will be automatically linked. If the current clip is linked, a small link 
icon appears on top of every clip in the Timeline that’s also linked to that clip. When you 
select another clip that’s not linked, the linked clip icons disappear.

 > Tracker icon: If any node within a particular clip’s grade has been tracked, a small crosshairs 
tracker icon appears on top of its thumbnail.

 > Cache icon: If you’ve used the Mark Clip for Render Cache command on a clip, a small 
cache icon appears at the bottom left corner, over the thumbnail. 

 > Cache percentage: If the Clip Cache mode is set to anything other than off, a percentage 
value appears within the thumbnail of every clip in the Timeline. This shows the percentage 
of the clip that’s been cached so far. At 100%, the clip is fully cached to the scratch disk.

 > Clip number: Each clip’s number appears at the left underneath its thumbnail. Clips are 
numbered in ascending order according to the position of their first frame, from left to 
right, regardless of the video track in which they appear. 

 > Track number: The video track in which a clip is edited appears to the right of the clip number. 

 > Version name/Source format: If you create a version for a clip, the version name appears to 
the right, below its thumbnail. The version name provides information about whether a clip 
is using a remote version, or a local version, indicated by an (L). If you’ve given the current 
version a name, it appears; otherwise the version will be labeled “Version” with its number. 
Double-click the version name to toggle between displaying version names and the source 
format of that clip.

 >Grade indicator: If a clip has been graded, a thin rainbow indicator the width of its thumbnail 
appears below.

 > 3D indicator: All stereo 3D clips in the timeline appear with this icon. Its color indicates 

which eye you’re monitoring; red indicates the left eye, while blue indicates the right eye.
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By default, the Timeline displays every clip of the currently selected edit in the Edit page, sorted in 
A mode (the record order of your edit). However, the sort order and contents of the Timeline can be 
changed and filtered to make it easier for you to find specific groups of clips for grading.

Changing Timelines

If you’re working on a project that has more then one timeline, you can switch timelines right from 
within the Color page.

To switch timelines in the Color page:

 > Choose another timeline from the Timelines pop-up menu at the top of the Viewer.

Timeline selection at the top center of the Viewer

To switch among timelines using the DaVinci control surface:

 > Press the MODES button above the fourth trackball on the Center panel, then press the 
SWITCH TIMELINE soft key. Press MODES to return to the main page of controls when 
you’re done.

A and C Mode Sorting

By default, the Timeline is set to Record mode sorting, otherwise known as A mode sorting. In this 
mode, clips appear in the Timeline according to the order in which they were edited. This lets you 
see the order of clips as they’ll appear in the final program.

A Mode sorting, i.e., record order

Sorting and Filtering Clips in the Timeline
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However, you can change the sort order of the clips in the Timeline to Source mode, or C mode 
sorting. In C mode sorting, all clips are rearranged in ascending order from left to right according 
to their source timecode, and their record timecode is temporarily ignored.

C Mode sorting, i.e., source clip order

Sorting by C mode makes it easy to identify a range of similar clips. For example, if you’re working 
on a documentary, sorting by C mode will arrange all of a particular subject’s head shots from 
a specific interview contiguously, one after another, since they all come from the same range of 
timecode on the same source tape. This makes it easy to balance them, copy grades among them, 
or group them.

When you’re finished, you can switch the Timeline back to A sort mode, and all of the clips will go 
back to being arranged in the order in which they were edited.

To toggle between A and C mode sorting, do one of the following:

 > Choose an option from the View > Timeline Thumbnail Mode Source/Record submenu.

 > Press Command-Page Down to toggle to C mode sorting.

 > Press A/C MODE on the T-bar panel of the DaVinci control surface.

While in C mode, the word “SOURCE” appears at the right in the Timeline Ruler

Source mode indicated at the right of the Timeline ruler

A checkbox in the Conform Options group of the Master Project Settings lets you change the 
behavior of C mode sorting. Opening the Settings window and clicking Master Project Settings 
reveals the Sort Timeline Using Reel Name and Timecode checkbox.
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Project settings, Master project settings

With this checkbox turned on (the default), all clips in the Timeline are sorted by reel number first, 
and then by source timecode. This way, clips with similar timecode from the same reel will appear 
next to one another in C mode.

If you turn this checkbox off, reel number is ignored, and all clips in the Timeline are sorted only by 
source timecode. This may result in clips from multiple sources being mixed together, but it is useful 
in specific situations. 

For example, when grading dailies from a three camera shoot, you may want to see consecutive 
clips from all three cameras lined up one after the other on the Timeline, so that Cam1_Shot1, 
Cam2_Shot1, and Cam3_Shot1 appear first, followed by Cam1_Shot2, Cam2_Shot2, and Cam3_
Shot2, and so on. In this situation, you don’t want clips from cameras 2 and 3 to be placed at the end 
of the Timeline simply because of their reel number.

Flags and Markers

You have the option of flagging or marking clips in the Color page just like you can in the Edit page, 
in order to keep track of specific media or frames that you may need to do something to later. For 
example, you could flag every closeup of a particular actor with a blemish that you want to spend 
some time fixing with a green flag. 

Methods of flagging and marking clips in the Color page:

 > To flag a clip: Right-click any clip’s thumbnail, and choose a flag color from the Flags 
submenu. Flags are not frame-specific, so flagging one clip will result in flags also being 
placed on all other clips that share the same source media in the Media Pool.

 > To remove all of a clip’s flags: Move the playhead to a clip, and choose Mark > Clear Current 
Timeline Flags, or right-click a clip’s thumbnail and choose the top Remove Flags option 
from the Flags submenu.

 > To mark a frame of a clip: Move the playhead to the frame of a clips you want to mark, then 
choose Mark > Add Marker (M), or right-click a clip’s thumbnail and choose a marker color 
from the Marker submenu.

 > To remove a single marker: Move the playhead to the frame with the marker you want to 
remove, and choose Mark > Clear Current Marker (Shift-Command-0).

 > To remove all of a clip’s markers: Move the playhead to a clip, and choose Mark > Clear 
Current Timeline Markers (Command-0), or right-click that clip and choose the top remove 
markers option from the Markers submenu.
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Timeline Filtering

A pop-up button at the far right of the toolbar underneath the Timeline presents options for 
dynamically filtering which clips are shown in the Timeline. This allows you hide all the other clips in 
the Timeline except for the subset on which you want to focus.

Timeline filtering options

For example, once you’ve added flags or markers to clips, it’s easy to hide every other clip in the 
Timeline that doesn’t fit the criteria; for example, hiding clips that don’t have a green flag. This does 
nothing to alter the original edit, and you can return the Timeline to its original state at any time

To filter the Timeline:

 > Click the Timeline Filtering pop-up button in the Toolbar, and choose an available option.

To return the Timeline to normal:

 > Click the Timeline Filtering pop-up button, and choose All Clips.

There are several criteria by which you can filter the Timeline:

 > All Clips: No clips are filtered, and every clip in the current edit is shown.

 >Graded Clips: Filters all clips that have been graded.

 > Ungraded clips: Filters all clips that have not yet been graded.

 > Unrendered clips: Filters all clips that have not yet been rendered.

 > Stereoscopic 3D Clips: Filters stereo 3D clips, a submenu presents options for filtering All 
Stereo Clips, or just Stereo clips that have been Autoaligned, those with Convergence 
adjustments, those with Floating Windows adjustments, or stereoscopic clips with swapped 
media for the left and right eyes.

 > Flagged Clips: Filters all clips that have a particular flag, a submenu presents each color.

 >Marked Clips: Filters all clips that have a particular mark, a submenu presents each color.

 >Modified clips: Submenu, filters all clips that have been modified within a specified time.

 > Tracked clips: Filters all clips with motion tracking.
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 >Grouped clips: Filters all clips belonging to a particular group, a submenu shows the 
available groups.

 >Different Frame Rate Clips: Filters all clips with frame rates that don’t match that of the project.

 > Clips with Noise Reduction: Filters all clips using noise reduction.

 > Clips with Input Sizing: Filters all clips that have had any Input Sizing parameters adjusted.

 > Common Media Pool Clips: Filters all clips sharing the same source in the Media Pool as 
the current clip.

 > Selected Clips: Filters all currently selected clips.

 > Clips with Matte Nodes: Filters all clips with an exposed Matte node in the Node Editor.

 > Clips with Mattes Available: Filters all clips with a matte assigned to them, whether they’re 
used or not.

You can use timeline filtering in conjunction with A or C mode sorting to arrange clips in whatever 
way is best for the task you’re trying to accomplish. Clip filtering can also be used in the Lightbox, 
and a currently selected clip filtering method will simultaneously isolate clips in the Timeline and 
Lightbox as you switch back and forth.
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The Lightbox shows you all clips in the Timeline as a grid of thumbnails, arranged in rows from left 
to right and top to bottom. This lets you quickly evaluate, compare, and search for clips you want 
to use when making selections, creating groups, flagging clips, or when scanning for a particular 
scene or looking for an individual clip.

The Color page Lightbox displays all the clips in the timeline

At the right of the Lightbox is a vertically oriented Timeline Ruler letting you know the timecode 
value at the beginning of each row of clips. At the bottom right is a Zoom slider that lets you change 
the size of the thumbnails.

Selecting a clip in the Lightbox is the same as selecting a clip in the Timeline, and right-clicking a 
clip in the Lightbox shows the same contextual menu items you’d see if you right-clicked a clip in the 
Timeline. Furthermore, you can also grade the current clip in the Lightbox using a control surface, 
or by exposing the color controls to grade the current clip using a mouse or other input device.

Methods of using the Lightbox:

 > To show or hide the Lightbox: Click the Lightbox button in the toolbar, or at the bottom 
right of the Lightbox if the color controls are hidden.

 > To show color controls in the Lightbox: Click the Show Color Controls button to show 
or hide the tool palettes along the bottom of the interface, which let you adjust clips in 
the Lightbox.

 > To show thumbnail info in the Lightbox: Click the Clip Info button to turn each clip’s 
thumbnail Info off and on.

Using the Lightbox
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 > To filter the Lightbox: Use the Clip Filtering pop-up menu in the toolbar, or at the bottom 
right of the Lightbox if the color controls are hidden.

 > To resize clips in the Lightbox: Drag the Zoom slider to the right to increase thumbnail size, 
or to the left to decrease thumbnail size.

The Zoom slider, Lightbox button, Lightbox Filtering pop-up, and Thumbnail Info buttons

The Lightbox can also be output to video, in order to see its contents on a broadcast display or 
projector.

To output the contents of the Lightbox to video: 

 > Click the Output Lightbox to Video button at the upper right-hand corner of the Lightbox.

The button for outputting the Lightbox to video

For more information about clip selections, groups, and grade management, either in the Timeline 
or Lightbox, see Chapter 7, “Copying and Managing Grades.”
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Ordinarily, DaVinci Resolve attempts to process all grading and effects in real time. If your workstation 
has an adequate number of GPUs to facilitate the kind of work you do at the resolution you require, 
you may never use the Render Cache.

However, if you find that some areas of your timeline are too processor-intensive to be played in real 
time, then the Render Cache may come in handy. For example, if the grades of two clips that overlap 
because of a dissolve or other transition cause Resolve to momentarily lose real time performance, 
you can automatically cache your transitions. Or, if most of your project is real time except for a 
handful of clips that use particularly intensive grades, you can manually add just those processor-
intensive clips to the Render Cache to maintain high-quality playback during critical timelines, such 
as client reviews or tape layoffs.

To add a clip to the Render Cache for caching in User or User & D modes:

 > Right-click a clip in the Thumbnail timeline, and choose Mark Clip For Render Cache from 
the contextual menu.

 > Press SHIFT UP then CACHE MODE on the T-bar panel of the DaVinci control surface, or 
press MODES on the Center panel and then CACHE MODE.

Once you add a clip to the Render Cache, a cache icon appears within its thumbnail in the Timeline, 
along with a percentage value that shows how much of the clip has been cached so far. 

The Render cache is ‘active’ icon above the clip number

More About the Render Cache
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To have Resolve begin caching, you need to change the Render Cache mode to one of four  
different options.

To enable or change the Render Cache mode:

 > Choose Color > Render Cache Mode (Option-R) to cycle among the various options.

 > Press CACHE MODE on the T-bar panel of the DaVinci control surface to cycle among the 
various options.

The Render Cache modes are as follows:

 >Off: No caching happens.

 > All: Every clip in the Timeline begins the process of caching, whether it’s necessary or not.

 > Dissolves: Only transitions between clips are cached, to account for the increased 
processing requirements of overlapping media.

 > User: Only clips that have been deliberately added to the Render Cache using the Mark 
Clip For Render command will be cached.

 > User & D: Both transitions between clips and manually cached clips will be cached.

When the Render Cache mode is set to anything but off, any clips or transitions that are designated 
for caching are cached when played. If playback is suspended, then the currently selected clip in 
the Timeline, as well as the next previous clip, begin caching automatically. Once a clip is cached, it 
remains cached until you change its grade, at which time the cache data for that clip is flushed, and 
the clip will need to be re-cached.

Tip: If you’ve cached one or more clips, and you decide to change the Cache mode to off, whichever 
clips have already been cached remain cached until you change their grade. Changing the Cache 
mode back to one of the four caching options shows what percentage of each clip has been  
cached again.
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The Info Palette

The Info palette is hidden by default. Clicking the Info palette button at the far right of the toolbar 
reveals it at the right of the Timeline. The Info palette has two tabs that display different information. 
There are no user-editable controls in the Info palette.

Info palette displaying System Status

Clip Info

The first tab displays information about whichever clip is currently selected in the Timeline. This 
information is not editable, but is provided for reference, and includes:

 > File Name: The name of the media file on disk.

 > Reel Name: The reel name of that clip, if one is being read properly.

 > Start T/C: The source timecode value of the first frame in the clip.

 > End T/C: The source timecode value of the last frame in the clip.

 > Duration: The duration of the clip, in timecode.

 > Frames: The duration of the clip, in frames.

 > Version: The name of the remote or local version used by that clip.

 > Frame Rate: The frame rate used by that clip.

 > Timeline: Which Timeline/Edit the clip is within.

 > Source Res: The native resolution of the source clip.

 > Codec: The codec or format used by the source clip.

The Info Palette and Clip Information
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System Info

The second tab displays information about operational modes currently in use by Resolve. It’s 
meant to provide the status of different Resolve features that can be enabled, disabled, or cycled 
among various options. This information includes:

 > Clips: The total number of clips in the Timeline.

 > Proxy: The status of Proxy mode (On or Off).

 > Clip Cache: The status of the Clip Cache mode (Off, All, Dissolves, User, User & D).

 > Ref Transform: The status of Reference Still reposition. 

 > Ref Mode: The status of the Reference Mode (Gallery, Timeline, Offline).

 >Wipe Style: The currently selected Wipe Style for split screens (Wipe-H, Wipe-V, Wipe-M, 
Wipe-A).

 > Convergence: The current Convergence setting (Linked Zoom, Opposite)

 > Stereo Grade: The currently displayed eye and gang mode (Left or Right - Gang or Solo).

 > Stereo Display: The current Stereo Display mode (Mono or Stereo).

Clip Details

You can right-click any clip thumbnail in the Timeline and choose Clip Details to show a translucent 
window with all of that clip’s information available at a glance. You can drag this window anywhere 
you like, even to another display.

The Clip Details window
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This information is not editable, but is provided for easy reference, and includes:

 > File Name: The name of the media file on disk appears at top.

 > Start Timecode: The source timecode value of the first frame in the clip.

 > End Timecode: The source timecode value of the last frame in the clip.

 > Duration: The duration of the clip, in timecode.

 > Frames: The duration of the clip, in frames.

 > Reel Name: The reel name of that clip, if one is being read properly.

 > Version: The name of the remote or local version used by that clip.

 > Format: The codec or format used by the source clip, along with the frame size and bit depth.

 > Folder: Which directory on disk the source media resides in.

 > Description: The description field of the Metadata editor.

 >Notes: The notes field of the Metadata editor.

 > EDL Comments: EDL comments for that event, if any exist.
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About Undo and Redo

The Undo and Redo commands in DaVinci Resolve work differently depending on which page is 
currently open. In the Edit page, Undo and Redo affect edits made to the Timeline (covered in more 
detail in Chapter 4). In the Color page, Undo and Redo affect color adjustment operations.

Every time you adjust a control or a parameter in the Color page, a memory of that state of the 
grade is saved to an internal list for that clip. Each clip has its own memory stack, which means that 
Undo and Redo will undo different operations depending on which clip is the current clip. Each 
clip’s undo stack is unlimited, however the memory stack of every clip in a project is cleared when 
you quit Resolve, and every time you start Resolve each clip is a clean slate.

To Undo and Redo, do one of the following:

 > Choose Edit > Undo (Command-Z).

 > Choose Edit > Redo (Shift-Command-Z)

 >On the DaVinci control surface, press the UNDO and REDO buttons on the T-bar panel.

If you have the DaVinci control surface, there is one other control that lets you control the Undo 
stack more directly when using the trackballs, rings, and pots. Pressing RESTORE POINT manually 
adds a memory of the current state of the grade to the Undo stack. Since discrete undo states are 
difficult to predict when you’re making ongoing adjustments with the trackball and ring controls, 
pressing RESTORE POINT lets you set predictable states of the grade that you can fall back on.
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The Left Palette panel contains four palettes that relate to color and contrast adjustments in 
different ways. The controls found within these palettes provide the foundation for any grade, and 
this chapter covers how you use the Camera Raw palette, Color Wheels, Primary Controls, RGB 
Mixer, and Motion Effects palettes to manipulate your image.

Left palette selection buttons

Note: If you’re using DaVinci Resolve with a computer monitor that’s smaller than 1920x1080, then 
the Left and Center Palette panels are consolidated into a single panel, and all the palette buttons 
appear together.

Color Controls
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When a timeline uses clips that are linked to camera raw source media recorded from cameras from 
Blackmagic Design, RED, ARRI, Sony, and Vision Research, all clips in raw media formats are initially 
debayered using the settings found in the Camera Raw panel of the Project Settings.

However, if there are individual clips that you want to apply different settings to, for example altering 
the ISO to pull more detail out of the highlights or shadows, then you can use the controls found in 
the Camera Raw palette to individually alter the parameters found within.

The Camera Raw palette showing the available parameters for the Sony F65 CineAlta camera.

The Camera Raw palette is automatically set to the mode (seen within the Mode pop-up menu) that 
is appropriate to the clip that’s currently selected. If the current clip is not in a raw format, then the 
parameters within the Camera Raw palette are disabled.

All settings that currently populate the Camera Raw palette are also accessible from the DaVinci 
control surface.

To access camera raw settings on the DaVinci control surface:

1. Press the CAMERA RAW soft key on the Center panel.

2. Use the Center panel knobs to make camera raw parameter adjustments.

3. When you’re finished, press the MAIN soft key to return to the main page of controls.

This section covers general use of the Camera Raw palette. For in-depth documentation about 
specific Camera Raw parameters, see Chapter 3, “Camera Raw Decoding.”

Camera Raw
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Copying, Versioning, and Protecting Camera Raw Settings

Ordinarily, a clip’s camera raw settings are copied along with its grade, or saved inside stills grabbed 
from that clip, when you use the various grade management techniques covered in Chapter 7, 
“Copying and Managing Grades.” 

DaVinci Resolve version 9 and later differ from earlier versions of Resolve in that when you create 
new versions, you now have the option to save individual camera raw settings for each version, so 
long as the Save with Version checkbox is turned on in the Camera Raw palette.

Camera Raw master settings

This means that you can have different versions with different camera raw settings, if, for example, 
you wanted to compare the results of two different camera raw adjustments on the same clip.

If you’re copying and rippling grades among multiple clips, you can also protect each clip’s camera 
raw settings from being overwritten using the “Copy Grade: Preserve Source Settings” option 
found in the contextual menu of the Gallery. For more information on the Copy Grade settings, see 
Chapter 7.
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Making Changes to Clip Camera Raw Settings
If you want to make individual adjustments to a particular clip’s camera raw settings, choose “Clip” 
from the Decode Using pop-up menu in the Camera Raw palette. This makes all the parameters in the 
Camera Raw palette editable, and changes you make override the project-wide camera raw settings.

Selection of Clip permitting individual clip control

Changes to the parameters in the Camera Raw palette can also be rippled across multiple clips 
at once.

To ripple camera raw adjustments across multiple clips:

1. Select a range of clips in the Color page timeline.

2. Open the Camera Raw palette, and make whatever adjustments are necessary to the current 
clip. The name of each parameter you adjust changes to amber, showing you which parameters 
have been modified, and which have not.

3. To ripple your changes, do one of the following:

 > Click the Apply Changes button to ripple only the altered parameters (in amber) to the 
other clips you’ve selected in the Timeline. This preserves differences between clips in the 
parameters you haven’t adjusted (in gray).

 > Click the Apply All button to ripple every parameter of the current clip to the other clips 
you’ve selected, overwriting all the camera raw settings at once.
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The Apply Changes and Apply All buttons in the Camera Raw palette

Resetting Camera Raw Settings

If you’ve made changes to the parameters of the Camera Raw palette and you decide you need to 
reset them, there are two options, found in the Options menu.

 > Reset: Resets all parameters in the Camera Raw palette to their default settings.

 > Revert: Similar to the “Original Memory” command, Revert changes all camera raw 
parameters back to the state they were at when you first selected the current clip. You 
should see some nice pixel detail reappear in formerly “flat” areas of the image, although 
the color channel you’re correcting may become exaggerated as a result.

If necessary, you might need to alter the color balance of the highlights or shadows (whichever 
was clipped) to achieve a more realistic coloration within the patched region. The result can 
be better seen by comparing the RGB Parade scopes before and after this adjustment.

When you’re done, you should see a bit more pixel detail in the formerly clipped regions of 
the image, with more pleasing color rendition.
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If you’ve had any exposure to color correction tools in any application, the controls found within the 
Color Wheels palette should look familiar. These controls correspond to the most basic color correction 
functionality available in DaVinci Resolve, and are designed to let users without control surfaces have 
easy access to color balance and YRGB contrast manipulation using a mouse, tablet, or trackpad.

Color Wheels for primary grading, in Primaries mode

The Color Wheels palette has two distinct modes of operation. Primaries mode contains the 
traditional DaVinci Lift/Gamma/Gain controls that allow tonally specific yet widely overlapping 
regions of adjustment. Log mode, on the other hand, contains Shadow/Midtone/Highlight/Offset 
controls that offer more restrictive yet customizable regions of adjustment.

How to Use Color Balance Controls and Master Wheels

Each of the modes in the Color Wheels palette use the same controls, albeit in different ways. This 
section explains, in a generic way, how to use these controls to make adjustments.

Color balance controls provide a way to adjust all three color channels simultaneously with a single 
move of the pointer, according to the mode that’s currently selected. These controls correspond 
to the trackballs found on the DaVinci control surface, but there are a variety of keyboard modifiers 
that let you make specific adjustments via the GUI.

Lift, Gamma and Gain wheels to balance the grades

Color Wheels Palette
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To make adjustments using the color balance controls:

 > Click and drag anywhere within the color ring: Moves the Color Balance indicator relative 
to its previous position, and rebalances the three color channels in whatever range of 
image tonality is governed by that control. You don’t need to drag the Color Balance 
indicator itself. This simulates the kind of relative control you get when using a trackball to 
manipulate these parameters. As the Color Balance indicator moves, the RGB parameters 
underneath change independently to reflect the independent adjustments being made to 
each channel.

 > Shift-Click and drag within the color ring: Jumps the Color Balance indicator to the absolute 
position of the pointer, letting you make faster, more extreme adjustments to the color 
balance governed by that control.

 > Double-click within the color ring: Resets the color adjustment without resetting the 
corresponding contrast adjustment for that control.

 > Command-click and drag within the color ring: Adjusts YRGB contrast identically as if you 
were dragging that control’s master ring.

 > Click the reset control at the upper-right of a color ring: Resets both the Color Balance 
control and its corresponding master ring.

The Master Wheels, located below the Color Balance controls, let you adjust the YRGB channels 
together to adjust Lift, Gamma, and Gain by individually adjusting the black point, the white point, 
and distribution of midtones that fall in-between. This has the practical effect of letting you adjust 
image contrast when you manipulate any two of these wheels together.

Lift, Gamma and Gain wheels to balance the grades

The Master Wheels correspond to the rings surrounding the trackballs on the DaVinci control 
surface, which let you modify image contrast via YRGB adjustment (as opposed to modifying image 
contrast via Y-only adjustment, covered later in this chapter).

To adjust a Master Wheel:

 > Drag it to the left or right: Dragging it to the left makes that area of the image darker, and 
to the right makes that area of the image lighter. The effect will vary according to the mode 
you’re in. As you make an adjustment, the YRGB parameters located underneath all change 
together to reflect the simultaneous adjustment you’re making to all channels.
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Understanding the Primaries Mode Controls

The Color Wheel palette’s Primaries mode lets you rebalance color and adjust contrast via the 
traditional DaVinci controls, which govern three overlapping tonal ranges referred to as Lift, Gamma, 
and Gain. The Lift/Gamma/Gain color balance and Master Wheel controls are tied to the YRGB Lift/
Gamma/Gain sliders found in the Primaries palette; adjustments made to one set of controls are 
mirrored in the other.

Though they may look different, the sliders and Color Balance wheels actually adjust the same components, but in different ways.

These tonal ranges are defined by image lightness, on a scale where 0 is absolute black and 1023 is 
absolute white. The following illustration shows an approximation of how the Lift, Gamma, and Gain 
tonal zones broadly overlap, and how each zone’s influence falls off towards the opposing extremes 
of image tonality.

Lift Gamma Gain

Graphic displays the relationship of the Lift, Gamma and Gain controls over the image brightness range that they control

The Lift color balance control region of influence starts at black, and then falls off through the 
middle grays to diminish to no influence at white. Meanwhile, the Gamma color balance control has 
its greatest influence over the image in the middle grays, and its influence diminishes towards black 
and white. Lastly, the Gain control is the inverse of Lift, having its greatest effect on the image at 
white, with its influence falling off to diminish at black.

Because these tonal ranges overlap so broadly, you can make very soft, subtle, naturalistic 
adjustments using these controls. Furthermore, you can capitalize on their overlap by moving an 
adjacent color balance control toward a color that’s complementary to an adjustment you’ve just 
made to restrict further how much of the image is affected.

The following image shows the interaction of extreme corrections made to a grayscale image using 
all three Color Balance controls. Lift has been pushed toward green, Gamma has been pushed 
toward blue, and Gain has been pushed toward red.
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Extreme adjustments showing the overlap of the Lift, Gamma, and Gain color balance controls 

Source footage courtesy of Gianluca Bertone DP, www.bertonevisuals.com

Notice how, even though these corrections are extreme, the colors blend smoothly. This is the reason 
for the broad overlap among all three controls, and why Lift, Gamma, and Gain are so effective in 
making corrections to the ambient color temperature of a scene to account for inconsistencies in 
lighting or camera settings.

3 Way Master Wheel Adjustments

The Master Wheels located below the Color Balance controls let you precisely modify image contrast 
by YRGB adjustments, which individually alter the black point, the white point, and distribution of 
midtones that fall in-between. 

Master gain wheels help you control contrast

These controls correspond to the rings surrounding the trackballs on the DaVinci control surface.

 > Lift: Lets you adjust the perceived shadow density of the image by altering the black point 
of the image. Dragging the Lift master wheel to the left makes the darkest values in the 
image darker, increasing the distance between the black and white points of the image, 
and stretching all the midtone values in-between. Dragging the Lift master wheel to the 
right makes the darkest values in the image lighter, reducing contrast and squeezing all the 
midtone values between the black and white points.
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 >Gamma: Lets you adjust the overall perceived lightness of the image by altering the 
distribution of midtones that fall between the Lift and Gain master wheel settings. Dragging 
the Gamma master wheel to the left darkens the overall image, while dragging it to the 
right brightens it. Most Gamma contrast adjustments have a minimal effect on the black 
and white point of the image, but large adjustments may push either boundary of image 
lightness farther out. This interaction is described in more detail below.

 >Gain: Lets you adjust the lightness of the highlights by altering the white point of the image. 
Dragging the Gain master wheel to the left makes the lightest values of the image darker, 
squeezing the midtones between the white and black points of the image. Dragging Gain 
to the right makes the lightest values even lighter, eventually clipping at maximum white.

White Point

Midtones

Black Point

Waveform display shows the clips contrast range

These contrast adjustments are not limited by one another. For example, raising or lowering the 
Gamma master wheel by a large amount may push the highlights of the image higher or the shadows 
of the image lower, regardless of the current Lift or Gain contrast setting. 

As a result, these controls are somewhat interactive, and you may find yourself going back and forth 
between controls as you make your final contrast adjustments. This is one of the reasons a control 
surface is valuable, as it allows you to adjust all three settings simultaneously.

Offset Color and Master Controls

The fourth set of Color Balance and Master Wheel controls is actually shared with the Log controls 
and with the Offset sliders in the Primaries palette. These are the Offset controls, which let you 
make linear adjustments to rebalance the entire tonal range of the RGB channels.

 > The Offset color balance control: Works as a simultaneous adjustment to all three Offset 
sliders located in the Primaries palette; adjustments made to the Offset color balance 
control also alter the Offset sliders. Used subtly, this makes it easy to neutralize color 
imbalances in the darkest part of the image, while simultaneously rebalancing every other 
part of the image. Used more dramatically, this control makes it easy to add a color wash 
throughout the entire image.
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 > The Offset master wheel: Acts as a global adjustment to image lightness, an operation 
sometimes referred to as setup, raising or lowering all YRGB channels together.

When using a DaVinci control surface, the Offset color balance control is adjusted in either Lift/
Gamma/Gain or Log modes via the fourth trackball, while the Offset wheel is adjusted via the ring 
surrounding the fourth trackball.

Contrast and Pivot

The Primaries mode of the Color Wheels palette also shares a pair of controls for adjusting image 
contrast with the Log controls. The Contrast parameters let you quickly narrow or widen image 
contrast about a user-definable pivot point. Regardless of which Color Wheels mode you’re in, 
these parameters are identical.

 > Contrast: This one parameter lets you increase or reduce the distance between the darkest 
and lightest values of an image, raising or lowering image contrast. The effect is similar 
to using the Lift and Gain master controls to make simultaneous opposing adjustments. 
Bright and dark parts of the image are pushed apart or brought together about a center 
point defined by the Pivot parameter.

 > Pivot: Changes the center of tonality about which dark and bright parts of the image are 
stretched or narrowed during a contrast adjustment. Darker images may require a lower 
Pivot value to avoid crushing the shadows too much when stretching image contrast, while 
lighter images may benefit from a higher Pivot value to increase shadow density adequately.

Contrast and pivot can also be adjusted using the DaVinci control surface via the CONTRAST and 
PIVOT knobs on the Center panel’s default page, regardless of whether you’re in Lift/Gamma/Gain 
or Log mode.

Saturation, Hue, and Lum Mix in the 3-Way Color Controls

The Saturation, Hue, and Lum Mix parameters mirror the three knobs found at the right of the 
Center panel of the DaVinci control surface. These are mirrored by the same parameters in the Log 
mode of the Color Wheels palette.

 > Saturation: Increases or decreases overall image saturation. At higher values, colors appear 
more intense, while at lower values, color intensity diminishes until, at 0, all color is gone, 
leaving you with a grayscale image.

 > Hue: Rotates all hues of the image around the full perimeter of the color wheel. The default 
setting of 50 shows the original distribution of hues. Raising or lowering this value rotates all 
hues forward or backward along the hue distribution as seen on a color wheel.
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 > Lum Mix: Lets you control the balance between YRGB contrast adjustments you’ve made 
using the Master Wheels or ganged Custom curves, and Y-only adjustments to contrast 
made using the Y channel Lift/Gamma/Gain controls of the Primaries palette or the 
unganged Luma curve. At the default of 100, YRGB and Y-only adjustments to contrast 
contribute equally. Reducing this value diminishes the effect of Y-only contrast adjustments 
until, at 0, Y-only contrast adjustments are turned off.

Additionally, you’ll notice that at a Lum Mix setting of 100, individual adjustments to R, G, 
or B using the RGB sliders or unganged Custom curves result in automatic adjustments 
being made to the other two color channels in order to maintain constant Luma levels. At 
a Lum Mix setting of 0, individual color channel adjustments have no effect on the other 
color channels.

Like most parameters in Resolve, clicking and dragging a parameter’s name or value to the left or 
right lowers and raises that parameter with a virtual slider, while double-clicking that parameter’s 
number lets you edit it numerically, and double-clicking that parameter’s name resets the parameter 
to its default position.

Auto Correction in the Primaries Mode Controls

The Auto Color button provides a quick way to automatically balance the blacks and whites of a clip 
based on the current frame at the position of the playhead. Resolve looks for the darkest levels in 
the image to neutralize the RGB color balance in the blacks, and the brightest levels to neutralize 
the RGB color balance in the highlights. Furthermore, Master Lift and Master Gain are adjusted to 
maximize image contrast at the outer boundaries of 0 and 100 percent. Using this control with the 
Primaries mode palette open causes these automatic adjustments to be made using the color and 
contrast controls, so you can see what’s changed.

The Log Mode of the Color Wheels Palette

The Shadow/Midtone/Highlight color balance and Master Wheel controls operate independently 
of the Lift/Gamma/Gain color balance and Master Wheel controls found in the Primaries mode. 
While the Log mode uses the same types of controls as the Primaries mode, the way each control 
affects the image is very different.
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Log color wheels, with behavior that is very different from the Primaries mode color wheels

There are two ways of using the Log mode controls. The first takes advantage of the way these 
controls work to make fast, filmic adjustments to log-encoded media while it’s normalized by LUTs 
or manual adjustments added after it in the image processing pipeline.

The other way of using the Log controls is to take advantage of the more restrictive, but adjustable 
tonal range of the Shadow/Midtone/Highlight controls to stylize normalized clips by tinting specific 
regions of the image.

Using the Log Mode Controls to Grade Log-Encoded Media

The Log controls are so named because they’re designed to work specifically with media with Log-C 
or similar gamma and color encoding, derived from the Cineon Log gamma curve, developed by 
Kodak to digitally store flat-contrast, wide-gamut image data that preserves image detail with a 
wide latitude for adjustment.

       

An example of a log-encoded clip (left), and the same clip after being normalized (right)
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As discussed in the “Camera Raw Encoding” section of Chapter 3, you can debayer most raw formats 
to a log-encoded image in order to derive the maximum amount of image data and adjustable 
latitude from that source. However, the resulting image needs to be normalized to occupy the final 
range of color and contrast that you intend for the final result. You can do this one of two ways:

 > You can make a very careful curves adjustment in a second node to stretch the log-encoded 
out to fit the contrast profile you want. By making this adjustment in Node 2, you make 
room for a customizing adjustment made using the Log controls in Node 1, prior to the 
normalization adjustment. This is key.

 > You can also apply a 1D Output or 3D LUT to the first node of a clip to normalize the image. 
This is a faster, if less flexible operation, but a smooth tonal range may be easier to obtain. 
Since a LUT applied within a node is always the last adjustment within that node’s order of 
operations, you can also use Node 1’s Log controls to customize the look of the footage.

In either case, it’s important that the normalizing adjustment happens after your Log control 
adjustments, for the Log control adjustments to work as they should. With your node tree set up 
in this way, you’ll be monitoring an ordinary-looking image, but taking advantage of the Log mode 
controls’ unique tonal ranges to manipulate the log-encoded image data with great specificity. 

When using the Log mode controls, here’s a workflow to consider as you learn how they work:

 > First, use the Offset master wheel to set the black point, and use the Contrast and Pivot 
parameters to stretch or compress contrast as necessary to achieve the tonal range you 
require.

 > Second, use the Offset color balance control to adjust the overall color balance of the 
image to your liking.

 > Third, use the Shadow/Midtone/Highlight color balance and Master Wheel controls to 
make specific, targeted adjustments to the color and contrast of the image in tonal ranges 
that match where that data is in the log-encoded image.

Working in this way, you’ll find that adjustments made with the Offset color balance and Master 
Wheel controls and Contrast controls control the log-encoded image very nicely to create an overall 
adjustment, while the Shadow, Midtone, and Highlight controls allow you to fix specific issues, such 
as shadow balance and density, after your main adjustment has been set.

The following illustration shows an approximation of how the default ranges of the Shadow, 
Midtone, and Highlight controls divide the tonal range of a log-encoded image. 
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This graphic shows the tonal range of each of the Log controls when used with a log-encoded image

As you can see, when used with a log-encoded image the color interactions between each 
adjustment overlap very softly, while still allowing more specific adjustments than those made by 
the Lift/Gamma/Gain controls.

Furthermore, the boundaries of the Shadows, Midtones, and Highlights Log controls can be 
customized using the Low and High Range parameters. This gives you added flexibility to apply 
more specific contrast and color adjustments.

Once you’ve made an adjustment using Log mode controls along with a normalizing LUT or curve 
adjustment, you can always apply additional nodes and use the Primaries mode of the Color Wheels 
palette to make further alterations to the now normalized image, working as you normally would 
with any of the other tools in Resolve.
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Using the Log Mode Controls to Stylize Normalized Media

You can also use the Log mode controls on normalized images. Although the results you get 
will be somewhat different, this can be a fast way to create interesting stylizations. Whereas the 
broadly overlapping tonal ranges of the Lift, Gamma, and Gain color balance controls allow subtle 
adjustments to be made very easily, the Log palette’s color balance controls affect much more 
restrictive tonal zones that overlap much less when used on normalized images.

The following illustration shows an approximation of how the Shadows, Midtones, and Highlights, 
by default, divide the tonal range of the image into non-overlapping thirds. As you saw in the 
previous section, these divisions were originally intended to map to log-encoded media. However, 
with normalized media these divisions provide a different, and potentially useful, set of ranges from 
the Primaries mode controls. 

Shadows Midtones Highlights

High RangeLow Range

This graphic shows the tonal range of each of the Log controls with the additional low and high range to expand or contract the range

With normalized media, the Shadows really do only affect the darkest shadows, falling off at 
approximately the bottom third of image tonality. The Midtones affect only the middle third of 
grays, and the Highlights affect the brightest top third of image values. However, these default 
ranges of image tonality can be adjusted using the Low Range and High Range controls, which are 
described in more detail later.

The following image shows the default interaction of extreme corrections made to a grayscale 
image using the Log mode controls. The Shadows have been pushed toward green, the Midtones 
have been pushed toward blue, and the Highlights have been pushed toward red.
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Extreme adjustments showing the overlap of the Shadow, Midtone, and Highlight color balance controls

As you can see, with normalized media the color interaction between each adjustment is very subtle. 
The darkest shadows end up bright green, the midtone values are vivid blue, and the highlights are 
almost pure red. This restrictiveness is useful when you want to limit a correction to a specific tonal 
range within the image without needing to use a Luma qualifier. It’s also quite useful for making 
bold, stylistic color adjustments when creating a non-naturalistic look.

Adjusting Tone Ranges In Log Mode

Two parameters let you modify the range of Shadows and Highlights that each Color Balance 
control affects, in turn narrowing and widening the range of Midtones. Keep in mind that while the 
ranges can be customized, the amount of overlap between each range cannot.

 > Low Range: Moves the border where the Shadows and Midtones meet. Lowering this 
parameter widens the range affected by the Midtones, and narrows the range affected by 
the Shadows. Raising this parameter narrows the Midtones and widens the Shadows.

 > High Range: Moves the border where the Midtones and Highlights meet. Lowering the 
High Range parameter narrows the range affected by the Midtones, and widens the 
range affected by the Highlights. Raising this parameter narrows the Highlights and 
widens the Midtones.

There are also Saturation and Hue parameters which mimic these settings found within other 
palettes and modes.
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Adjusting Contrast in Log Mode

When using the Log mode controls, your primary tools for adjusting image contrast will usually be 
the Offset master wheel and Contrast and Pivot parameters. Using these three controls, you can set 
a black point and adjust the overall contrast very quickly.

The Shadow, Midtone, and Highlight master wheels let you adjust image lightness within the 
same restrictive ranges of image tonality that are defined by the Low Range, High Range, and 
Pivot parameters. These adjustments should appear smooth, if somewhat narrower then the Lift/
Gamma/Gain controls, when used with log-encoded media. However, when used with normalized 
images, severe adjustments made with one master wheel may not always make a smooth transition 
to the next adjacent range of image lightness.

Note: Because these controls are so restrictive when used with normalized images, it’s easy to 
create solarization effects by raising the shadows to be higher than the Midtones, or lowering the 
Highlights to fall below the Midtones, to give two examples.

Log Offset Color and Master Controls

The Log controls also share the same Offset Color Balance and Master Wheel controls that appear 
in the Lift/Gamma/Gain mode of the Color Wheels palette (which are tied to the Offset controls of 
the Primaries palette).

 > The Offset color balance control: Works as a simultaneous adjustment to all three Offset 
sliders located in the Primaries palette; adjustments made to the Offset color balance 
control also alter the Offset sliders. Used subtly, this makes it easy to neutralize color 
imbalances in the darkest part of the image, while simultaneously rebalancing every other 
part of the image. Used more dramatically, this control makes it easy to add a color wash 
throughout the entire image.

 > The Offset wheel: Acts as a global adjustment to image lightness, an operation sometimes 
referred to as setup, raising or lowering all YRGB channels together.

When using a DaVinci control surface, the Offset color balance control is adjusted in either Lift/
Gamma/Gain or Log modes via the fourth trackball, while the Offset wheel is adjusted via the ring 
surrounding the fourth trackball.

Switching to Log Mode Using the DaVinci Control Surface

You can switch to the Log grading mode of the currently selected node by pressing the LOG soft 
key on the Center panel of the DaVinci control surface. Press the MAIN soft key to return to the 
more traditional Lift/Gamma/Gain mode of adjustment.
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The Primaries palette occupies the Left Palette panel by default when you first open the Color 
page, and contains the original set of DaVinci Resolve color adjustment sliders. These sliders serve 
two uses. First, they’re highly visible indicators of the individual YRGB channel adjustments that are 
made using the trackballs, rings, and knobs of a control surface. Second, they provide control of 
individual YRGB Lift/Gamma/Gain parameters using a mouse, tablet, or trackpad.

Primary grading controls

RGB Lift/Gamma/Gain Sliders

The most prominent controls of the Primaries palette are the individual Luma (or Y), Red, Green, 
and Blue sliders, four each for Lift, Gamma, and Gain. These sliders correspond to a set of knobs on 
the POTS page of the DaVinci control surface, and provide precise Lift/Gamma/Gain style control 
over each of the YRGB channels of the image. When used in conjunction with a Parade Scope video 
analysis of the image, these controls can enable you to fix irregular color imbalances in specific 
channels quickly.

Additionally, the Luma (Y) Lift/Gamma/Gain sliders correspond to the three knobs arranged 
vertically to the left of the Center panel of the DaVinci control surface. These three controls allow 
easy Y-only adjustments to contrast, where an increase in contrast results in perceptually diminished 
color saturation. 

Making Y-only adjustments to contrast is a great way to increase contrast when you’re going for 
muted saturation or a gritty look. This kind of adjustment is also useful in situations where you’re 
trying to increase shadow density without increasing image colorfulness.

Four Master Wheel controls appear underneath each group of Lift/Gamma/Gain sliders. The first 
three of these controls are identical to the Lift/Gamma/Gain master wheels in the Primaries mode 
of the Color Wheel palette, and control YRGB contrast, while the fourth is identical to the Offset 
master wheel found in the Log mode of the Color Wheel palette.

Primaries Palette
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Finally, each group of Lift/Gamma/Gain sliders has its own reset button. To reset individual channels, 
double-click the single-letter label underneath that slider.

To adjust RGB Lift/Gamma/Gain using the DaVinci control surface:

1. Press the POTS soft key on the main page of the Center panel.

2. Use the variously identified LUM/RED/GREEN/BLUE and OFFSET/BLACK/GAMMA/GAIN 
knobs to make the required adjustments.

3. Press the MAIN soft key to return to the Center panel’s main page.

Offset Sliders and Wheel

These vertical sliders mirror the settings of the Offset color balance controls in the Color Wheel 
palette, except that they provide individual control over the Red, Green, and Blue color channels. 
When you drag one of the Offset sliders up or down, you raise or lower that color channel in its 
entirety, which can be useful for adjusting color channels that are particularly problematic.

Offset RGB and master controls

Each Offset slider also has a pair of arrow buttons, one at the top and one at the bottom. These 
buttons provide “Printer Point” adjustment of these values, which let you adjust each Offset channel 
in discrete increments. Printer Points can be useful for projects that have tight integration with a film 
lab, and are designed to emulate color adjustments made using optical printers.

The Offset wheel control underneath the Offset sliders lets you adjust all three sliders at once, 
performing a setup adjustment. The Offset sliders, Printer Point buttons, and Offset wheel can be 
adjusted using the DaVinci control surface.
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To adjust the Offset sliders individually using the DaVinci control surface:

 > Use the MASTER OFFSET, RED OFFSET, GREEN OFFSET, and BLUE OFFSET knobs on the 
main page of the Center panel.

To adjust Offset Printer Points using the DaVinci control surface:

1. Press the PRINTER LITES soft key on the main page of the Center panel to display the Printer 
Points controls page on the Transport panel.

2. Use the + and – MASTER, RED, GREEN, and BLUE buttons that appear on the Transport panel.

3. Press PRINTER LITES again to return the Transport panel controls to their previous state.

There’s also a special set of keyboard shortcuts, mapped to the numeric keypad of an extended 
keyboard, that lets you make Printer Point adjustments in discrete increments, adding or subtracting 
a point at a time.

To use the Printer Lights Hotkeys:

 > Choose Color > Printer Lights Hotkeys, or press Option-Command-Grave Accent (`)

When you enable Printer Lights Hotkeys, there are two sets of shortcuts you can use to manipulate 
printer points. If you want to directly manipulate RGB, there’s one set for that, which makes sense 
when used on a numeric keypad.

However, if you want to work in the classic way by manipulating cyan, magenta, and yellow, there’s 
another set of shortcuts for that, using the remaining keys on the numeric keypad.

Note: The increments used by the Printer Point buttons are defined by the Printer Light Step 
Calibration parameters, found in the General Options of the Setup window. For more information, 
see Chapter 2, “Project Settings.”

Red Green Blue

7 +Red 8 +Green 9 +Blue

4 – Red 5 – Green 6 –Blue

Red Green Blue

1 +Cyan 2 +Magenta 3 +Yellow

Minus (–) –Cyan 0 –Magenta Period (.) –Yellow
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Saturation, Hue, and Lum Mix in the Primaries palette

The Saturation, Hue, and Lum Mix parameters mirror the three knobs found at the right of the 
Center panel of the DaVinci control surface, and are mirrored by the same parameters found in the 
Color Wheel palette.

 > Contrast: This one parameter lets you increase or reduce the distance between the darkest 
and lightest values of an image, raising or lowering image contrast. The effect is similar 
to using the Lift and Gain master controls to make simultaneous opposing adjustments. 
Bright and dark parts of the image are pushed apart or brought together about a center 
point defined by the Pivot parameter.

 > Pivot: Changes the center of tonality about which dark and bright parts of the image are 
stretched or narrowed during a contrast adjustment. Darker images may require a lower 
Pivot value to avoid crushing the shadows too much when stretching image contrast, while 
lighter images may benefit from a higher Pivot value to increase shadow density adequately.

 > Saturation: Increases or decreases overall image saturation. At higher values, colors appear 
more intense, while at lower values, color intensity diminishes until, at 0, all color is gone, 
leaving you with a grayscale image.

 > Hue: Rotates all hues of the image around the full perimeter of the color wheel. The default 
setting of 50 shows the original distribution of hues. Raising or lowering this value rotates all 
hues forward or backward along the hue distribution as seen on a color wheel.

 > Lum Mix: Lets you control the balance between YRGB contrast adjustments you’ve made 
using the Master Wheels or ganged Custom curves, and Y-only contrast adjustments made 
using the Y-channel Lift/Gamma/Gain controls of the Primaries palette or the unganged 
Luma curve. At the default of 100, YRGB and Y-only contrast adjustments contribute 
equally. Reducing this value diminishes the effect of Y-only contrast adjustments until, at 0, 
Y-only contrast adjustments are turned off.

Additionally, you’ll notice that at a Lum Mix setting of 100, individual adjustments to R, G, 
or B using the RGB sliders or unganged Custom curves result in automatic adjustments 
being made to the other two color channels in order to maintain constant Luma levels. At 
a Lum Mix setting of 0, individual color channel adjustments have no effect on the other 
color channels.

Like most parameters in Resolve, clicking and dragging a parameter’s name or value to the left or 
right lowers and raises that parameter with a virtual slider, while double-clicking that parameter’s 
number lets you edit it numerically, and double-clicking that parameter’s name resets the parameter 
to its default position.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

430

The RGB Mixer palette lets you remix different amounts of image data from one channel to another, 
and has a wide variety of creative and utilitarian uses. Furthermore, the RGB Mixer can be used 
either to remix the color channels, or to add different proportions of each color channel into a 
monochrome image.

RGB mixer palette

By default, the RGB Mixer palette is set to mix any amount of the Red, Green, and Blue color 
channels into any of the other channels. Each color channel has a dedicated control group of Red, 
Green, and Blue sliders that you use to do the mixing, and the default values of these can be seen 
in the screenshot above.

Each slider has an overall range of -2.00 to +2.00. This means that you also have the option of 
subtracting any combination of color channel values from a particular channel. For example, you 
can lower the Red control group’s Green slider to -.24 to subtract 24 percent of the Green channel 
from the Red channel.

RGB Mixer Palette
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Preserve Luminance

With “Preserve Luminance” turned on in the Options menu at the upper right of the Palette panel, 
any channel adjustment you make is prevented from altering the luma of the image by automatically 
raising or lowering the other two channels to compensate. In the following example, you can see 
that when “Preserve Luminance” is turned on, lowering the Green control group’s Green slider 
results in the Red and Blue channels being raised by the same amount (as seen in the Parade scope). 
Conversely, raising a color channel’s slider ends up lowering the other two channels by the same 
amount to keep overall image luminosity the same.

The result of an RGB Mixer adjustment with “With luminance level preserved” turned on.  

You can see that lowering the green channel slider also raises red and blue.

Resetting the RGB Mixer

Choosing Reset from the RGB Mixer’s Option menu resets each slider to its default position, where 
Red = 1.00 for Red output, Green = 1.00 for Green output, Blue = 1.00 for Blue output, and all other 
sliders = 0.

Swap Channels Buttons

A set of three buttons at the bottom of the RGB Mixer lets you easily swap two channels with one 
another. This can be useful as part of a creative look, or corrective in instances where two channels 
are accidentally reversed.

 > Swap Red and Green: Swaps these two color channels.

 > Swap Green and Blue: Swaps these two color channels.

 > Swap Red and Blue: Swaps these two color channels.
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Using the RGB Mixer in Monochrome Mode

When you enable Monochrome in the RGB Mixer palette’s Options menu, two of the sliders within 
each Output group are disabled. This leaves the Red > Red slider, the Green > Green slider, and 
the Blue > Blue slider as the only available controls.

Sliders at their default values when “To monochrome” is enabled

Keeping in mind that each of the color channels that makes up an image is itself a grayscale channel, 
the RGB sliders in Monochrome mode let you add different proportions of the Red, Green, and 
Blue color channels together to create custom grayscale versions of a shot.

To understand why this is useful, let’s consider the default values of the Red, Green, and Blue sliders. 
To emulate the human eye’s sensitivity to the wavelengths of light, the Rec. 709 video standard 
defines an isolated Luma (Y’) component as consisting of 0.2126 of the Red channel, 0.7152 of the 
Green channel, and 0.0722 of the Blue channels added together. This can be seen in the default 
values (rounded to the nearest integer percentage) of 21, 71, and 7.

This is the standard method of deriving a black and white version of a color image, and in fact 
produces identical results to those obtained by setting the Saturation parameter to 0. 

However, there have traditionally been other ways of mixing the colors of life into different 
grayscale interpretations. For example, photographers often use colored filters in conjunction with 
black & white film stocks, such as a yellow/green filter to emphasize pleasing skin tone for lightly-
complexioned people. A much older example is the use of black & white film stocks with different 
sensitivities (old orthochromatic stocks were not sensitive to red wavelengths, recording only blue 
and green to create an image).

Using the RGB Mixer with “To monochrome” turned on gives you the ability to mix your own 
custom blends of all three color channels to emphasize the creative characteristics you require. 
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For instance, increasing the mix of blue and decreasing red and green can give skin tones a darker, 
metallic sheen. The following screenshots show multiple versions of the same image with different 
monochrome mixes.

Three monochrome mixes of the same image. The top image is the result of setting saturation to 0.

Like the parameters in Color mode, you can use the RGB Mixer’s Monochrome mode to subtract 
one color channel from the others, for even more creative effects.
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RGB Mixer Controls on the DaVinci Control Surface

All of the RGB Mixer palette controls are available from the DaVinci Resolve control surface.

To open the RGB Mixer curve controls on the DaVinci Resolve control surface:

 > Press the CURVES soft key on the main page of the Center panel.

To exit the RGB Mixer curve controls:

 > Press the MAIN soft key on the Center panel.

To adjust the principle color regions using knobs:

 > Adjust one of the four groups of knobs on the Center panel. All are labeled to identify 
which RED/GREEN/BLUE source channels are paired with RED/GREEN/BLUE destination 
channels. For example GREEN->BLUE adds or subtracts an amount of the Green color 
channel from the Blue color channel.

 > Press the PRESERVE LUM soft key to turn on the “With luminance level preserved” 
checkbox.

 > Press MONO to turn on the “To monochrome” checkbox.

 > Press COLOR to turn off the “To monochrome” checkbox.
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Motion Effects Palette

The Motion Effects palette contains two sets of controls for applying optical-flow-calculated effects 
to clips in your program, enhanced Spatial and Temporal noise reduction, and motion-estimated 
artificial motion blur.

Noise Reduction Controls

Two sets of parameters let you apply GPU-accelerated Spatial and/or Temporal noise reduction 
that’s designed to let you subdue noise in problematic clips, in close to real time on workstations 
with appropriate processing power. Both methods of noise reduction can be used separately or 
together, in varying amounts depending on the needs of the particular material you’re working 
on. Furthermore, each set of controls is highly customizable, allowing for varying amounts of noise 
reduction to the chroma and luma of an image, as well as numerous options for how to apply this 
noise reduction.

Noise Reduction controls

Spatial NR Controls

The Spatial NR controls let you smooth out regions of high-frequency noise throughout the image, 
while attempting to avoid softening by preserving detail. It’s effective for reducing noise that 
Temporal NR can’t.

 > Radius: Options include Large, Medium, and Small. A smaller radius offers greater real 
time performance, and can provide good quality when using low Luma and Chroma 
Threshold values. However, you may see more aliasing in regions of detail when using low 
NR Threshold values.
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 > Setting Radius to be progressively larger results in higher quality within areas of greater 
visual detail at high Luma and Chroma Threshold values, at the expense of slower 
performance. An NR Radius of Medium should provide suitable quality for most images 
when using medium NR Threshold settings. As with many operations, there’s an adjustable 
tradeoff between quality and speed.

 > Luma Threshold: Lets you determine how much or how little noise reduction to apply to 
the luma component of the image. The range is 0-100, where 0 applies no noise reduction 
at all, and 100 is the maximum amount. Too high a setting may eliminate fine detail from 
the image.

 > Chroma Threshold: Lets you determine how much or how little noise reduction to apply to 
the chroma component of the image by smoothing out regions of high-frequency noise 
while attempting to preserve the sharpness of significant edge details. The range is 0-100, 
where 0 applies no noise reduction at all, and 100 is the maximum amount. Too high a 
setting may eliminate fine color detail from the image, although you may find you can raise 
the Chroma Threshold higher then the Luma Threshold with less noticeable artifacting.

 > Luma/Chroma Threshold ganging: Ordinarily, the Luma and Chroma Threshold parameters 
are ganged together so that adjusting one adjusts both. However, you can ungang these 
parameters in order to adjust different amounts of noise reduction to each component of 
the image. For example, if an image softens too much at a certain level of noise reduction, 
but you find there’s more color speckling then there is luma noise, you can lower the Luma 
Threshold to preserve detail while raising the Chroma Threshold to eliminate color noise.

 >NR Blend: Lets you dissolve between the image as it’s being affected by the Spatial NR 
parameters (at 0.0) and the image with no noise reduction at all (100.0). This parameter lets 
you easily split the difference when using aggressive temporal noise reduction.

Temporal NR Controls

The Temporal NR controls analyze images across multiple frames in order to isolate noise from 
detail. Motion estimation settings let you exclude moving subjects from this operation in order to 
prevent unwanted motion artifacts.

 >Number of Frames: The number of frames you want Resolve to average in order to separate 
detail from the noise. You can choose between 0 and 2 frames. 0 applies no frame averaging, 
2 applies maximum frame averaging. A value of 2 frames gives the best analysis, but can 
yield unwanted artifacts for fast-moving images. A value of 1 can yield better results for 
fast-moving images.

 >Motion Est. Type: Picks the method Resolve uses to detect motion in the image. The 
default, Faster, is less processor intensive, but less accurate. Choosing Better can effectively 
exclude motion more accurately, but is more processor intensive. None lets you disable 
motion estimation altogether, with the result being the application of Temporal NR to the 
entire image.
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 >Motion Range: Three settings, Small, Medium, and Large, let you set the speed of motion 
that Motion Estimation should expect to exclude. A Small setting assumes slow-moving 
subjects with little or no motion blur, allowing Temporal NR to affect more of the image at 
a given Motion Threshold setting. A Large setting assumes fast motion with blur occupying 
a larger area of the image, which excludes more of the image from Temporal NR at the 
same Motion Threshold setting. Choose the setting that gives you the best compromise 
between a reduction in noise and the introduction of motion artifacts when adjusting the 
Motion Threshold parameter.

 > Luma Threshold: Lets you determine how much or how little Temporal NR to apply to the 
luma component of the image. The range is 0-100, where 0 applies no noise reduction 
at all, and 100 is the maximum amount. Too high a setting may eliminate fine detail from 
the image.

 > Chroma Threshold: Lets you determine how much or how little Temporal NR to apply to the 
chroma component of the image. The range is 0-100, where 0 applies no noise reduction 
at all, and 100 is the maximum amount. Too high a setting may eliminate fine color detail 
from the image, although you may find you can raise the Chroma Threshold higher then the 
Luma Threshold with less noticeable artifacting.

 > Luma/Chroma Threshold ganging: Ordinarily, the Luma and Chroma Threshold parameters 
are ganged together so that adjusting one adjusts both. However, you can ungang these 
parameters in order to adjust different amounts of noise reduction to each component of 
the image, depending on where the noise happens to be worst.

 >Motion Threshold: Defines the threshold separating which moving pixels are in motion (above 
this threshold) versus which moving pixels are static (below this threshold). Using Motion 
Estimation, Temporal Noise Reduction is not applied to regions of the image that fall above 
this threshold, in order to prevent motion artifacts by not applying frame-averaging to parts 
of the image that are in motion. Lower values omit more of the image from Temporal NR 
by considering more subtle movements. Higher values apply Temporal NR to more of the 
image by requiring faster motion for exclusion. You can choose between 0 and 100, where 
0 applies Temporal NR to no pixels, and 100 applies Temporal NR to all pixels. The default 
value is 10.7, which is a suitable compromise for many clips. Be aware that if you set too high 
a Motion Threshold, you may see artifacts in moving parts of the image.

 >NR Blend: Lets you dissolve between the image as it’s being affected by the Temporal NR 
parameters (at 0.0) and the image with no noise reduction at all (100.0). This parameter lets 
you easily split the difference when using aggressive temporal noise reduction.
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Using Noise Reduction

The following procedure suggests a method of using the Noise Reduction (NR) parameters to 
achieve a controlled result.

Applying noise reduction to an image:

1. Enable Temporal NR by choosing either 1 or two frames from the Number of Frames pop-
up menu.

2. Choose options from the Motion Est. Type and Motion Range pop-up menus corresponding 
to how much motion is in the image. If there’s a lot of motion, you may need to choose Better 
and Large. If there’s not very much motion, lesser settings may suffice.

3. With Luma and Chroma Threshold linked, slowly raise either parameter until you just start 
to see a reduction in noise within the non-moving areas of the image, then make smaller 
adjustments to determine the maximum amount of Temporal NR you can add without creating 
motion artifacts, or overly softening image detail you want to preserve. 

4. If there’s obviously more chroma than luma noise in the image, you can disable Luma/Chroma 
linking at a satisfactory level of luma noise reduction, and then raise the Chroma Threshold to 
apply more aggressive Temporal NR to address color speckling in the picture.

5. If you’re not satisfied with the tradeoff between the maximum possible threshold of noise 
reduction and the prevention of motion artifacts, you may want to adjust the Motion Threshold 
setting, lowering it to omit more of the motion from the noise reduction operation, or raising 
it to include more motion. If you’re still not satisfied, you can also try better Motion Est. Type 
and Motion Range settings.

Before and After Temporal NR to reduce noise in unmoving areas of the image
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 Keep in mind that the strength of Temporal NR is to reduce noise in unmoving parts of the 
image. When you’ve achieve the best tradeoff between noise reduction in the still areas and 
avoidance of motion artifacts in the moving areas of the image, then it’s time to turn to Spatial 
NR to further eliminate noise throughout the rest of the picture.

6. Enable Spatial NR by raising either the Luma or Chroma Threshold parameters, which are 
linked by default, until you strike a suitable balance between the reduction of noise, and an 
unwanted increase in image softness.

7. If there’s obviously more chroma then luma noise in the image, you can disable Luma/Chroma 
linking at a satisfactory level of luma noise reduction, and then raise the Chroma Threshold to 
apply more aggressive Spatial NR to address color speckling in the picture.

Before and after noise reduction improves the ‘look’

8. If you’ve had to use a high Spatial NR Luma or Chroma Threshold setting to reduce noise 
visibly, and areas of detail look a bit chunky or aliased, you can choose a larger setting from 
the Radius pop-up menu to enable a more detailed analysis of the scene.

 This will result in higher visual quality, but larger NR Radius settings are more processor 
intensive, and may reduce real time performance if you don’t have adequate GPU resources 
available to your system.

9. If you’ve found suitable noise reduction settings, but the result is too aggressive and makes 
the image appear too processed, you can try raising the Spatial NR and/or Temporal NR Blend 
parameters to fade between the noise reduction added by each set of controls, and the image 

as it was before you added noise reduction.
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Try Applying Temporal NR First, then Applying Spatial NR

Because Temporal NR analyzes multiple frames for its noise isolation, it tends to be better at 
preserving detail accurately in regions of the image where there’s little motion. If you try applying 
Temporal NR first and get a successful result, even if only in part of the image, you may reduce how 
much Spatial NR you have to apply, thus improving the overall quality of your final result.

Keep in mind that while Temporal NR does a great job in unmoving parts of an image but is less 
effective when dealing with subjects in motion, Spatial NR is able to reduce noise everywhere in the 
frame falling below its threshold, even when there’s motion. Ultimately, a combination of the two is 
almost always going to be a winning combination. 

Spatial NR Radius, How Large Should You Go?

Larger NR Radius settings can dramatically improve the quality of high-detail regions in shots where 
you’re using aggressive Spatial noise reduction, but it’s not necessary to always jump to the large 
Radius setting, which provides the highest precision. In many cases, when evaluating an image that 
you’re applying noise reduction to, you may not actually be able to perceive the additional quality, 
and you’ll waste processing time on an unnecessary level of correction.

It’s a good idea to make sure that you’re evaluating the full-frame image on a large enough display 
to see the noise you’re working on within the viewing context of the intended audience. Zooming 
really far into a clip while applying noise reduction may encourage you to use higher quality settings 
than are necessary, because an excessively enlarged detail of an image lets you see subtle changes 
that you wouldn’t notice at actual size.

Limiting Noise Reduction in Useful Ways

As with any other correction in the Color page, noise reduction can be limited using HSL Qualification 
or Power Windows. This means you can focus your efforts on reducing noise in the most problematic 
areas of an image (for example, in shadows and background regions), while sparing elements that 
you don’t want to affect (such as faces or better-lit areas of the image).

Furthermore, you can use Spatial NR in lieu of Blur operations to perform a subtler form of 
complexion smoothing, using the HSL Qualifier or a Window to isolate an actor’s skin tone for 
targeted noise reduction.

Controlling the Order of Operations for Noise Reduction

You can apply noise reduction at any point in your image processing tree using a dedicated node. If 
you have an image with noise that you think might be enhanced by whatever corrections you need 
to make (increasing the contrast of underexposed clips often increases whatever noise is within an 
image), there are two approaches to noise reduction:
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 > Apply noise reduction at the beginning of a node tree: This lets you pre-emptively eliminate 
any noise before it becomes a problem as a result of whatever adjustments you’re planning 
to make. The result can be smoother, but you may also notice that the edge detail within 
the image is a bit softer.

 > Apply noise reduction at the end of a node tree: The alternative is to make your adjustments 
first, and then apply noise reduction in a separate node afterwards. In this case, you may 
find that the noise reduced regions of the image aren’t quite as smooth, however the edge 
detail within the image may be visibly sharper as a result.

 > Apply Noise reduction to only one color channel of an image: Using the Splitter/Combiner 
nodes, you can also apply noise reduction to only one color component of an image. If 
you’re grading a video clip with a noisy Blue channel, this can be a way to focus noise 
reduction where it’s needed.

Neither result is universally better or worse than the other. Which is preferable depends on the 
image you’re working on, and the type of result you’re looking for (you might prefer some shots to 
be a bit softer, while you’d like other shots to be a bit sharper). The real point is that the node-based 
image processing of DaVinci Resolve lets you choose which technique works best for you.

Note: If you apply noise reduction and make color adjustments within the same node, noise 
reduction is processed first, followed by color adjustments.

Using Noise Reduction Controls with the DaVinci Control Surface

All three Noise Reduction controls are available via knobs on the PRIMARIES, NOISE REDUCTION 
control group on the Center panel.

To open the Noise Reduction controls on the DaVinci control surface:

 > Press the PRIMARIES or MAIN soft key on the Center panel, whichever is visible (depending 
on which control group is currently displayed).
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Motion Blur

Motion Blur settings use optical-flow based motion estimation to add artificial motion blur to clips 
that have none. This can be useful in cases where a program was shot using a fast shutter speed, 
and you later decide that the resulting video has too much strobing. By analyzing the motion within 
a clip, the Motion Blur settings can selectively apply blurring to the image based on the speed and 
direction of each moving element within the scene.

Motion Blur controls

Three parameters let you set how much motion blur to add, and at what quality:

 >Motion Est. Type: A setting of Better provides more accurate pixel mapping at the expense 
of being more processor intensive. Faster provides a more approximate result, but is less 
processor intensive.

 >Motion Range: Determines what speed of motion to consider when defining regions 
being blurred.

 >Motion Blur: Raise this parameter to add more motion blur to the image, lower it to add less. 
The range is 0-100, where 0 applies no motion blur, and 100 applies maximum motion blur.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

443

OpenFX is an open plug-in standard intended to enable easier development of cross-platform 
visual effects plug-ins for a variety of applications. Popular plug-in packages include the GenArts 
Sapphire plug-ins which are a ubiquitous tool for feature and broadcast work, but there are many 
other plug-in collections from other vendors available, and the numbers grow as this format 
becomes more widely adopted. With OpenFX support, you can use plug-ins to do many stylized 
operations that would be difficult or impossible to do using the other tools in Resolve.

This kind of optical effect would be impossible to do without plug-in support

The installation and licensing of OpenFX plug-ins is handled by a vendor’s own installer. Once 
installed, OpenFX plug-ins appear within the Library of the Open FX Panel, which can be opened 
by clicking the FX button at the bottom right of the Node Editor.

Click the FX button to open the OpenFX Library

When you click the FX button, the Open FX Panel opens out of the right side of the Node Editor 
to show the Library, resizing the Viewer, Gallery, and Node Editor to make room. The OpenFX 
Library is organized hierarchically. Each vendor’s plug-ins appear under a header with the name 
of that plug-in collection and a disclosure triangle at the right that can be closed to make room 
for browsing other collections. Within a given collection, plug-ins may be further organized into 
categories, separated by headers with disclosure triangles, which let you make the Hierarchy as 
compact or spread out as you like.

OpenFX
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The Library in the Open FX Panel

Since many OpenFX plug-in collections are quite large, a Search field at the top of the Library lets 
you quickly find plug-ins by name or partial name. Typing a few letters is enough to isolate only 
those plug-ins that have that character string within their name.

Applying OpenFX Plug-Ins

Once you’ve found an OpenFX plug-in you want to use in the Library, simply drag and drop it onto 
a new node to apply that plug-in’s effect within your grade. Nodes with an OpenFX plug-in applied 
have an FX badge in the upper right-hand corner.

A node with an OpenFX plug-in applied

You can only apply one OpenFX plug-in to a node at a time, but by using multiple nodes you can 
add as many OpenFX plug-ins to your grade as you need.
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OpenFX Plug-ins Are Processor Intensive

Because they create such a wide variety of effects, some OpenFX plug-ins can be extremely 
processor intensive, all the more if you add multiple plug-ins to a single grade. If you find your 
playback performance dropping because of a particularly expensive effects operation, you can 
right-click that clip’s thumbnail and choose Mark Clip for Render Cache to flag the clip for caching. 
Then, choosing Playback > Render Cache > User will initiate the caching of all user-flagged clips, 
which will render during inactive moments when you’re not working. Once fully cached, you can play 
these clips back in real time, at least until you change that clip’s grade again. For more information 
on caching, see “More About the Render Cache” earlier in this chapter.

OpenFX Settings

When you select a node with an OpenFX plug-in applied to it, the Open FX Panel switches to the 
Settings, which show you every single parameter associated with that plug-in, ready for customization.

Some of the parameters of the GenArts Sapphire Glint Rainbow plugin

Adjust any of the standard controls to manipulate that plug-in’s effect on the image.
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OpenFX On-Screen Controls

When you select a node with an OpenFX plug-in applied to it that has on-screen controls, the 
Viewer Mode pop-up automatically changes to OpenFX Overlay mode, and the available controls 
appear within the Viewer. Different plug-ins expose different custom controls, letting you control 
the effect or manipulate the image, depending on that plug-in’s function.

Adjusting the on-screen controls exposed by the GenArts Sapphire Glint Rainbow plug-in

Using OpenFX

The following procedures describe how you can work with OpenFX plug-ins within the Color page.

Methods of working with OpenFX:

 > To find an OpenFX plug-in: Click the FX button at the bottom right of the Node Editor to 
open the Open FX Library. Then type a name, or part of a name, into the search field at the 
top. The list shrinks to only show those plug-ins that have the text you typed somewhere 
within their name.

 > To add an OpenFX plug-in to a node: Drag a plug-in from the OpenFX Library onto a 
node. If you drag a plug-in onto a node that already has a plug-in, the previous plug-in 
will be overwritten.

 > To remove an OpenFX plug-in from a node: Right-click a node showing the FX badge, and 
choose Remove OFX Plug-in from the contextual menu.

 > To edit the parameters of an OpenFX plug-in: Select any node with an FX badge, and open 
the Open FX Panel to show the Settings list. You can switch to the Library by clicking the 
Library button.

 > To use OpenFX on-screen controls in the Viewer: Select any node with an FX badge, and 
the on-screen controls, if there are any, should appear in the Viewer. If not, make sure the 
Viewer mode pop-up is set to FX.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

447

The Curves palette, selectable via one of the toolbar buttons above the Center Palette panel of the 
Color page, has six modes that provide different curve-based methods of manipulating the color 
and contrast of an image. Each curve lets you adjust a customizable region of the image based 
either on image tonality (zones of lightness or darkness), or hue (specific colors). All curves can be 
adjusted using either the pointer, or knobs on the DaVinci control surface.

Tip: All curves in DaVinci Resolve can be used to affect the overall image, or limited to affect only a 
specific portion of the image as a part of a secondary operation using HSL Qualification, Windows, 
Imported Mattes, or any combination of the three.

Adjusting Curves Using the Mouse

All curves have identical controls for basic on-screen adjustment using the mouse.

Methods of adjusting curves using the on-screen interface:

 > To add a control point: Click anywhere on or around a curve. A control point is added at the 
position of the mouse where you clicked, and the curve is altered, if necessary, to match the 
new control point’s position.

 > To add a control point without altering the curve: Hold the Shift key down, and click 
anywhere on or around a curve. A control point is added at the horizontal position of the 
pointer where you clicked, but the curve is not altered.

 > To remove a control point: Right-click any control point to make it disappear.

 > To reset a curve to a completely neutral setting: Click Reset.

 > To reset all Custom curves: Right-click anywhere within the Curves tab and outside of each 
curve control box and choose Reset Custom Curve.

By default, individual control points influence the portion of each curve that falls between its 
neighboring two control points. 

Control point adjustments affect the entire portion of a curve between adjacent control points.

Curves
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In the screenshot to the left, you can see that the control point at the position of the pointer is 
affecting the larger part of the curve that falls between the lower left-hand control point (which is 
there by default), and a user-created control point placed up within the highlights of the curve.

In the screenshot to the right, an additional control point to the left of the one being adjusted limits 
the area of the curve that is adjusted. By careful placement of additional control points, you can 
make extremely targeted adjustments to images using the Custom curves. 

This example highlights the importance of using control points to “lock off” portions of a curve at 
a neutral or nearly neutral position to prevent changes to specific portions of an image, even while 
using other control points to make changes.

Note: The Hue vs. Hue/Sat/Lum and Lum vs. Sat curves also have an optional adjustment mode 
using Bezier curves that will be covered in those sections.

Custom Curves

DaVinci’s Custom curves provide smooth adjustment of each clip’s Y, R, G, and B channels.

The Luminance, Red, Green, and Blue (YRGB) Custom curves at their neutral defaults

The YRGB Custom curves are useful for making more tonally specific, channel-by-channel 
adjustments to an image than can be accomplished using the Color Balance controls. They’re 
also useful for making strange and wonderful stylistic adjustments through unusual alterations to 
different combinations of color channels.

Each Curve Control area is square, and the default, neutral position of a curve is a diagonal line that 
runs from the lower-left black point of the image through the upper-right white point. 

The horizontal axis represents the range of image tonality in the original image, while the vertical 
axis represents the range of alteration you can make. By adding control points to the surface of 
the curve and raising or lowering different areas, you are actually remapping the original horizontal 
“input” value of a color channel to an “output” value of your choosing.
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Controls attached to each Custom curve; the handle on the upper-right hand side  

is the YSFX vertical slider, and the slider underneath is the Curve Mix slider

Tip: The background grid makes it easy to see which parts of any curve are at or near the diagonal 
default that represents no change made.

Ganging and Unganging Custom Curves

By default, the Custom curves are ganged, meaning that changes made to one curve are 
automatically made to all of the other curves.

When Custom curve ganging is enabled, changes to one curve are applied to all curves.

When ganged together, curve adjustments affect a clip’s YR GB channels all together, resulting in an 
adjustment to image contrast that’s similar to using the Master Wheels in the Color Wheels palette, 
or the ring controls of the DaVinci control surface. When making this type of adjustment, increasing 
contrast also increases image saturation, while reducing contrast also reduces image saturation. Since 
curves can be manipulated with greater specificity than the three Master Wheels, you can make much 
finer contrast adjustments using the YRGB curves then when using the Master Wheels only.
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To enable or disable Custom curve ganging:

 > Click the Options menu at the upper right-hand corner of the palette, and choose Gang 
Custom Curves. A checkbox indicates when it’s enabled.

Turning ganging off lets you use the full power of Custom curves to alter the image. Unlike the Color 
Balance controls, each of which adjust all three color channels simultaneously, the Curve controls let 
you adjust each channel individually when Gang Custom Curves is turned off. 

Turning off curve ganging lets you independently adjust each curve

Tip: When curve ganging is disabled, the Luma curve allows you to adjust the Y channel by itself, which 
is similar to using the Y-only Lift/Gamma/Gain knobs of the DaVinci control surface. When making this 
type of adjustment, increasing luma contrast results in a perceptual decrease of image saturation.

Copying Custom Curve Channels

Even if you’ve unganged the Custom curves, you can still mirror one curve’s adjustments to another 
by copying it. To copy a Custom Curve from one channel to another:

 >Option-drag the curve you want to copy onto the curve you want to paste to. The pointer 
appears with a plus sign underneath to indicate that you’re successfully dragging one curve 
onto another.
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Curve Intensity Sliders

Curve Intensity sliders underneath each curve control let you mix between the current curve’s effect 
on the clip, and the original state of the image before you altered the curve. The default Intensity 
of 100 results in that curve exerting its full effect on the image, while an intensity of 0 results in that 
curve having no effect on the image.

The Intensity sliders provide an easy way to “split the difference” between a curve adjustment and 
the previous state of the image.

Lowering the Curve Mix slider reduces the effect of that curve’s adjustment on the image.

YSFX Sliders

Each of the Custom curves (Y’, R, G, and B) has a vertical YSFX slider at the left of each curve control 
that lets you invert any or all color channels by any amount you want, to create different types of 
stylized effects.

Image with the Luma channel modified using the vertical YSFX slider

As with all other adjustments in the Color page, YSFX may be combined with Power Windows or HSL 
qualification to limit channel inversions to specific portions of the image for creative purposes.
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Large View Custom Curves

For clips where you need to make finer adjustments than the default size of the Custom curves will 
allow, you can temporarily enlarge the Custom curves inside a floating window. In this “large curve 
view,” it’s possible to do nearly everything you could do with the ordinary, smaller curves. When 
you’re finished making your adjustment, you can send this window away.

To use the Large Curve mode:

 > Click the Zoom Curves control, at the bottom center of the Curves palette.

Use the Large Curve view to make subtle changes

To exit the Large Curve mode:

 > Click anywhere outside of the floating window to close it.

Adjusting Custom Curves with the DaVinci Control Surface

The controls that correspond to the Custom curves on the DaVinci control surface are available by 
default when you first open Resolve (the rotary knobs on the Center panel will be labeled PRIMARIES). 
If these buttons are not visible, you need to switch to the Primaries controls using the soft keys.

To open the Primary Curve controls of the DaVinci Resolve control surface:

 > Press the PRIMARIES soft key on the center panel.

 > If the Center panel is currently in CURVES mode, then press the MAIN soft key on the 
Center panel.

The rotary knobs on the Center panel update to show the CHANNEL OFFSET/CUSTOM 
CURVES and YSFX controls.
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To make curve adjustments:

 > Adjust the DARK LUM, MID-DARK LUM, MID-LIGHT LUM, or LIGHT LUM rotary knobs.

By default, all adjustments you make using these controls are ganged across all four YRGB 
curve controls. However, if you turn Custom curve ganging off, then these controls only 
affect the Luminance curve.

These controls correspond to the following default control point positions on the Curve controls.

You also have the option of using the fourth trackball from the left to adjust individual control points 
on curves to any position you like. This works for all curves in DaVinci Resolve that have control 
surface mappings.

Methods of selecting and adjusting individual control points using the master trackball of the 
Center panel:

 > To select a control point to adjust: Spin the fourth ring control to the left or right to select 
the next control point in that direction (it takes about half of a turn to select another 
control point).

Selected control points are highlighted in cyan.

 > To move a selected control point: Adjust the fourth trackball to move the control point up, 
down, left, or right. Selected control points are constrained between whichever control 
points are to the left and right.

Another set of rotary knobs let you adjust Curve Mix and YSFX parameters.

To adjust the Curve Intensity sliders:

 > Adjust the LUM CURVE, RED CURVE, GREEN CURVE, or BLUE CURVE rotary knobs.

To make YSFX adjustments:

 > Adjust the LUM YSFX, RED YSFX, GREEN YSFX, or BLUE YSFX rotary knobs. 



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

454

Soft Clip

The Soft Clip mode provides an interface for adjusting highlight and shadow soft clipping either 
overall, with Gang Clips enabled, or on a per-channel basis. The Soft Clip controls are intended to 
provide clip-by-clip adjustment, as opposed to the Generate Soft Clip LUT settings, which let you 
set one soft-clipping setting for the entire program. For more information on the Soft Clip LUT 
setting, see Chapter 2, “Project Settings.”

High and Low soft clip controls within the Curves palette

Soft clipping lets you apply a “knee” to any clipping that occurs at the upper or lower extremes of 
the image, and can be used to quickly ease off any unpleasantly harsh loss of detail that occurs as a 
result of blowing out the highlights or crushing the shadows too aggressively.

In the following example, the screenshot at top has had the highlights deliberately blown out by 
excessively boosting the highlight contrast. As you can see, the edges of the clipped area lack 
detail. The screenshot at bottom shows the same image with soft clipping increased for all three 
color channels. The result retrieves detail, compressing the highlights to bring the tops of each 
color channel back within the allowable range.
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Using High Soft Clip to pull highlight details into the viewable range

Ganging and Unganging Soft Clip Controls

Soft clipping can be simultaneously applied to all three color channels by ganging them together 
(the default), or you can disable Soft Clip ganging to individually adjust each channel. For example, 
using soft clipping on individual channels can be useful for legalizing RGB out-of-gamut errors for 
channels that over or undershoot your QC standards.

To enable or disable Soft Clip ganging:

 > Click the Options menu at the upper right-hand corner of the palette, and choose Gang Clips.  
A checkbox indicates when it’s enabled.

Tip: Applying too much soft clipping to individual color channels may add an unwanted color 
tint to the corresponding highlights or shadows of an image. To avoid this, use the soft clipping 
parameters with ganging enabled to clip all three color channels equally.
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Soft Clip Controls

Whether all channels are ganged or not, soft clipping is controlled via two sliders and two additional 
parameters for each color channel.

Clipping point slider identified

High Clipping Point

The High Clipping Point vertical slider (to the left of each Clip Curve control) lets you adjust the 
maximum signal level above which the signal is clipped. Any pixels above the clipping level are 
made equal to the clipping level. 

The High Clipping Point defaults to a digital level of 1023 relative to the DaVinci Resolve internal 
video scopes. Lowering this slider causes the highlights of the image to clip at a lower level, resulting 
in lower, dimmer maximum levels.

At the default top position, no clipping occurs and image data that you push above 1023 on the 
internal scopes is preserved and passed through the image processing pipeline to subsequent 
nodes. For example, in the following two screenshots, the highlights in the screenshot at top are 
blown out raising the gain dramatically in Node 1. In the screenshot at bottom, a subsequent 
adjustment in Node 2 lowers the gain and retrieves all the previously clipped values.

RGB Parade displays the clipped imageSelecting and adjusting the high clip
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Middle–the image is clipped using the Gain control in Node 2; Bottom–image data that was clipped in Node 1 is  

retrieved in Node 3 by lowering the Gain control. This illustrates the preservation of deliberately clipped data.

However, if at any point in a node tree you lower the High Clip vertical slider, even by a single 
digit, all image data above the new clipping threshold is discarded from that node forward. In the 
following example, the High Clip slider in Node 1 is lowered. The result is that all clipped image 
data is discarded. As a result, when Node 2 lowers the gain, there is no image detail left to retrieve, 
and all three channels exhibit flattening.
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Lowering the High Clip slider in Node 1 forces all image data above the new High Clip threshold to be irretrievably  

discarded. Clipped data cannot be brought back by subsequent nodes

High Soft

The High Soft parameter sets the threshold, below the clipping point, at which highlights begin 
to compress before hard clipping. At 0, no soft clipping occurs. As you raise this value, more and 
more of the clipped highlight values are compressed, rather than clipped, resulting in softer, more 
pleasant “glowing” highlights. In the following screenshots, an image with deliberately boosted 
highlights is shown with High Soft set to 0, 500, and 1000, so you can see the difference.

Important: Image data that was clipped “in camera” is not necessarily retrievable using the Soft 
Clip controls, although there may be some preserved overhead in the super-white highlights of 
Y’CbCr-encoded video data.

Low Soft Clipping Point

The Low Soft Clipping Point vertical slider (to the right of each Clip Curve control) lets you adjust 
the minimum signal level at which the signal clips. This defaults to a digital level of 0 relative to the 
DaVinci Resolve internal video scopes. Raising this slider causes the shadows of the image to clip at 
a higher level, resulting in lighter minimum levels, and a lower-contrast image with lighter (possibly 
milky) shadows.

Low Soft

The Low Soft slider sets the threshold, above the minimum clipping point, at which shadows begin 
to compress before hard clipping. At 0, no soft clipping occurs. As you raise this value, more and 
more of the clipped shadow values are compressed, rather than clipped, resulting in a softer, more 
pleasant rolloff in the shadows.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

459

Using Soft Clipping Controls with the DaVinci Control Surface

The soft clipping controls can also be manipulated using the DaVinci control surface, which provides 
separate controls for ganged and individual color channels.

To open the soft clipping control on the DaVinci Resolve control surface:

 > Press the CLIPS soft key on the Center panel.

To exit the soft clipping controls:

 > Press the MAIN soft key on the Center panel.

To make a ganged soft clipping adjustment:

 > Adjust the MASTER CLIP or MASTER SOFT rotary knobs of the SCENE WHITE CLIPS or 
SCENE BLACK CLIPS control groups (there are 4 individual knobs).

These controls adjust all four corresponding YRGB High Soft, High Clip, Low Soft, or Low 
Clip parameters simultaneously.

To adjust soft clipping for individual color channels:

 > Adjust the RED/GREEN/BLUE CLIP or RED/GREEN/BLUE SOFT rotary knobs of the SCENE 
WHITE CLIPS or SCENE BLACK CLIPS control groups (there are 12 individual knobs).

Each control adjusts an individual YRGB color channel.

The Hue and Sat Curves

Three sets of Hue curves, and one additional Lum vs. Sat curve, let you make different types of 
curve-based alterations to the image. Whereas the Custom curves let you make adjustments to 
the color channels of an image based on tonality (for example, boosting the Red channel in the 
highlights while lowering it in the shadows), the Hue curves let you make adjustments to the hue, 
saturation, or luma of elements in an image based on their hue.

Curves controls including six-vector selection and bezier handle button
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For example, you could use the Hue vs. Sat curve to selectively lower the saturation of everything 
that’s blue, while raising the saturation of everything that’s blue.

You can use these curves to make adjustments similar to those made using HSL qualification, but 
with one critical difference. Curve adjustments are mathematically smoother than the matte-limited 
adjustments of HSL qualifiers, so it can sometimes be easier to make specific alterations that blend 
smoothly with the rest of the image, without the potential for artifacts at the edges of qualified keys 
that can sometimes defeat a seamless result. 

On the other hand, it is often easier to define more distinct boundaries between separate elements 
using HSL qualification. Only time and experience will help you determine which tools are best for 
which situations.

Top–Original image, Bottom–the image as altered by the Hue vs. Sat curve shown in the middle
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Unlike the Custom curves, which default to a diagonal position where lower left represents the 
black point and upper right represents the white point, Hue and Sat curves are flat. In the case of 
the Hue vs. Hue/Sat/Lum curves, the horizontal range of the curve from left to right represents the 
overall range of possible hues, from red through green through blue and then cycling back to red.

Because the range of hues cycle smoothly from the left to the right edge, changes that affect the 
curve near the left boundary of these curves loop smoothly around to the right boundary, and vice 
versa, such that the left and right sides of the curve always move together (as you can see in the 
above screenshot).

Important: When using Hue curves, the range of hue that you isolate with control points is always 
relative to the RGB input connected to that node. That means if you change the hue of a shirt from 
blue to red using Hue vs. Hue and you then want to raise the same shirt’s saturation with the Hue 
vs. Sat curve within the same node, you need to add control points to the same range of blue for 
both curves.

Image Sampling for Hue and Sat Curves

There’s an additional way to use Hue curves in Resolve. Whenever one of the Hue vs. Hue, Hue vs. 
Sat, Hue vs. Lum, and Lum vs. Sat curve tabs are open, clicking or clicking and dragging over any 
range of pixels within the viewer area samples the hues and/or image tonality of that region of the 
picture, and automatically places three control points on the currently open curve that correspond 
to the range of color and contrast you sampled. This also works if you use the cursor from the 
DaVinci control surface with the fourth trackball to sample a range of color.

Additional Controls in the Hue and Sat Curves

While the Hue vs. Hue, Hue vs. Sat, Hue vs. Lum, and Lum vs. Sat curves can be adjusted similarly to 
the Custom curves, they have additional controls running underneath the curve graph.

 > Six-Vector Color Patches: The Hue curves each have six buttons for automatically adding 
control points to manipulate the red/yellow/green/cyan/blue/magenta ranges of hue. 
Clicking any of these buttons adds three control points; two to define the outer range of 
hue to be adjusted, and a middle control point that you use to make the adjustment.

 > Input and Output (Hue Rotate/Saturation/Lum) fields: These two numeric fields correspond 
to the horizontal and vertical adjustment values for the currently selected control point. 
Click any control point on a curve to view or alter these values. The label of the second field 
depends on the curve that’s selected.

 > Enable Bezier button: Turning this button on forces a curve to use Bezier control handles, 
rather than the default DaVinci Resolve curve control points, to manipulate each control 
point on the curve. With Bezier handles enabled, click any control point to reveal its two 
Bezier handles. Drag either handle to alter the shape of the curve at that control point.

The following sections describe each available curve in more detail.
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Hue vs. Hue

The Hue vs. Hue curve lets you change any hue to any other hue. In the following example, the 
image at top is the unadjusted original. The image at bottom has had the magenta jacket shifted to 
an olive green via a set of three control points.

Changing the hue of the woman’s jacket using the Hue vs. Hue curve; Top–original image, Bottom–altered image

One excellent use of the Hue vs. Hue curve is to quickly and subtly alter elements that require only 
minor adjustments. For example, a sky that appears a bit too cyan can be made into a richer shade 
of blue with a small adjustment. 

Hue vs. Hue is also useful for making more radical changes to elements that might be too noisy 
to key successfully using the HSL qualifier controls. For example, red autumnal foliage blowing in 
the wind might result in a chattery matte, but you can use the Hue vs. Hue curve to change reds to 
greens, without having to worry about aliased matte edges giving your correction away.
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Hue vs. Sat

The Hue vs. Sat curve lets you selectively alter the saturation of any hue within the image. This is a 
terrific tool for creative effect, allowing you to quickly and easily boost the saturation of elements 
you want to catch the viewer’s eye, while reducing the saturation of elements you’d prefer the 
audience not dwell upon.

This can be extremely useful for legalizing over-saturated overshoots or undershoots during a QC 
pass. For example, desaturating reds that are off the charts while leaving everything else alone.

Lowering the saturation of the woman’s jacket using the Hue vs. Sat curve; Top–original image, Bottom–altered image

The Hue vs. Sat curve can also be a powerful tool for increasing the color contrast of images that 
seem lackluster and flat. By boosting the saturation of colorful elements that are distinct from the 
dominant palette of a scene, you can add variety to an otherwise monochromatic image.
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Hue vs. Lum

The Hue vs. Lum curve lets you increase or decrease the lightness of elements of specific colors.

Darkening the woman’s jacket using the Hue vs. Lum curve; Top–original image, Bottom–altered image

This is a tricky curve to use with highly compressed footage, as it can quickly reveal artifacts in the 
image if you aren’t careful. However, if you’re working with very high-quality footage, this can be 
a great tool to darken specific hues to add richness and depth, or to lighten colorful elements to 
which you want to draw attention.
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Lum vs. Sat

The Lum vs. Sat curve is similar to the Custom curves in that alterations to the saturation of an image 
are based on user-definable ranges of image tonality, rather than hue. In the following example, 
the Lum vs. Sat curve is being used to decrease selectively the saturation of everything falling into 
the highlights and shadows of the image, while increasing the saturation of everything within the 
midtones.

In the following example, a vividly saturated treatment results in shadows that seem artificially 
colorful. Using the Lum vs. Sat curve, it’s easy to gradually desaturate everything below a certain 
range, with a nice smooth falloff.

This is an outstanding curve to use for creative effect, for example, slightly boosting saturation 
within the midtones while reducing saturation in the shadows to increase the depth of the darkest 
portions of the image. It’s also a great curve to use to solve QC violations. For example, if you 
have illegal saturation in the highlights of an image, you can use the Lum vs. Sat curve cleanly and 
smoothly to lower the specific values that are causing problems.
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Selective desaturation in the shadows and highlights, along with increased saturation in the midtones,  

using the Lum vs. Sat curve; Top–original image, Bottom–altered image
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Using Hue and Sat Curves with the DaVinci Control Surface

Using these curves with the DaVinci control surface unlocks their speed, letting you make fast, 
controlled adjustments to specific elements within each scene.

To open the Hue and Sat curve controls on the DaVinci Resolve control surface:

 > Press the CURVES soft key on the center panel.

To exit the Hue and Sat curve controls:

 > Press the MAIN soft key on the center panel.

To adjust the principle color regions using knobs:

 > Adjust one of the 18 knobs in the PRIMARIES CURVE GRADE control groups corresponding 
to the RED/YELLOW/GREEN/CYAN/BLUE/MAGENTA colors paired with HUE/SAT/LUM.

To sample a region of a shot to place curve control points:

1. Press the soft key corresponding to the curve you want to adjust (HUE - HUE, HUE - SAT, HUE 
- LUM, LUM - SAT).

2. Press the CURSOR button (located above the fourth trackball).

3. Use the fourth trackball to move the on-screen cursor to the pixel you want to sample.

4. Press the first of the three buttons underneath the fourth trackball to sample the color at the 
position of the cursor.

 Three control points appear on the currently selected curve. The outer two control points 
define region of the curve you’re adjusting, and the center control point (selected by default) 
lets you make the actual adjustment.

5. To hide the cursor when you’re finished sampling, press the CURSOR button again.

To select and adjust control points using the fourth trackball of the Center panel:

 > To select a control point to adjust: Spin the fourth ring control to the right or left to select 
the next control point in that direction (it takes about half of a turn to select another control 
point). Selected control points are highlighted in cyan.

 > To move a selected control point: Adjust the fourth trackball to move the control point up, 
down, left, or right. Selected control points are constrained between whichever control 
points are to the left and right.
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Secondary correction describes isolating a specific part of the image, or a specific subject, using 
a key. Keys in Resolve are grayscale images that define which areas of the picture you want to alter 
(in white) and which parts of the picture you want to leave alone (in black). Keys are generated 
either using the controls in the Qualifier palette, by using a Power Window, or by importing an 
external matte.

This section covers the use of the Qualifier palette, which lets you pull a Chroma or Luma key, with 
which to isolate the correction you need. The Qualifier controls are fast and flexible when you 
need to isolate an irregularly shaped subject with a distinct range of color or lightness. Since you’re 
generating a key by sampling the image, there’s no need for tracking or keyframing, so in the right 
situation Qualifiers can be your fastest solution. In the following example, the client likes the slightly 
cool treatment overall, but wishes that the skin tones were a little more vibrant. This is exactly the 
sort of situation where Qualifiers can help out. Adding a second node, and using the HSL Qualifier 
to isolate the face makes it relatively simple to add color exactly where you want it.

Top–The image with a simple primary correction. Middle–Adding a second node and using HSL Qualification to  

isolate the skin tones. Bottom–The final adjusted image.

Secondary Qualifiers
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Just about every control in the Color page can be limited using qualification. This makes the 
Qualifier palette a jack-of-all-trades tool with 101 uses. A few practical examples include keying a 
red element that’s too intense for broadcast to darken it or desaturate it, keying a range of green 
foliage to shift its hue to a more attractive color, keying an actor’s skin tone in a commercial to apply 
some selective softening to it, or keying a range of sky to add blue.

Adding a Secondary Operation to the Node Editor

Any node can be switched between functioning as a primary correction, where the adjustments you 
make affect the entire image, and a secondary correction, where you’re adjusting a specific element 
in the scene. The only difference is that nodes being used for secondary corrections are limited 
using a Qualifier, Power Windows, or an external matte.

If you’re planning to add a secondary operation to the current grade, you’ll need to first add another 
node in the Node Editor. With regard to HSL qualification, it’s important to understand that you’ll be 
sampling the YRGB values being fed to that node from any previous nodes in the tree. That means 
that the state of the image being fed to a node you’re qualifying affects the key you’re pulling.

For example, if the image coming out of Node 1 is well saturated and has a neutral color balance 
with a wide range of colors, but the image coming out of Node 2 applies a low saturation, 
monochromatically orange color wash, you may find it more difficult to pull a detailed key from 
Node 2 than you would from Node 1. 

Choosing your battles–the image coming out of Node 1 will be easier to key then the image coming out of Node 2

This is important because you have the flexibility of determining from what image you want to 
try pulling a qualified key. By connecting the node that’s outputting the best YRGB image for the 
key you’re trying to create to the node you’re qualifying, you can control what you’re keying. This 
flexibility is described in more detail in Chapter 6, “Manipulating and Combining Keys.”
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The Qualifier Interface

The DaVinci Resolve Qualifier palette interface is straightforward. To the left, graphical controls 
above numeric parameters let you manually adjust what ranges of each color component contributes 
to the key you’re creating. To the right, Blur and Shrink parameters let you alter the key, while a set 
of Selection Range tools below lets you define a key by sampling pixels of the image, either using 
the pointer, or by using the fourth trackball of a DaVinci control surface.

Qualifier palette with HSL controls selected

The default qualification mode is the HSL Qualifier, which uses three color components, hue, 
saturation, and luma, to define a key. However, you can also use the RGB or LUM (Luma) qualification 
modes to pull keys using other combinations of color components. The LUM qualifier mode, in 
particular, lets you make targeted adjustments to specific ranges of image lightness. This is a 
technique employed by many colorists to alter color temperature within a specific range of image 
highlights or shadows.
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Basic Qualification: Sampling the Image

The most straightforward way to use image qualification is to sample the image in the Viewer. A set 
of four controls let you sample the image in different ways.

 > Sample Eyedropper: The first control you use whenever sampling the image. It defines the 
initial range of the qualification; you must use this tool before any of the others. Clicking 
once with this tool selects a single pixel value, while clicking and dragging selects a range 
of image values that add together.

Color Picker button

 > Add/Subtract Color Range: These two controls let you add areas of the image to, or subtract 
them from, the currently selected inner range of values that define the core of the key. As 
with the eyedropper, you can click on single pixels, or drag over a range of color.

Add and Subtract color buttons

 > Add/Subtract Softness: These two controls let you redefine the softness that transitions 
from the inner range of the key, falling off towards the outer edge of the key. Just like the 
other controls, you can click on single pixels, or drag over a range of color.

Add and Subtract qualifier softness

Note: When you select one of the sampling controls, it remains selected until you select another 
sampling control. If you select another clip in the Timeline, then click in the Viewer to sample a key 
and nothing happens, make sure that you select the Eyedropper control in the Qualifier palette.

If you’re working with the Resolve on-screen interface, the easiest way to qualify a subject is to use 
the pointer in conjunction with the sampling controls.
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Example image to qualify

To sample a subject in the Viewer for qualification:

Eyedropper in the OSD menu of the viewer

1. Open the Qualifier palette, and click the eyedropper.

2. Either click a pixel of the subject you want to sample, or click and drag across a range of pixels 
within that subject.

Picking to qualify the blue shirt

3. To see the key you’re creating as you work, click the Highlight button. The area of the image 
you’re isolating appears in color, while the area of the image being excluded appears 
solid gray. 
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Viewer image with highlight turned one

 Even though the highlight obscures the rest of the image, this doesn’t prevent you from using 
the sampling tools to select pixels you can’t see.

4. To subtract from the inner range of the key you’re creating, click the minus Color Range control, 
and click or drag across the portion of the keyed image that you’d like to exclude.

5. To add softness to the outer range of the key you’re creating, click the plus Softness control 
and then click or drag across the portion of the image you’d like to include as a soft edge.

6. When you’re finished, click the Highlight control to turn the highlight off, and make whatever 
adjustment you need. In this example, the saturation has been raised and the color balance 
changed to make the adjustment obvious.

Increased saturation of the qualified blue shirt

If you have a DaVinci control surface, you can use the fourth trackball to sample the image, referring 
to either the Viewer or the display connected to the video output of your DaVinci workstation.
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To sample a subject using the DaVinci control surface:

1. Press VECTORS on the T-bar panel to open the Qualifier palette, which defaults to the HSL 
Qualifier controls.

2. Press CURSOR (the third button above the fourth trackball) on the Center panel, to display the 
small cursor crosshairs in both the Viewer and the video output display.

3. Use the fourth trackball to position the cursor over the subject you want to sample, and press 
the leftmost of the three buttons appearing underneath the fourth trackball to sample the 
image.

4. Press HILITE on the Transport panel to turn on the highlight so you can see the key you’re 
creating, and then use the knobs at the top of the Center panel to adjust the range and 
softness parameters to obtain the most accurate key for your purposes.

Qualifier Presets

There is a set of HSL Qualifier presets, or Six Vector presets, that you can use to isolate automatically 
a predefined wedge of color (green, blue, red, magenta, yellow, or cyan) or chroma intensity (chroma 
light, chroma dark, or both). These presets are available either from the Color > Presets menu, or 
from the DaVinci control surface.

Selecting one of these presets automatically sets the HSL Qualifier to the corresponding range or 
color or lightness. Afterwards you can continue modifying the HSL Qualifier to suit your purpose.

To choose a Six Vector preset from the DaVinci control surface:

1. Press the PRESETS soft key on the Center panel. The Center panel’s soft keys update with all 
the available lightness and color presets.

2. Press the soft key corresponding to the preset you want to use. The HSL Qualifier updates with 
the new settings, and the Center panel goes back to the main page of soft key controls.
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Using Highlight to See What You’re Isolating

The Highlight control lets you overlay a representation of the key you’re creating over the current 
image in the Viewer. Overlays are also mirrored to your video output, so they’ll show up on an 
external display as well, in the event that you’re hiding the on-screen Viewer.

There are two types of highlights with which you can evaluate a qualification you’re creating. Each 
is useful for different tasks.

 > Flat-Gray: The default highlight that Resolve uses shows the selected portion of the image 
with the original colors, and the unselected portion of the image with a flat gray. It is useful 
for seeing the subject you’re isolating even while you’re adjusting the Qualifier controls, 
which lets you also see the color or contrast adjustments you’re applying at the same time.

Oranges qualified and highlighted

 > High-Contrast: Pressing Option-Shift-H, you can show what’s called a “high-contrast” 
highlight, which should be familiar to you if you’ve used other color correction applications 
and plug-ins; it’s a more typical display wherein the selected portion of the image is white, 
and the unselected portion of the image is black. The high-contrast highlight is useful in 
situations where you need to eliminate holes in a key, or evaluate how “chattery” a key is 
since irregularities are easier to spot when divorced from the original image.

Hi-Contrast B&W highlighting
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To enable or disable a flat-gray highlight, do one of the following:

 > In the Qualifier palette, click the Highlight control.

 > Choose View > Highlight (Shift-H).

 >On the T-bar Panel of the DaVinci control surface, press HILITE. To enable or disable a high-
contrast highlight, do one of the following:

 > Choose View > Highlight BW (Option-Shift-H).

 >On the T-bar panel of the DaVinci control surface, press SHIFT DOWN and then press HILITE.

To make high-contrast black and white the default highlight:

1. Open the Settings window.

2. Open the General Options and turn on “Mattes display high contrast black and white.”

3. Click Save.

 The next time you click the Highlight control in the Qualifier palette, or press HILITE on the 
DaVinci control surface, the high-contrast highlight will display.

Using Highlight to Solo Nodes

There’s one other use of the Highlight control, and that’s to solo individual nodes in the Viewer and 
video out, rather then outputting the sum of the entire node tree. For example, if you’re trying to 
adjust a stack of nodes attached to a Parallel or Layer Mixer node, it’s difficult to see what you’re 
doing while adjusting one of the stack of nodes, because only the final result is being output. 

However, if you turn on Highlight with no key being generated, then only the currently selected 
node is output, making it easy to view just one node as you adjust it. Just make sure you turn 
Highlight off before moving on, or you may confuse yourself.

Qualifier Parameters

Each of the Qualifier modes has parameters that correspond to the relevant color components 
for that mode, with which you can identify a range and softness, similar to using the sample tools. 
These parameters can be edited as virtual sliders using the pointer, or you can modify them using 
the knobs of the DaVinci control surface.

HSL Qualification Controls

The HSL Qualifier is by far the most versatile mode of the Qualifier palette. It’s also the qualifier 
that’s easiest to understand, and the easiest to adjust by hand if you don’t feel the need to sample 
the image. By selecting range and softness for each of three different color components, hue, 
saturation, and luma, you can isolate a wide variety of colorful subjects, or ranges of image lightness 
and saturation.
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This last point is important, as you can enable or disable each of the three HSL components using 
the Hue, Sat, and Lum checkboxes, found at the bottom left of each Qualifier range control. This 
lets you ignore specific color components, while focusing on others that are more important. For 
example, if you’re trying to isolate the brightest and most saturated parts of the image, regardless of 
the hue, you can turn off the Hue qualifier so that only Sat and Lum are used to sample the image.

Qualification with saturation and luminance only

The HSL parameters include:

 > Hue Center: Defines the center of the range of Hue being isolated.

 > Hue Width: Defines the width of the range of hue being isolated. Widening or narrowing 
this parameter widens and narrows the range of hue about the current Hue Center.

 > Hue Soft: Widens or narrows the falloff at both sides of the currently selected range of hue.

 > Hue Symmetry: Lets you selectively alter the angle of Hue Soft falloff at either the right or 
left side. Lowering this parameter makes the softness to the right of the hue range grow 
steeper. Raising this parameter makes the softness to the left of the hue range grow steeper.

 > Sat Low/High: Two parameters let you define the upper and lower range of saturation 
being isolated.

 > Sat Low Soft/High Soft: Two parameters let you define the upper and lower softness falling 
off outside the current range of saturation.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

478

 > Lum Low/High: Two parameters let you define the upper and lower range of luma being isolated.

 > Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of luma.

RGB Qualification Controls

The RGB Qualifier mode lets you isolate range and softness in the Red, Green, and Blue channels 
of an image. While this is not necessarily an intuitive way of manually creating a qualification from 
scratch, it can provide a different way of isolating potentially trickier ranges of the RGB color space. 

If you start by sampling the image, then you can widen and narrow each color channel’s isolated 
range of values. In some cases, you may find it’s faster to isolate a specific range of continuous color 
by adjusting these controls.

RGB qualification controls

The RGB parameters include:

 > Red Low/High: Two parameters let you define the upper and lower range of the Red channel 
being isolated.

 > Red Low Soft/High Soft: Two parameters let you define the upper and lower softness falling 
off outside the current range of red.

 > Blue Low/High: Two parameters let you define the upper and lower range of the Blue 
channel being isolated.

 > Blue Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of blue.

 >Green Low/High: Two parameters let you define the upper and lower range of the green 
channel being isolated.

 >Green Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of green.
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Luma Qualification Controls

The Luma Qualifier mode simply pulls a key from the Luma channel all by itself. It’s identical to the 
HSL qualifier with H and S turned off. This single-component keyer is more useful than you might 
think; it’s a common technique to isolate a range of highlights, midtones, or shadows throughout 
the image to alter the color temperature selectively.

Also, keep in mind that the luma component is the sharpest keyable component when you’re 
working with heavily compressed video. Keys that are noisy or chunky with HSL qualification may be 
sharper if you just use the Luma Qualifier, although you won’t be able to be chromatically specific.

The Luma Qualifier has four parameters:

 > Lum Low/High: Two parameters let you define the upper and lower range of the luma 
component being isolated.

 > Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of luma.

Blur/Shrink Controls

After you’ve used the sample controls and Qualifier parameters to create the most useful key for 
your purposes, you may find that it has problems that cannot be overcome easily by the available 
adjustments. Issues such as chattery edges, holes, or noisy bits can sometimes be easily fixed by 
simply blurring the key.

Blur

The Blur controls filter the output of the Qualifier controls, so blur may work well in some instances, 
and poorly in others, depending on what you’re trying to do. In small amounts, blurring a key does 
well to take the edge off problem edges. However, blurring a key can also feather the edges of a 
key past the border of the subject you’re keying, with the result being a visible “halo” around your 
subject depending on the adjustment you’re making. 

Using the blur parameters to soften the edges of a key
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If haloing is a problem, you may want to consider using the Qualifier Softness parameters to feather 
the edges of the key, instead.

There are two Blur parameters:

 > Blur Radius: The amount of blur that’s applied to the key. The default value is -100, which 
applies no blur. The maximum value possible is 100.

 > Blur H/V Ratio: Restricts the direction of blur. At the default value of 0, blur is omnidirectional. 
At negative values, blur becomes increasingly vertically oriented. At positive values, blur 
becomes increasingly horizontally oriented.

Shrink

The Shrink controls are another filtering operation with which you can alter the key. The name 
is misleading, as these parameters can be used to either shrink or expand the key. Like the Blur 
controls, the Shrink controls affect the overall result that’s output by the Qualifier controls. These 
controls are useful for pushing the edges of a key farther inward, or for expanding the edges of a 
key to expand it or fill in holes. 

Shrink controls reduce and expand qualified area

There are two Shrink parameters:

 > Shrink Radius: Negative values expand the key outward and fill in holes. Positive values 
shrink the key inward.

 > Shrink Offset: Adjust shrink offset together with shrink radius to refine the edges of 
particularly tricky keys.

The Many Ways to Invert a Key

Sometimes, you’ll need to isolate a subject or range of values in an image, and then make a change 
to everything else. One way to do this is to add an Outside node after the node in which you’ve 
created the key. This lets you make one set of adjustments to what you’ve keyed, and another set of 
adjustments to everything outside the key.
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If you just need to make a simple adjustment, you can invert the key from within the Qualifier palette. 
However, there are three other ways to invert a key.

 > The Qualifier Invert button: Clicking this control simply inverts the key being generated by 
all of the controls within the Qualifier palette.

 > Key Palette Input Invert: The Qualifier Invert control within the Key palette provides another 
control with which you can invert the key that’s generated by the Qualifier palette.

 > Key Palette Output Invert: The Output Invert control within the Key palette is notable because 
it inverts the sum of all keys applied within that node. For example, if you’re using a Qualifier 
in conjunction with a Window, the two invert controls mentioned previously will only invert 
the Qualifier key; the Window key remains unaffected. However, using the Output Invert 
control inverts the overall combination of the Qualifier key and the Window, all together.

Combining Qualifiers and Windows

This is covered in more detail shortly, but if you create a key using one of the Qualifier modes, and 
you then add a Window, the final key that’s output by that node is limited to the intersection of the 
Qualifier key and the Window. This makes it easy to use a Window to “garbage matte” out bits of a 
key that you don’t want, that can’t be eliminated by further adjustment of the Qualifier controls.

Top–Oranges being isolated are very similar to other colors in the frame. Bottom–A PowerCurve  

is used to further isolate the oranges.
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Power Windows are another way of making secondary correction, being essentially shapes you can 
use to isolate regions of the image. Different controls let you use oval, rectangular, polygonal, or 
custom curved shapes. Because you can isolate regions of the image by drawing, Power Windows 
produce exceptionally clean results, with edges that can be precisely positioned and feathered to 
achieve a variety of effects.

PowerCurve Power Window isolates the sky area

Power Windows are excellent when what you need to adjust can be encompassed within a clearly 
defined geometrical area. For example, the oval of a person’s face, the front of a car, or a wide 
expanse of sky are all good candidates for windowed adjustments. A drawback of windows can be 
that they must be animated to follow whatever subject they’re isolating. Fortunately, this is where 
DaVinci Resolve’s powerful tracker comes in, making it easy to track Power Windows quickly and 
accurately to follow along with the subject being isolated.

Circular Power Window to focus attention to the skin

Power Windows
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DaVinci Resolve makes it easy to combine multiple Power Windows in different ways, to intersect 
with one another and create even more sophisticated shapes. For example, multiple windows can 
be added together, or one window can be used to cut out part of another window, which saves you 
from the need to make complicated keyframing operations to animate that window’s shape.

Multiple Windows combined to isolate and mask the image

This section covers the use of Power Windows, how to create and modify them, as well as how to 
combine multiple windows, and combine windows and qualifiers to create highly specific isolations.

Adding Nodes with Windows

As with qualifiers, you must first add a node to a grade’s node tree before you begin windowing a 
correction. This is because all of the windows within a particular node work together to limit that 
node’s grade. As a reminder, any node can be changed from a primary operation that affects the 
entire image, to a more targeted secondary operation, simply by turning on a window, using a 
qualifier, or enabling an external matte.

Serial nodes showing the window on Node 2

If you don’t create a new node before creating a window, you’ll discover you’ve inappropriately 
changed a primary correction into a secondary correction. If you create a new serial node, you’ll 
then need to use the controls found within the Window palette to turn on a window to customize 
for your purposes. However, there are also a set of commands you can use to add serial nodes with 
a window already turned on, saving you a few clicks or button presses in the process.
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To add a new node with a window already turned on:

 > Choose Nodes > Node + CPW (Option-C), or press the button of the same name on the 
T-bar panel of the DaVinci control surface to create a new serial node with a circular window.

 > Choose Nodes > Node + LPW (Option-Q), or press the button of the same name on the 
T-bar panel of the DaVinci control surface to create a new serial node with a linear window.

 >Choose Nodes > Node + PPW (Option-G), or press the button of the same name on the T-bar 
panel of the DaVinci control surface to create a new serial node with a polygonal window.

 >Choose Nodes > Node + PCW (Option-B), or press the button of the same name on the T-bar 
panel of the DaVinci control surface to create a new serial node with a PowerCurve window.

When you add a node with a Power Window, the Window palette automatically opens up, 
ready for editing.

The Window Palette Interface

Once you’ve created a node with which to apply a Power Window correction, you need to open the 
Window palette if it hasn’t been opened already.

To open the Window palette:

 > Click the Window palette button.

 > Press the WNDWS button on the T-bar panel of the DaVinci control surface.

The majority of the Window palette is occupied by the Window List, within which you can create 
as many windows as you need for the task at hand. There are five types of windows you can create, 
each of which has a different geometry. You can use these windows individually, or you can combine 
them to create even more complex shapes and interactions. The Window palette has four groups 
of controls that let you use these windows in different ways.

The Window palette with the Window list
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 >Window List: A row of buttons at the bottom of this list lets you add new windows to this 
list, which you can then customize as necessary. Each window in the list exposes an On/
Off button, shape type, invert button, mask button that governs how that window interacts 
with the other windows that are currently enabled (adding to other nodes by default, 
or subtracting from other nodes in Mask mode), and a Layer Name field you can use to 
identify what each window is for.

 > Transform parameters: Controls the overall size, aspect ratio, position, and rotation of the 
currently selected window. 

 > Softness parameters: Controls the edge softness of the currently selected window. Different 
window shapes have different softness options.

 >Window Preset pop-up menu: A menu to which you can save presets of individual or 
multiple windows for easy recall later.

 >Option pop-up menu: The Option pop-up menu has commands for resetting windows, 
deleting windows, saving and managing window presets, and copying and pasting track data.

There are five types of windows you can create:

 > Circular: An oval that can be shaped, sized, and feathered to solve an amazing number 
of problems.

 > Linear: A four-point shape that can be edited into any kind of rectangle or trapzoid you 
might need. In addition to the center and corner controls, you can also drag any of the four 
sides to change the shape.

 > Polygonal: A four-point shape that can be expanded with additional control points to create 
complex sharp-cornered polygonal shapes.

 > PowerCurve: A Bezier drawing tool that you can use to create any kind of shape, curved, 
polygonal, or mixed, that you require.

 >Gradient: A simple two-handled control for dividing the screen into two halves, with options 
for the center, angle, and feathering of the shape. Good for fast sky adjustments.

Managing Windows

To manipulate a window, first you need to create the type of window you want to use, or if you’ve 
got a group of windows created already, you need to select the window you want to work on.

Methods of creating and selecting windows:

 > To create a new window: Click the Create Window button (at the bottom of the Window list) 
that corresponds to the window you want.

 > To create a new window using the DaVinci Control Surface: Press WNDOWS on the T-bar 
panel, then use the UP and DOWN buttons on the Trackball panel to select the window 
type you want to apply, and press ADD.
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 > To select a window using the on-screen controls: Click anywhere within a window to select 
it in the Viewer.

 > To select a window from the Window list: Click the Shape icon button corresponding to the 
window you want to select. 

To delete a window you no longer want: 

 > Select a window, then choose Delete Selected Window from the Option pop-up.

To reset one or all windows:

 > To reset one window to its default shape: Select a window, then choose Reset Selected 
Window from the Option pop-up.

 > To reset all windows: Choose Reset All Windows from the Options pop-up.

Showing and Hiding On-Screen Window Controls

When you open the Window palette, the Viewer goes into Power Window mode. Enabling a window 
makes that window’s on-screen controls appear within the Viewer, and are mirrored to video out so 
you can see the window controls on your external display. If you like, you can change how and where 
the on-screen controls appear.

To choose whether on-screen controls are mirrored to video out, or disabled:

 > Choose an option from the View > Window Outline submenu.

There are three options:

 >Off: Hides the window outline on both the external display and the Viewer.

 >On: The default, shows the window outline on both the external display and the Viewer.

 >Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

To show or hide window on-screen controls using the DaVinci control surface:

 > Press SHIFT UP and then DISPLAY/CURSOR, above the fourth trackball on the Center panel.

This command is a three-way toggle. The first use of this command hides the window outline 
on your external display, but leaves it in the Viewer. The second use of this command hides 
the window outline on both the external display and Viewer. The third use of this command 
shows the window outline on both the external display and Viewer.
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Window Transform Controls

Windows have transform parameters that are similar to those found in the Sizing palette. These 
parameters let you alter the window, affecting all of its control points together.

Window transform controls

 > Size: Scales the entire window up or down. 50.00 is the default size.

 > Aspect: Alters the aspect ratio of the window. 50.00 is the default value, larger values make 
the window wider, and smaller values make the window taller.

 > Pan: Repositions the window along the X axis. 50.00 is the default position, larger values 
move the window to the right, smaller values move the window to the left.

 > Tilt: Repositions the window along the Y axis. 50.00 is the default position, larger values 
move the window up, smaller values move the window down.

 > Rotate: The default value is 0. Increasing this parameter rotates the shape clockwise, 
decreasing this parameter rotates the shape counterclockwise. 

The transform parameters also correspond to onscreen controls found in the Viewer, which can be 
manipulated directly using the pointer.

Manipulating the window position on the viewer
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While many of the on-screen controls correspond to parameters within the Window palette, 
some on-screen controls, such as the control points that govern reshaping linear, polygonal, and 
PowerCurve windows, are only adjustable via the pointer.

On-screen controls for window transforms:

 > To select a window: Click on one of an arrangement of many windows to select it, making 
that window’s controls active.

 > To reposition a window: Drag anywhere within the window’s onscreen control. Window 
position corresponds to the Window palette’s Pan and Tilt parameters. For a Gradient 
window, drag the center control point.

 > To resize a window while locking its aspect ratio: Drag one of the four blue corner points out 
to enlarge, or inwards to shrink. This corresponds to the Window palette’s Size parameter.

 > To squish or stretch a window, altering its aspect ratio: Drag one of the blue top, bottom, 
left, or right control points. These adjustments correspond to the Window palette’s 
Aspect parameter.

 > To rotate a window: Drag the top inner blue rotate handle, in the middle of the window. For 
a gradient, drag the bottom arrow handle.

 > To change a window’s center of rotation: Command-drag the bottom inner blue rotate 
handle to a new location.

 > To alter window softness: Drag any one of the magenta softness handles. Different window 
shapes have different sets of handles, which correspond to the Softness parameters.

 > To reshape a linear window: Drag any of the green corner handles to corner pin the window, 
or drag one of the green top, bottom, or side handles to move an entire side segment of 
the window around.

 > To reshape a polygonal window: Turning on a polygonal window reveals a simple green 
rectangle with four corner control points. Click anywhere on the surface of the rectangle to 
add additional control points with which to reshape the polygon, and drag any green control 
point to alter its shape. Polygonal windows are limited to a maximum of 128 control points.

 > To change the size and aspect of a PowerCurve or polygon: Command-drag any control 
point to freely resize the PowerCurve about the center point.

 > To remove control points from polygonal or PowerCurve windows: Middle-click the control 
point you want to remove.

Note: Removing a control point from a Polygonal window that has already been  
animated results in that control point abruptly popping on and off at the keyframes 
creating the animation.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

489

Window Softness

Each type of window has different Softness parameters, depending on how adjustable that window is.

 > Circular: A single parameter, Soft 1, lets you adjust the uniform softness of the oval’s edge.

 > Linear: Four parameters, Soft 1-4, let you adjust the softness of each of the four sides of the 
linear window independently. Magenta softness control points on the top, bottom, left, 
and right let you adjust the softness of each side of the linear shape independently.

 > Polygon: Two parameters, Inside Softness and Outside Softness, let you adjust the overall 
softness of a polygonal window. There are no on-screen softness control points.

 > PowerCurve: Two parameters, Inside Softness and Outside Softness, let you adjust the overall 
softness of a PowerCurve. Using the on-screen controls, you can adjust the magenta inside 
and outside softness control points independently, creating any softness shape you need. 

 >Gradient: A single parameter, Soft 1, lets you adjust the uniform softness of the gradient 
window’s edge.

Drawing a PowerCurve

The PowerCurve window is the only window that doesn’t display any on-screen controls when it’s 
first turned on. Instead, you must click within the Viewer to add control points, drawing your own 
custom shape to isolate whatever region you want.

PowerCurve window to isolate the sky

Tip: Turning on the Viewer’s full-screen mode can make it easier to draw detailed shapes. You can 
also zoom into and out of the Viewer while you’re drawing, using either the scroll wheel of a mouse 
or by pressing Command-Plus or Command-Minus.

To draw a PowerCurve:

1. Turn on the PowerCurve window style control.

2. Click anywhere in the Viewer to start adding control points and drawing the shape you need. 

3. Click and drag to add and shape Bezier curves, or just click and release to add a hard angle.

4. To finish drawing and close the shape, click the first control point you created.
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Methods of modifying a PowerCurve:

 > To add points: Click anywhere on a PowerCurve to add control points.

 > To reshape a PowerCurve: Drag any control point to a new location.

 > To resize a PowerCurve: Command-drag any control point to resize the whole shape. 
Vertical and horizontal sizing are not locked.

 > To move a PowerCurve: Drag anywhere within or just outside a PowerCurve to move it.

 > To symmetrically alter a Bezier curve: Drag any Bezier handle. The opposite handle 
automatically moves in the other direction.

 > To asymmetrically alter a Bezier curve: Option-drag any Bezier handle. The opposite handle 
stays in place while you drag the current handle. Once you’ve created an asymmetric pair 
of Bezier handles, they move together as one if you simply drag a handle. You need to 
Option-drag to change the angle.

 > To change a curve into a corner: Option-double-click any Bezier curve control point to 
change it to a sharp-angled corner point.

 > To change a corner into a curve: Option-click any corner point and drag to pull out a Bezier 
handle, changing it to a curve.

Note: Corner points cannot be moved; dragging them always turns them into curves.

 > To remove points: Middle-click the control point you want to remove.

Note: Removing a control point from a PowerCurve that has already been animated results 
in that control point abruptly popping on and off at the keyframes creating the animation.

Resetting the Window Palette

The entire Window palette can be reset using the Option menu’s Reset command.
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Combining Power Windows With the Mask Control

Adding multiple windows to a single node is an easy way to create composite keys. When combining 
windows, the Mask control defines whether one window adds to another window, or subtracts from 
that window.

The mask control is turned on for the Circular window and PowerCurve

In the following example, Circular and PowerCurve windows have both been created, and each 
window’s Mask control is also turned on, resulting in both masks being added together so that the 
sunset look correction affects both the sky and the woman’s face.

The two images show the combination of the key mattes
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By turning the Mask control of the Circular window off, the Circular window is subtracted from 
the PowerCurve.

Turning the Mask control of the Circular window

Now, the woman’s face is being protected from the aggressive sky treatment.

The two images show the result of subtracting the circular window

Since windows can be individually tracked and keyframed, you can quickly set up complex 
interactions of windows to solve common problems you’ll encounter. For example, when you’re 
tracking a window to follow a moving subject that moves behind something in the frame, you can 
use a second window with Mask turned off to cover the object in front. Now, when the tracked 
window intersects the subtractive window, the correction will disappear along with the subject.
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You can also use the Mask control to create more complex shapes than you can with a single window.

Mattes and mask used together to make complex shapes

Furthermore, once you reach the limits of what shapes you can create using the four available windows, 
you can combine multiple nodes containing multiple shapes and qualifiers using the Key Mixer. 

Copying and Pasting Windows

If there’s a particular window you’ve created that you want to either duplicate within the current 
node, or apply to another node, you can copy and paste an individual window’s shape from one 
item in the Window list to another.

Methods of copying and pasting Windows:

 > To copy a Window: Click any enabled Window in the Window list, then click the Window 
palette option menu and choose Copy Window.

 > To duplicate a Window: After copying a window, create another window of the same type 
that you copied, and then click the Window palette option menu and choose Paste Window.

 > To paste a Window to another node: Double-click or otherwise select another node, open 
the Window palette, choose the same type of window that you copied in the Window list, 
and then click the Window palette option menu and choose Paste Window.

Saving Window Presets

If you find there’s a particular window shape or combination of windows that you use frequently, you 
can save one or more windows as a preset for easy recall whenever needed. For example, if you’re 
working on a documentary within which you find you need to do a lot of face brightening, you can 
create preset face ovals for close-up, medium, and wide shots, to save you from having to customize 
a stock circular window for every single new shot. You can also save groups of windows together as 
a single preset, in order to reuse complicated multi-window shapes.

Window presets are available from a group of Presets controls in the upper right-hand corner of the 
Window palette.
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Methods of working with Power Window presets:

 > To save a window preset: Once you’ve created one or more windows you want to save, click 
the plus button, type a name into the resulting dialog, and click OK. That preset is now 
available in the Preset pop-up.

 > To recall a window preset: Choose a preset in the Preset pop-up, and it’s instantly applied. 
Recalled window presets overwrite whatever other windows were set up in that node.

 > To update an already saved preset: Recall a preset, change the resulting window(s),  
then click the Checkmark button to overwrite the current preset with the altered  
window arrangement.

 > To delete a window preset: Choose a preset in the Preset pop-up, and click the  
Trashcan button.

Once recalled, windows created by presets can be modified and tracked just like any other window.

Using Windows and Qualifiers Together

Another use of windows is to act as a “garbage matte” when used together with a qualifier. By 
default, when you use a window and qualifier together, a key is only output where both the window 
and qualifier intersect. This makes it easy to exclude unwanted parts of a key that are too difficult to 
eliminate by further refinement of the qualifier controls.

For example, the following qualification is intended to isolate the woman’s face, but some of the 
similarly colored wood and sky in the background is also included.

Instead of driving yourself crazy trying to eliminate the unwanted parts of the key by modifying the 
current qualification, which is doing a great job of isolating the skin tones, you could instead use a 
Circular window to isolate her face, excluding everything outside the window, and simplifying your 
job considerably.

Controls for saving, applying, and deleting window presets
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A qualified image with highlight on

If she moves, then you can simply track the Circular window to follow. Simple tracking is covered 
later in this chapter.

Now with additional Power Window isolation

Furthermore, you can use the window’s Invert control to do the reverse, excluding all qualified portions 
of the key inside the window, and including all qualified portions of the key outside the window.

If you need to build more complex qualifier/window combinations than this, you can add more 
windows, or you can use multiple qualifiers and windows with the Key Mixer node, which is discussed 
later in this chapter.
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Manipulating Windows Using a Control Surface
Window shape and position can also be manipulated using the DaVinci control surface. All Windows 
controls are located on the T-bar panel, except for the ADJ WINDOW button above the fourth 
trackball of the Center panel.

To enable, mask, or disable a window:

1. Press WNDWS on the T-bar panel. The Window palette should appear.

2. Press the soft key that corresponds to the type of window you want to turn on, CPW (Circular Power 
Window), LPW (Linear Power Window), PPW (Polygonal Power Window), or PCW (PowerCurve 
window). The appropriate window controls should appear with an orange highlight.

3. Press the MATTE/MASK soft key to toggle among turning the window on, turning Mask on, 
and turning the window off.

To reposition a window using the Pan and Tilt knobs:

1. Press the unlabeled soft key at the bottom-right of the T-bar panel to toggle between the 
current knob mappings on the T-bar panel, and the PAN and TILT mappings.

2. Use the Pan and Tilt knobs to adjust the window’s position.

To reposition a window using the fourth trackball:

1. If necessary, press WNDWS on the T-bar panel to open the Window palette.

2. Press ADJ WNDW, above the fourth trackball on the Center panel.

3. Use the fourth trackball to reposition the window.

4. When you’re finished, press ADJ WNDW again to exit adjust window mode.

To alter a window’s Zoom, Aspect, or Rotation:

 > Use the ZOOM, ASPECT, and ROTATE knobs on the T-bar panel.

To alter a window’s softness, do one of the following:

 > For Circular and Linear windows: use the SOFTNESS knob on the T-bar panel.

 > For Polygonal and PowerCurve windows: press the unlabeled soft key at the bottom-right of 
the T-bar panel to toggle between the current knob mappings, and the PAN, TILT, INSIDE 
SOFT and OUTSIDE SOFT knob mappings.

To invert a window:

 > Press the INVERT soft key on the T-bar panel.
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Tracking Windows

If you’re applying one or more windows to a clip in which the camera and/or the subject you’re 
isolating is in motion, you’ll need to make the window’s position follow along. Fortunately, the Object 
Tracker in DaVinci Resolve is both easy to use, and exceptionally capable of quickly tracking position, 
size, and orientation in clips with complex motion, and applying those transformations to any kind of 
window. This section describes the simplest way of tracking a window to follow a moving subject.

To track a window to a moving subject:

1. If there are multiple windows turned on, select a window to track by clicking that window in 
the Viewer, or by opening the Window palette and clicking the gray area behind that window’s 
Style/Invert/Mask controls. The selected window appears thicker in the Viewer, and an orange 
highlight appears around the selected window’s controls.

Preparing windows for tracking 

2. To initiate tracking, do one of the following:

 > Choose Playback > Track Forward (Command-T)

 > Choose Playback > Track Backward (Option-T)

 >On the T-bar panel of the DaVinci control surface, press OBJECT TRACK MODE, and then 
press either the TRACK FWD or TRACK REV soft keys on the Center panel.
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The Tracker palette automatically opens, then Resolve automatically identifies trackable details 
within the shape being tracked using multiple tracking points, and tracks from the frame at the 
position of the playhead to the end of the selected clip.

If the track you’ve performed is unsuitable, you can reposition the window to cover a different area 
of the subject you’re trying to track, and initiate tracking again. New tracking data overwrites any 
previous tracking data applied to that window.

Once you’re satisfied with your track, you can continue to resize, reposition, or reshape the window 
being tracked. Tracking data is separate from the window transform parameters (which can be 
keyframed), so changes you make to a window offset it from the originally tracked path.

There are many other options for customizing a track and solving tracking problems, all of which are 
covered in “Window Tracking and Image Stabilization.”

Tracking the face within the circular window
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The Tracker palette has two modes, available from the Palette menu. In Window mode, the tracking 
controls let you match the motion of a window to that of a moving feature in the frame. In Stabilizer 
mode, the same underlying technology is used to smooth or stabilize the motion within the 
entire frame.

Window Tracking

DaVinci Resolve has an incredibly simple, yet powerful, object tracker that allows you to track  
quickly and accurately any Power Window (Circular, Linear, Polygonal, PowerCurve or Gradient) to 
follow any moving feature. This avoids the need to use dynamic keyframes to manually animate a 
window’s position. 

In particular, you can use the tracker to match a window’s position to either foreground or background 
elements that move within the frame.

A Power Window tracking a woman’s face; the motion path resulting from the track is shown as the wiggly white line

Simple Tracking Using the Tracker Menu

The simplest way to track a feature using a Power Window is to use the commands found in the 
Playback menu. These commands include:

 > Track Forward (Command-T): Tracks a window to a feature from the current position of the 
playhead forward, ending at the last frame of a clip.

 > Track Reverse (Option-T): Tracks a window to a feature from the current position of the 
playhead backward, ending at the first frame of a clip.

 > Track Stop (Command-Option-T): Interrupts any track. This is useful for letting you cancel 
a long track that goes wrong (the Stop button of a control surface stops tracking as well).

Window Tracking and Image Stabilization
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Most window tracks are easy to accomplish using these three commands.

To track any Power Window to match a moving feature within the frame:

1. Move the playhead to the frame of the current shot where you want to begin (you don’t have 
to start tracking at the first frame of a shot).

2. Turn on any window, and adjust it to surround the feature you want to track.

 Typically, you’ll have done this anyway, for example, framing someone’s moving face with a 
Circular Window to lighten their highlights.

3. To initiate tracking, do one of the following:

 > Choose Color > Track Forward (press T)

 > Choose Playback >Track Backward (Option-T)

 Resolve automatically opens the Viewer page, places a series of tracking points within the 
window you’ve created, and performs the track from the current frame; forward to the last 
frame or backward to the first frame.

Resolve analyzes a cloud of tracking points that follow the vectors of every trackable group of pixels 
within the window you’ve created, and the results are fast and accurate. After tracking, the window you’ve 
placed automatically moves, resizes, and rotates to match the motion of the feature you’re tracking.

Object tracking in progress. Tracking points are automatically placed over trackable features of the image

Once a clip has tracking data applied to one of its windows, a small tracking icon appears within 
that clip’s icon in the Thumbnail timeline.

A tracking icon in the top left corner of the Thumbnail timeline shows that clip has been tracked
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Simple Ways of Working With Existing Tracking Data

If you find that you don’t like a track you’ve made, you can simply move the playhead back to the 
frame where you’d like to redo tracking, and start over. New tracking data always overwrites old 
tracking data.

If there’s a portion of a shot that you haven’t tracked (for example, you started tracking at a later 
frame, or you ended tracking before the end of the shot), then the window you’re tracking remains 
wherever it was at the first or last frame that was tracked. If you want to fill in these gaps, you 
can always move the playhead to the first or last frame that was tracked, and then use the Track 

Backward or Track Forward command to track the rest of the frames in that shot.

Tips For Better Tracking

In situations where a feature changes shape in such a way as to confuse the tracker, you can try 
tracking a smaller part of the feature by using a smaller window. Once you’ve achieved a successful 
track, you can resize the window as necessary, and it will have no effect on the track that’s already 
been made.

Also, if you’re tracking a feature that moves behind something onscreen and disappears for the 
rest of the shot, there’s an easy way to avoid having an awkward window sitting in the middle of 
the scene. You can use dynamic keyframes to animate the Post Mixing Gain slider (in the Key tab of 
the Color page) to fade from the correction’s full strength of 1.0 down to 0, the value at which the 
correction disappears, along with the window itself.

Copying and Pasting Tracking From One Window to Another

There will be plenty of times you’ll apply multiple windows to a single moving subject, such as a car, 
when you can use a single motion track for all the windows. Commands in the Option menu let you 
copy and paste track data from one window to another within the same node, saving time when you 
want several windows tracking together as one.

To copy track data from one window to another:

1. Open the Window palette, then select a window that has tracking applied to it (indicated by a 
tracking badge in the corner of the shape icon), and choose Copy Track Data from the Option 
pop-up. 

2. Select another window, and choose Paste Track Data from the Option pop-up.

Once you’ve copied track data from one window, you can paste it to as many other windows as  
you like.
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Combining Tracking and Dynamic Keyframes

You can easily combine object tracking and keyframing to animate windows. For example, you’ll 
typically use object tracking to make a window follow the position and orientation of a moving 
feature, but you can add dynamic marks to the window track of the correction in the Color page 
with which to alter its size and shape to better conform to a feature’s changing form.

Controls in the Window Tracker Palette

Occasionally, you’ll run into a shot that doesn’t quite track well enough using the Tracker menu’s 
simple controls. In these cases, the Viewer page provides the complete set of object tracking 
controls that can be used to modify tracking operations in different situations.

The Tracker palette

The Object Tracking Controls are divided into seven groups.

Tracking Type

The Tracker palette’s Option pop-up menu lets you choose between Window mode (for matching 
a window to the motion of a feature in the frame), and Stabilizer mode (for subduing unwanted 
camera motion, covered later).
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Object Tracking

The Object Tracking controls provide the most basic tracking functions, some of which are mirrored 
within the Tracker menu.

Choose which type of transform you want to track before tracking

A series of four checkboxes let you turn on and off which transforms you’d like motion tracking to 
apply automatically to the window. These checkboxes must be selected before you perform a track 
in order to restrict the transforms that are used. 

 > Pan: Enables tracking of horizontal position.

 > Tilt: Enables tracking of vertical position.

 > Zoom: Enables tracking of size.

 > Rotate: Enables tracking of orientation.

Note: Once tracking or stabilization has been done, disabling these checkboxes does nothing to 
alter the result. To make changes, you need to enable or disable the necessary checkboxes first, 
and then reanalyze the clip.

After you’ve defined the transforms you want to use for the track, the next three buttons let you 
proceed with the analysis of the subject being tracked.

 > Track Reverse button: Initiates tracking from the current frame backward, ending at the first 
frame of the clip.

 > Pause button: Stops tracking (if you’re fast enough to click this button before tracking is 
finished).

 > Track Forward button: Initiates tracking from the current frame forward, ending at the last 
frame of the clip.
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Clip/Frame Controls

Two buttons let you set how manual adjustments to the position of tracked windows affect the 
overall track.

Selecting clip or frame to apply adjustments

 > Clip: The default mode, in which changes you make to the position of a window are globally 
applied to the entire track. For example, if you track a feature, and then move the window, 
the window moves along a motion path that’s consistently offset from the original track 
for the duration of the clip. Use this mode if you’re happy with the track, but you want to 
modify the window’s overall shape and position relative to the motion path it’s following.

 > Frame: In this mode, changes you make to the position of a window are only applied to the 
current frame. This mode is required for using the Interpolate commands explained below. 
Key Frame mode is also useful for making corrections to individual frames that were badly 
tracked, or for making manual, frame-by-frame adjustments to window position to cover 
untrackable sections.

Interactive Mode Controls

The Interactive controls let you make manual changes to the automatically generated tracking point 
cloud that Resolve creates, so you can try different ways of obtaining better tracking results in 
challenging situations.

Interactive mode actions

 > Interactive Mode checkbox: Turns the Interactive tracking mode on and off. When you 
enter Interactive mode, you can manually alter the point cloud that Resolve uses to track 
the feature within the current window. You’ll then make your track while in Interactive mode.

 > Insert: Lets you add tracking points to whatever trackable features exist within a bounding 
box that you’ve drawn in the Viewer. Inserted tracking points are automatically placed 
based on trackable pixels in the image.
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 > Set Point: Lets you use the cursor (using the DaVinci Resolve control surface), to manually 
place individual tracking points, one by one, with which to track a feature. If there is no 
trackable pixel group at the coordinates where you placed the cursor, a tracking point will 
be placed at the nearest trackable pixel group.

 > You must place at least two tracking points at different pixel groups to track rotation, and 
at least three to track zoom.

 > Delete: Eliminates all tracking points within a bounding box that you’ve drawn in the Viewer.

For more information, see “Using the Interactive Tracking Controls” later in this section.

Keyframes Interpolation Controls

The controls in the Interpolate section provide ways of dealing with occlusions, or objects that 
temporarily obscure features that you’re tracking. 

Interactive mode actions

By marking a hole in the middle of two successfully tracked sections of a clip, you can interpolate a 
motion path to fill the gap so that the vignette moves smoothly from the point where tracking is lost 
to the point where tracking is found again. These features require the tracker to be in Frame mode 
(see the previous section).

 >Mark: Lets you mark the beginning and/or end of sections of track data that you want to 
overwrite with a linear interpolation from the window position at the first frame to the 
window position at the second mark. Once a clip has been marked in the Viewer, you can 
use the Rev, Fwd, or Between buttons to interpolate an animation motion path to fill the gap 
in tracking data. Viewer marks appear as vertical yellow lines in the tracking bar underneath 
the transport controls.

 > Between: After using the Mark button to specify both the beginning and end of a gap in 
tracking data, click Between to interpolate a motion path to fill the gap.

For more information, see “Using the Interpolate Commands” later in this section.
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The Tracker Graph

The Tracker Graph provides a visual display of the tracking data that’s being analyzed. Each of the 
transform controls that can be tracked has an individual curve, which lets you evaluate each tracked 
parameter on its own.

Add keyframe and Interpolate between

A vertical slider to the right of the Tracker Graph lets you scale the height of the curve data within 
to make it easier to see it all within the graph. Above the Tracker Graph, a timeline ruler contains a 
playhead that’s locked to the playheads in the Viewer and Keyframe Editor.

You can draw a bounding box in the Tracker Graph with which to select a portion of one or more 
curves to delete sections of low-quality tracking data using the Clear Selected Keyframes command 
found in the Palette Options menu. To eliminate the current bounding box from the Tracker Graph, 
click once anywhere within the graph.

Additional Commands in the Tracker Palette Options Menu

There are some additional commands located in the Palette Options pop-up menu.

 >Clear Track Data: Lets you delete tracking data for the current clip. When you click Clear Track 
Data, a Clear Tracking window appears with four checkboxes that let you choose for which 
window, within the current clip, to clear tracking data. By default, every checkbox is turned on.

 > Clear Selected Keyframes: When you drag a bounding box over parts of one or more 
curves in the Tracker Graph, this command lets you delete that part of the graph. This is 
useful when you want to eliminate sections of low-quality track data. Portions of curves that 
are cleared in this way have linear interpolation automatically applied to them, similar to if 
you used the Keyframes Interpolation controls.

 > Clear All Tracking Points: Clears the tracking points in the Power Window at the frame you 
are on.

 > Show Track checkbox: Turn this checkbox on to show the motion path produced by the 
tracking you’ve done.
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Object Tracking Workflows

The next few examples illustrate how to use the Tracker palette’s controls in practical situations.

Using Interactive Mode to Manually Choose Tracking Features

Interactive Mode lets you manually remove or add tracking points to improve tracking performance 
in situations where the automatic image analysis in Resolve provides unsatisfactory results.

For example, you can delete tracking points within a window that correspond to overlapping features 
you don’t want to track. Suppose a car that you’re tracking drives by a sign that partially obscures 
the car. Without intervention, the PowerCurve that’s isolating the car will deform improperly when 
the car moves along and then away from the sign.

Using Interactive Mode, you can delete the tracking points that will overlap the sign you don’t want 
to track, improving the result.

To eliminate specific, unwanted tracking points from a track:

1. Open the Tracker palette.

2. Turn on the Interactive Mode checkbox.

Selecting Interactive Mode

3. In the Viewer, drag a box around the tracking points you want to eliminate within the window, 
and click the Delete button. The points within the selection area are deleted.

Dragging a box around tracking points that need to be deleted



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

508

4. Click the Delete button. The points within the selection area are deleted.

Deleting tracking points

5. Now, drag a box around the specific area where you’d like to add new tracking points, then 
click the Insert button.

6. When you’re finished tracking, click the Exit Interactive button.

Note: If you delete tracking points and then disable Interactive Mode without performing a new 
track first, Resolve goes back to using automatically placed tracking points.

In another interactive tracking example, you may sometimes run into situations where you want to 
eliminate all automatically placed tracking points altogether, placing your own in specific regions 
of the image.

To eliminate automatic tracking points, adding your own instead:

1. Open the Tracker palette.

2. Turn on the Interactive Mode checkbox.

Selecting Interactive Mode

3. In the Viewer, drag a box around all the tracking points in the window, and click the Delete 
button to eliminate all tracking points from the image.
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Selection box surrounding all tracking points

4. Click the Delete button to eliminate all tracking points from the image. 

Deleting tracking points

5. Now, drag a box around the specific area where you’d like to add new tracking points, then 
click the Insert button.

Placing the selection box over the top of the window
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 New tracking points are automatically added to whichever features are appropriate for tracking 
within the box you’ve drawn. If no appropriate tracking features can be found, no points will  
be added.

Placing the selection box over the top of the window

While in Interactive Object Tracking mode you may also choose to add tracking points one by one.

To add a single tracking point:

1. Open the Tracker palette.

2. Turn on the Interactive Mode checkbox.

3. Using the DaVinci control surface, press the CURSOR button above the fourth trackball of the 
Center panel, and move the onscreen cursor to the detail of the image that you want to add a 
tracking point to.

4. Click the Set Point button, within the Interactive Mode controls of the Tracker palette. 

 This adds a tracking point corresponding to the feature of the image that you clicked, and 
you’re ready to start tracking.

Using the Keyframes Interpolation Controls

Sometimes you’ll find that you need to deal with a gap in the useful tracking data. For example, 
objects in the frame that obscure the feature you’re trying to track cause gaps in the tracking 
information for a clip. Another common example is when the feature you’re tracking starts off 
screen, and then moves on screen (a person walking, or a stationary feature that moves when the 
camera pans). While you can track the feature as long as it’s fully within the frame, once it starts to 
move off screen, you may lose your track, and the window will be stuck at an awkward position on 
screen even though the feature it’s supposed to be isolating is gone.
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In these situations, you can identify the gap or problem in the tracking data, and use one of two 
methods to “patch” the tracking data by linearly interpolating the track path so that the window 
moves from the last good frame of data to the next good frame of data, without interruption

To replace a section of low-quality tracking data with a linear interpolation:

1. Drag a bounding box over parts of one or more curves in the Tracker Graph that you want  
to eliminate.

2. Click the Tracker palette option pop-up menu, and choose Clear Selected Keyframes.

 The portions of curves that you selected are deleted, and have linear interpolation automatically 
applied to them so that there’s no hole in the track data or the motion of the window.

In situations where a subject being tracked becomes totally occluded by another object in the 
frame, there’s another method of tracking interpolation you can use to cover holes in the available 
tracking data. In the following example, the woman walks behind another fence post, this time one 
that’s taller then she is. The window tracking her face will become completely lost at this point, but 
interpolation will help to salvage this shot.

Original clip



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

512

To interpolate a motion path using the Keyframes controls:

1. Move the playhead to the first trackable frame of the moving feature you’re correcting, and 
create a Power Window that surrounds it. 

Adding the Power Window

2. Use Track Forward to track the feature as far as you can before it becomes obscured behind 
something else in the frame.

3. When the Power Window stops tracking the feature, stop the track.

The Power Window is obscured by the post

4. Open the Tracker palette.
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5. Click the Frame radio button to put the Tracker controls into frame-by-frame adjustment 
mode. This is an important step.

Selecting frame control

6. Move the playhead to the frame where the feature you’re tracking reappears from behind the 
occlusion, then drag the window so that it again overlaps the feature.

Moving the playhead and position the window

7. Use Track Forward to continue tracking the feature until the end of the clip. Alternately, you 
could have started from the end of the clip and used Track Reverse to track the feature as far 
as possible, if that’s easier.

 Now that you’ve identified the gap in your tracking data for this clip, it’s time to set up  
the interpolation. 
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Notice the gap in the tracking data where the window was behind the post

8. Move the playhead to the last tracked frame in the first half of the clip, and click the Mark 
button. Keyframes appear on each of the curves in the Tracker Graph.

Adding a tracking keyframe in preparation to interpolate between

9. Now, move the playhead to the first tracked frame of the second half of the clip, and click the Mark 
button again. Another set of keyframes appear on each of the curves in the Tracker Graph.

Positioning the playhead at the edge of the tracking data gap to add the second keyframe

10. With the poorly tracked area of the Tracker Graph isolated with keyframes, click the Between 
button.
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Select Interpolate Between

 A motion path is automatically interpolated to fill the gap in between the clip’s two successfully 
tracked sections.

Tracks now show data between the keyframes

Manually Repositioning Tracks

Since interpolation generates a smoothly linear motion path, it may not work if you’re tracking an 
irregularly moving feature that becomes obscured. In these cases, you have the option of manually 
tracking a window to fit the likely trajectory of the hidden feature, frame by frame.

To manually reposition or track a window that can’t be interpolated properly:

1. Open the Tracker palette, and click Frame to change the tracking mode.

2. Click the Tracker palette Option pop-up, and choose Show Track to see the motion path in the 
Viewer. This will help you see the adjustments you’re making.

3. Move the playhead to the last frame that was successfully tracked.

4. Move the playhead frame by frame, and adjust the position of the window at each frame to 
move along with the feature that you’re trying to track.

 Continue adjusting the window frame by frame until you’ve reached the end of the clip, or 
reached the end of the gap in tracking data so that the window is now at the beginning of the 
next successfully tracked section of the clip.
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This technique may not be fun, but it’ll get the job done in a pinch. You can also use this technique 
to reposition specific motion path points in the middle of an otherwise successful track to make 
them fit better. 

Tip: You can also turn on the motion path by pressing the SHOW TRACK soft key on the Center 
panel of the DaVinci control surface when you’re in OBJECT TRACK MODE.

Image Stabilization

The Image Stabilization mode of the Tracker palette lets you smooth out or even steady unwanted 
camera motion within a clip. The analysis is performed in such a way as to preserve the motion of 
individual subjects within the frame, as well as the overall direction of desirable camera motion, 
while correcting for unsteadiness.

Image stabilization in DaVinci Resolve consists of three steps. First, you analyze the clip. Second, you 
choose the Stabilization settings you want to use. Third, you click Stabilize to calculate the result.

As with Object Tracking, you can choose which aspects of motion to stabilize, but this must be 
done before you do the initial image analysis.

Analyze Controls

The Analyze controls automatically scan through the entire clip, identifying trackable features that 
can be used to stabilize the shot.

A series of four checkboxes let you turn on and off which axes you’d like to stabilize. These checkboxes 
must be selected before you perform an analysis in order to restrict the data that’s generated.

 > Pan: Enables horizontal stabilization.

 > Tilt: Enables vertical stabilization.

 > Zoom: Enables stabilization of size.

 > Rotate: Enables stabilization of orientation.

Note: Once stabilization has been done, disabling these checkboxes does nothing to alter the 
result. To make changes, you need to enable or disable the necessary checkboxes first, and then 
reanalyze the clip.

The next three buttons let you perform the stabilization analysis.

 > Track Reverse button: Initiates tracking from the current frame backward, ending at the first 
frame of the clip.

 > Pause button: Stops tracking (if you’re fast enough to click this button before tracking is finished).

 > Track Forward button: Initiates tracking from the current frame forward, ending at the last 
frame of the clip.
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Interactive Mode Controls

The Interactive controls let you make manual changes to the automatically generated tracking point 
cloud that Resolve creates, so you can try different ways of obtaining better stabilization results in 
challenging situations.

 > Interactive Mode checkbox: Turns the Interactive stabilization mode on and off. When 
you enter Interactive mode, you can manually alter the point cloud that Resolve uses to 
stabilize the image. You’ll then make your analysis while in Interactive mode. When you 
exit Interactive mode, your manual changes to the point cloud are eliminated, and Resolve 
again uses automatically placed point clouds to do all stabilization.

 > Insert: Lets you add tracking points to whatever analyzable features exist within a bounding 
box that you’ve drawn in the Viewer. Inserted stabilization points are automatically placed.

 > Set Point: Lets you use the cursor (using the DaVinci Resolve control surface), to manually 
place individual tracking points, one by one, with which to track a feature. If there is no 
trackable pixel group at the coordinates where you placed the cursor, a tracking point will 
be placed at the nearest trackable pixel group. You must place at least two tracking points 
at different pixel groups to track rotation, and at least three to track zoom.

 > Delete: Eliminates all stabilization points within a bounding box that you’ve drawn in  
the Viewer.

The procedures for using Interactive Mode for stabilization are the same as for tracking. See the 
“Object Tracking Workflows” section earlier in this chapter.

Stabilization Parameters and Controls

There are four controls in the Stabilization group:

Stabilization selections

 > Strong: Lets you choose how tightly to adhere to the stabilization track. Some stabilized 
clips might look a little more natural with looser stabilization. 

 > Smooth: Lets you choose how much stabilization to apply to the clip. Lower values allow 
more of the original camera motion to show through, while higher values lock the shot off 
more aggressively. Zero (0) disables stabilization altogether.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

518

 > Zoom: When this checkbox is turned on, the image is resized by a large enough percentage 
to eliminate the blanking (black edges) that is the result of repositioning the image to 
eliminate unwanted camera motion. The higher a value Smooth Frames is set to, the more 
Resolve will need to zoom into an image to eliminate these blanked edges. If you turn 
this off, the image is not zoomed at all, and whatever blanking intrudes into the image is 
output along with the image, on the assumption that you’ll have dedicated compositing 
artists deal with eliminating this blanking by filling in the missing image data in a more 
sophisticated manner.

 > Stabilize: After you’ve tracked the clip and adjusted the previous two controls, you need to 
click Stabilize to calculate the resulting effect on your clip. Whenever you make changes to 
the Smooth Frames slider and Stabilization Zoom checkbox, you need to click Stabilize to 
recalculate the result to your clip.

Using Stabilization

Image stabilization in DaVinci Resolve is easy, but you need to follow a specific series of steps for it 
to be successful.

To stabilize an image:

1. Open the Tracker palette, and choose Stabilizer from the palette mode pop-up menu.

2. Turn off any of the Analyze checkboxes (Pan, Tilt, Zoom, Rotate) that correspond to transform 
axes you don’t want to smooth.

3. Click the Track Forward button to track the clip forward (or Track Reverse if you’d rather start 
from the end of the clip and work backwards).

Notice the multiple tracking points for stabilization

 This analyzes the clip, but no stabilization is yet applied.
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4. Increase the Strong and Smooth Frame parameters to reflect the amount of stabilization 
you want. 

5. Choose how you want the edges of the stabilized clip to be handled:

 > If you want Resolve to zoom into the image as much as is necessary to prevent blanking 
(black edges) from intruding into the frame (the result of repositioning the image to steady 
camera motion), then turn on the Viewer Zoom checkbox.

 > If you want to leave the scale of the image alone, allowing blanking (black edges) to intrude 
into the frame so that you can have an effects artist deal with filling in these holes later 
(without the need to zoom in), then turn off the Viewer Zoom checkbox.

6. With all of these controls adjusted, click Stabilize. The clip is immediately transformed to apply 
the amount of stabilization you selected via the Smooth Frames slider.

7. Play the clip and examine the stabilization effect. If you need to make any changes, choose 
new Strong and Smooth Frames values, then click Stabilize.

 Any time you change any of the Stabilization parameters, you need to click Stabilize to 
recalculate the resulting transform to your clip.

Tracking and Stabilizing with the DaVinci Control Surface

All of the tracking commands are available via the DaVinci Resolve control surface.

To open and close tracking controls:

 > Press OBJECT TRACK MODE at the top of the T-bar panel.

All of the tracking controls appear on the soft keys of the Center and T-bar panels.

To do simple tracking:

 > Use the TRACK FWD, TRACK REV, and STOP TRACK soft buttons on the left side of the 
Center panel.

 > Press SHOW TRACK if you want to see the resulting motion path.

To turn tracking on and off for Pan, Tilt, Zoom, and Rotate:

1. Press the P/T/Z/R ENABLE soft key.

 The middle four soft keys of the Center panel change to display PAN ON/OFF, TILT ON/OFF, 
ZOOM ON/OFF, and ROTATE ON/OFF.

2. Use these buttons to toggle any of these checkboxes on or off, then press BACK to go back to 
the other tracking controls.
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To interpolate between two separately tracked ranges of frames:

1. Use the transport controls to move the playhead to the first frame you want to place a mark, 
and press MARK.

 A Viewer Mark appears on the tracking bar, identifying either the beginning or the end of the 
gap in that clip’s motion tracking data.

2. If necessary, use the transport controls to move the playhead to the second frame where you 
want to place a mark, and press MARK.

 A second Viewer Mark appears in the tracking bar, identifying both the beginning and end of 
the gap in that clip’s motion tracking data.

3. To perform the interpolation, do one of the following:

 > If you marked both the first and last tracked frames that surround a gap in tracking data, 
press the INTRPLT BETWEEN soft key.

 > If you marked the last tracked frame in the first half of the clip, then use the transport 
controls to move the playhead to the first tracked frame of the second half of the clip and 
press the INTRPLT REV soft key.

 > If you marked the first tracked frame in the second half of the clip, then use the transport 
controls to move the playhead to the last tracked frame of the first half of the clip and press 
the INTRPLT FWD soft key.

To move the playhead to different “cue” frames:

 > Press the CUE START, CUE LOWER, CUE UPPER, or CUE END soft keys on the T-bar panel.

To use Interactive mode:

1. Press the INTERACTIVE soft key at the left of the center panel.

 Additional buttons controls appear on the soft keys of the Transport panel, including INSERT 
(POINTS), DELETE (POINTS), CLEAR (POINTS), and SET POINT.

2. Do one of the following:

 > To eliminate all tracking points, press the CLEAR soft key.

 > To add a single tracking point, press CURSOR (above the fourth trackball), use the fourth 
trackball to position the on-screen cursor over the feature you’d like to add a tracking point 
to, and then press the SET POINT soft key.

 > To eliminate a range of tracking points in order to prevent the tracking of an undesirable 
feature, use the mouse to draw a bounding box around the tracking points you want to 
remove, and press the DELETE soft key.
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 > To add a range of tracking points to a specific feature, use the mouse to draw a bounding 
box around the feature you want to track, and press the INSERT soft key.

3. Use the TRACK FWD, TRACK REV, and STOP TRACK soft buttons on the left side of the 
Center panel to perform the necessary tracking.

4. Press the INTERACTIVE soft key again to leave Interactive mode.
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This section covers effects that aren’t, in and of themselves, considered color corrections. However, 
they allow you to make stylistic and corrective alterations to the image that other applications 
typically apply with “filter” operations.

Blur Palette Effects

The Blur palette has three different modes of operation—blur, sharpen, and mist. While the 
functionality of the blur and sharpen modes somewhat overlap, each mode provides dedicated 
controls that the other ones lack.

As with virtually everything else in the Color page, the operations performed in the Blur palette 
can be limited as a secondary operation using HSL Qualifiers, Windows, or Imported mattes, which 
makes it easy to apply these effects to specific portions of the image.

Many of the controls in the Blur palette consist of three ganged sliders, one for red, one for green, 
and one for blue. 

By default, these ganged sliders move together as one, resulting in each color channel of the image 
being equally affected. A small orange button to the left of each control’s name lets you ungang 
these sliders, in order to apply degrees of adjustment to individual color channels.

Blur

The default mode, Blur lets you apply an exceptionally high-quality Gaussian blur to your image. 
This mode of operation has the simplest controls.

Two sets of linked parameters let you adjust the extent and directionality of blur. Additionally, you 
have the option in this mode to either blur or sharpen, depending on the direction in which you 
adjust the Radius control.

Blur Radius controls are ganged by default, but can be unganged

Blur Effects
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 > Radius: This is the primary control for adding blur or sharpening. The default value of 0.50 
results in no effect being applied to the image. Raising the radius slider increases blur, to a 
maximum value of 1.00. Lowering the radius increases sharpness, with a minimum value of 
0.00 providing maximum sharpness.

Tip: If you raise the Radius slider all the way to 1.00 and the image isn’t blurred enough, add 
another node and use it to add another blur operation.

 > H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

To adjust the Blur controls using the DaVinci control surface:

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Trackball’s 
main page.

2. Use the BLUR AMOUNT and H/V RATIO knobs to add either blur or sharpening.

3. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.

Sharpening

While the Blur controls also let you apply sharpening simply by lowering rather then raising the 
Radius sliders, the actual Sharpen mode provides additional controls specifically for tailoring 
sharpening operations.

Sharpening with Coring Softness and Level
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 > Radius: This is the primary control for adding blur or sharpening. The default value of 0.50 
results in no effect being applied to the image. Raising the radius slider increases blur, to a 
maximum value of 1.00. Lowering the radius increases sharpness, with a minimum value of 
0.00 providing maximum sharpness.

 > H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

 > Scaling: Multiplies the amount of scaling being applied by the Radius control for  
sharpening operations. The scaling parameter has no effect if Radius is set to 0.50 or  
above for blur effects.

The Coring Softness and Level parameters work together to allow you to be selective about which 
parts of the image you’re sharpening, without the need to build a secondary operation.

 > Coring Softness: Lets you limit how much of the image is being sharpened, based on the 
threshold of image detail defined by the Level parameter. With Level at 0, Coring Softness 
adjusts the blend between sharpening of the most detailed areas of the image (such as 
the eyes, lips, and dimples of a face), and low detail areas of the image that are not being 
sharpened at all (such as the cheeks, forehead, and chin).

 > Level: Sets the threshold at which image detail is omitted from a sharpening operation 
when Coring Softness is raised. The default setting of 0 sets the threshold low enough 
to omit all but the most highly detailed edges of an image. Raising Level gradually omits 
areas of reduced complexity, which results in more of the image being included in a 
sharpening operation.

To adjust the Sharpening controls using the DaVinci control surface:

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Center panel’s 
main page.

2. On the Center panel, press the IMAGE MODE soft key repeatedly to cycle to the RESOLVE 
IMAGE SHARPENING controls.

3. Use the SHARP AMOUNT, SCALING, LEVELS, and SOFTNESS knobs to create the desired 
sharpening effect.

4. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.
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Mist

The Mist mode lets you combine blur and sharpen operations in such a way as to create effects 
similar to those achieved via “Vaseline on the lens” or Pro-Mist optical filters.

Mist including Mist Mix control

Unlike the Blur or Sharpen modes, where the Radius sliders provide immediate access to the 
desired effect, the Mist mode requires you to lower the Radius and Mix sliders together to get a 
desirable result. By varying the amounts of Radius and Mix, you can create many variations on the 
mist effect.

 > Radius: When creating a Mist effect, you first need to lower Radius to sharpen the image. 
This operations then combines with a lowering of the Mix parameter to provide the 
combination of detail and blurring that results in a mist effect.

 > H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

 > Scaling: Multiplies the amount of scaling being applied by the Radius control, and lets you 
intensify a mist effect beyond the Radius slider’s ordinary range. The scaling parameter has 
no effect if Radius is set to 0.50 or above for blur effects.

 >Mix: After you sharpen the image using the Radius slider, decreasing the Mix parameter 
adds a superimposed blur that mixes with the high-detail areas of the picture to create the 
mist effect.
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To adjust the Mist controls using the DaVinci control surface:

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Center panel’s 
main page.

2. On the Center panel, press the IMAGE MODE soft key repeatedly to cycle to the RESOLVE 
MIST EFFECT controls.

3. Use the RADIUS, H/V RATIO, SCALING, and MIX knobs to create the desired mist effect.

4. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

527

DaVinci Resolve has a powerful tool set for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations. This section covers the nuts and bolts of resolution 
independence in DaVinci Resolve, and how to use the Sizing palette.

Resolution Independence in DaVinci Resolve

DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution 
of your source media, it can be output at whatever other resolution you like. This also means that 
you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, and 
scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, 
and then output at another resolution. This also makes it easy to output multiple versions of a 
program at different resolutions, for example, outputting both HD and SD sized versions of the 
same program.

Finally, the controls found in the Sizing palette let you transform clips individually, either to push 
into a clip for creative intent, or to pan and scan media of one format to fit better into a different 
output format.

Using High Resolution Media in Lower Resolution Projects

Every set of transform and sizing parameters and settings that resize clips is combined intelligently, 
so that the highest resolution media is always used as the source for any transform. For example, 
if you’re using 4K media within a 1920x1080 project, and you need to enlarge a clip using the Input 
Sizing palette’s Zoom parameter, the image is scaled relative to the native 4K resolution of the 
source, and the result is fit into the current timeline resolution. This automatically guarantees the 
highest quality for any image transform you make.

Timeline Resolution

This is one of the most fundamental settings in your project, defining its frame size. You can choose 
a predefined resolution from the “Set timeline resolution to” pop-up menu, or you can type a 
custom resolution into the X and Y fields below.

Media used in a project does not have to match the timeline resolution, in fact it’s common to 
mix resolutions within the same timeline. Clips that don’t match the current resolution will be 
automatically resized according to the currently selected Image Scaling setting (described below).

As mentioned earlier, you can change the timeline resolution at any time. When you do so, all Power 
Windows, Sizing palette adjustments, tracking, keyframing, and other geometric operations are 
automatically and accurately scaled to fit the new resolution.

2D Transforms
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Pixel Aspect Ratio (PAR)

The Timeline Format settings, found in the Master Project Settings, let you specify a Pixel Aspect 
Ratio in addition to the frame size. Defaulting to Square Pixel, which is appropriate for high definition 
projects, there are also options for 16:9 anamorphic, 4:3 standard definition, or Cinemascope. Which 
options are available depends on what timeline resolution you’ve selected.

In addition, each clip has individually adjustable PAR settings, for situations where you’re mixing 
multiple types of media within a single project. For example, if you’re mixing SD clips with non-
square pixels and HD clips with square pixels, you can sort out all of the SD clips in the Media 
Pool and assign them the appropriate NTSC or PAL non-square pixel ratio PAR setting. For more 
information, see Chapter 3, “Working in the Media Page.”

Image Scaling

If a clip’s native resolution doesn’t match the Timeline Resolution, then the currently selected Input 
Scaling Preset dictates how the mismatched clip will be handled. The default setting is “Scale 
entire image to fit,” which shrinks or enlarges the image to fit, in the best way possible, the current 
dimensions of the frame, adding letterboxing or pillarboxing as necessary.

The Image Scaling parameters are found in the Project Settings window, and there are two sets of 
parameters that let you set the quality and method used for these automatic transforms.

Image Scaling filters let you choose the mathematical method used to resize clips:

 > Uses sharper filter: Usually provides the best quality in projects, using the optical quality 
processing unique to DaVinci Resolve.

 > Uses smoother filter: May provide a more pleasing result for projects using clips that must 
be scaled down to standard definition, as this filter exhibits fewer sharp edges at SD 
resolutions.

 > Uses bilinear filter: A lower quality setting that is less processor intensive. Useful for 
previewing your work on a low-performance computer before rendering, when you can 
switch to one of the higher quality options.

 > Input scaling preset: Checking this box lets you choose an Input Sizing preset to apply to 
the project.

 >Output scaling preset: Checking this box lets you choose an Output Sizing preset to apply 
to the project.
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Input Image Scaling options let you choose how clips that don’t match the current project resolution 
are handled. The illustrated examples show an SD clip (gray) being fit into an HD project (blue) using 
each of the different options.

 > Center crop with no resizing: Clips of differing resolution are not scaled at all. Clips that are 
smaller than the current frame size are surrounded by blanking, and clips that are larger 
than the current frame size are cropped.

 > Scale full frame with crop: Clips of differing resolution are scaled so that the clip fills the 
frame with no blanking. Excess pixels are cropped.

 > Scale entire image to fit: The default setting. Clips of differing resolution are scaled so 
that each clip fills the frame without cropping. The dimension that falls short has blanking 
inserted (letterboxing or pillarboxing). 
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 > Stretch frame to all corners: Useful for projects using anamorphic media. Clips of differing 
resolutions are squished or stretched to match the frame size in all dimensions. This way, 
anamorphic media can be stretched to match full raster, or full raster media can be squished 
to fit into an anamorphic frame. An added benefit of this setting is that it makes it easy to 
mix anamorphic and non-anamorphic clips in the same project.

Output Image Scaling

Another group of settings found in the Image Scaling panel of the Project Settings lets you 
optionally choose a different resolution to be output via your video output interface, for monitoring, 
outputting to tape, or rendering. If you set the resolution in the Render Settings list of the Deliver 
page to something other then the Timeline Resolution, these settings are used to make the change. 
This can be used in situations where you’re working on a high resolution 4K project, but you want to 
monitor using an HD display, and output HD resolution media for approval.

 > Lock to timeline format: Turned on by default, so that these settings mirror the Image 
Scaling and Input Image Scaling settings described above. Turning this checkbox off lets 
you choose different settings for monitoring, outputting to tape, or rendering, using the 
other settings in this group.
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 > Set output resolution to: Lets you choose an alternate resolution.

 > For “X x Y” processing: Lets you specify a different custom alternate resolution.

 > Pixel aspect ratio is: Lets you specify an alternate pixel aspect ratio to match the alternate 
timeline format.

 >Mismatched resolution files: Lets you choose an alternate way of handling mismatched 
resolution files given the alternate resolution you’ve chosen. These options work identically 
to those of the “Input Image Scaling” group.

Edit Page Transform Parameters and Imported Sizing Information

 A set of Transform parameters corresponding to each clip in the Timeline is available from the 
inspector. These parameters operate independently of the Sizing controls found in the Color page, 
and exist primarily to store incoming transform data from imported AAF and XML projects coming 
from other applications.

The transform parameters in the Inspector of the Edit page

If, when importing an AAF or XML project file, you turned on the “Use sizing information” checkbox, 
then every clip that had position, scale, rotation, or crop settings applied in the originating NLE will 
have those adjustments applied to these transform parameters.

The transformation applied by these parameters is combined with whatever Input and Output 
Sizing adjustments are being made, to output the final geometric result.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

532

Edit, Input, Output, and Node Sizing on the Color Page

The Sizing palette on the Color page has another dedicated set of keyframable transform 
parameters that work with the DaVinci Control Surface to let the colorist apply pan and scan 
adjustments while working through a project. These parameters work independently of the Edit 
page Transform parameters, allowing you to keep imported transform settings separate from other 
transform settings that you apply. However, for convenience the Edit sizing controls are available in 
the Color page as well.

Format Resolution on the Delivery Page

By default, the Format Resolution setting in the Render Settings of the Deliver page matches the 
Timeline Resolution when “Match timeline settings” is enabled in the Output Scaling Preset in 
Project Settings .

Choosing a new resolution from the “Set Resolution to” pop-up menu lets you override the current 
Format Resolution setting before rendering. Using this control, you can queue up multiple jobs, 
each set to a different resolution, to output multiple formats during a single render session. For more 
information on rendering and setting up jobs for the Render Queue, see Chapter 10, “Deliver.”

The Four Color Page Sizing Modes

The Sizing Palette on the Color page can be put into three modes: Input Sizing, Output Sizing, and 
Node sizing. 

 >  Edit Sizing: These controls mirror those found in the Inspector of the Edit page.

 > Input Sizing: These controls let you make sizing adjustments to individual clips that affect 
their overall geometry (pan, tilt, zoom, and rotation). These controls are useful for doing clip 
by clip pan and scan adjustments.

 >Output Sizing: These controls are nearly identical, except that they affect every clip in the 
entire timeline, all at once. Output sizing is useful for making a formatting adjustment to an 
entire timeline, such as changing an HD timeline to an SD timeline with simple adjustments 
to crop and pan the resulting framing.

 >Node Sizing: Lets you add targeted sizing adjustments at any point within the node tree. 
Like Input Sizing, Node Sizing is specific to a particular clip. Unlike Input Sizing, Node Sizing 
is affected by operations that split color channels (such as the splitter/combiner nodes) 
and limit the image (such as qualifiers and windows). You can also add as many node sizing 

adjustments to a clip’s grade as you need.

Sizing Order of Processing on the Color Page

Input Sizing adjustments are applied before all image processing that takes place in the node 
graph, including Node Sizing, while Output Sizing adjustments are applied after image processing 
in the node graph.
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Using Node Sizing

Using Node Sizing, you can apply individual sizing adjustments on a per-node basis. All Node Sizing 
adjustments within a grade are cumulative, and any keyframing done to Node Sizing parameters is 
stored in that node’s Node Format keyframe track in the Keyframe Editor. Two good examples of 
Node Sizing include realigning color channels individually in conjunction with the Splitter/Combiner 
nodes, or duplicating windowed regions of an image by moving them around the frame.

Example 1: Using node sizing on individual color channels:

1. Choose Nodes > Add Splitter/Combiner Node to add this node structure to the current grade.

2. Select one of the three Corrector nodes connected between the Splitter and Combiner nodes 
that corresponds to the color channel you want to transform.

Adding the Splitter/Combiner nodes to use node sizing on individual color channels

3. Open the Sizing palette, choose Node Sizing from the mode pop-up, and use the Sizing 
parameters to transform that channel as necessary. For example, if you have an old video clip 
with misaligned color components, you could pan a misaligned channel to the left or right to 
try and improve its alignment.

       

Before and after panning the green channel
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Example 2: Using node sizing to duplicate a windowed area of an image to cover a blemish:

1. Create a new node.

2. Open the Window palette, create a Circular window, and then shrink and reposition it to 
surround a feature you want to remove.

3. Open the Tracking palette, and track the window to follow the feature to be removed.

4. After the track is complete, now move the window to an adjacent area of clean detail that’s 
right next to the feature you want to remove. This is the area of the image you’re going to 
duplicate and cover the unwanted feature with.

5. Now, open the Sizing palette, choose Node Sizing from the mode pop-up, and use the Sizing 
parameters to move a duplicate of the windowed area to cover up the unwanted feature.

       

Before and After using node sizing to clone an area of the image to cover up an unwanted feature

When you’re done, playing through the clip should show that the duplicated area of the image is 
still tracking the feature you want to remove.

Sizing Controls

Input, Node, and Output Sizing share many of the same controls. When the Sizing palette is set to 
Input Sizing mode, the controls transform each clip individually. If you’re simply pushing in on one 
or two clips, or making individual pan & scan adjustments to account for a change in format, these 
are the controls you want to use.
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The onscreen control in the Sizing palette

 > Pan: Moves the clip along the horizontal, X axis. Positive values move the clip right, negative 
values move the clip left.

 > Tilt: Moves the clip along the vertical, Y axis. Positive values move the clip up, negative 
values move the clip down.

 > Zoom: Positive values enlarge the clip, negative values shrink the clip.

 > Rotate: Positive values rotate the clip clockwise. Negative values rotate the clip counter-
clockwise.

 >Width: Positive values stretch the image wider, negative values squish the image narrower.

 > Height: Positive values stretch the image taller, negative values squish the image shorter.

 > Flip Horizontal control: Reverses the image along the X axis, left to right.

 > Flip Vertical control: Reverses the clip along the Y axis, turning it upside down.

Sizing OSC

An onscreen control currently mirrors the sizing parameters, showing you a preview of the 
transformed image, shown by an orange outline, relative to the size of the frame, shown in gray. 
Zoom and reset controls make it easier to see the full display.
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Blanking Controls

Output Sizing mode also has a set of Blanking controls that you can use to add custom blanking 
to a clip or project. For example, you can use these controls to add nonstandard letterboxing or 
pillarboxing to an image. Along with all other Output Sizing adjustments, blanking is added last in the 
image processing pipeline, so it’s not affected by any of the color or contrast adjustments you make.

 > Left: Adjusts the left pillarbox.

 > Right: Adjusts the right pillarbox.

 > Top: Adjusts the top letterbox.

 > Bottom: Adjusts the bottom letterbox.

Blanking presets are also available by choosing from the Color > Output Blanking submenu. 
Choosing one of these options automatically sets the Blanking parameters of the Sizing palette’s 
Output Sizing mode. The following presets are available: 

 > 1.33: SD or 4:3

 > 1.66: European theatrical

 > 1.77: HD or 16:9

 > 1.85: Theatrical flat aspect ratio

 > 2.35: Original anamorphic (scope) theatrical wide-screen

 > 2.39: Current 35mm anamorphic (scope) theatrical wide-screen

 > 2.40: Current 35mm anamorphic (scope) theatrical wide-screen (rounded up for Blu-Ray)

Anti-aliasing at the edges of blanking is handled by a setting in the Image Scaling panel of the 
Project Settings. For more information, see Chapter 2.

Resetting the Sizing Palette

You can reset every control within the Sizing palette at any time by choosing Reset from the palette 
options pop-up menu, or by clicking the reset button in the upper left-hand corner of the palette.

Input and Output Sizing Presets

If there are Input or Output Sizing settings that you find yourself using repeatedly, you can save 
them as presets for easy recall. For example, if there’s a group of input settings that you use to 
resize a clip of a particular format to match the current project, you can save it as a preset that you 
can use whenever. 

 > Preset pop-up menu: Provides access to all the currently saved presets in the 
current  database.
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 > Delete preset: To delete a preset, select it from the pop-up menu, click the trash can 
button, then click OK.

 > Add preset: To add a preset, make whatever settings adjustments you need, then click the 
plus button. When the Format Preset dialog appears, enter a name, check that the settings 
are correct, then click Save.

 > Change preset: To change a preset, load the preset you want to change, make whatever 
changes you need, then click the check button.

The Input and Output Sizing modes save different presets. Each of these sets of presets is available 
from the “Override input scaling” and “Override output scaling” pop-up menus in the Image 
Scaling panel of the Project Settings.

Sizing Controls With the DaVinci Control Surface

There are two sets of DaVinci control surface mappings for the sizing controls. The most obvious 
controls can be seen permanently mapped to the knobs and soft keys of the Transport panel. This 
makes these controls easy to access for projects where you’re panning & scanning nearly every shot 
of a film-scanned program. 

To adjust PTZR settings:

1. Press the OUTPUT or INPUT soft key to switch between Output Sizing and Input Sizing modes. 

2. Use the PAN, TILT, ZOOM, and ROTATE knobs of the Transport panel, and the H FLIP and V 
FLIP soft keys.

To adjust Input and Output Blanking:

1. Press the INPUT BLANKING or OUTPUT BLANKING soft key on the Transport panel.

2. Use the knobs labeled LEFT, RIGHT, TOP, and BOTTOM to make a blanking adjustment. 

3. Press SIZING when you’re finished.

Another set of DaVinci control surface mappings appears when you press the SIZING button of 
the T-bar panel. In this case, the Center panel knobs and soft keys update to a page showing 
the following:

 > Ref Wipe Sizing Adjustments: These controls, on the middle screen of the Center panel, 
let you reposition a still from the Gallery that’s being displayed in a split screen. This can 
make it easier to compare features that would otherwise be obscured by the still’s position 
on screen.

 > Input Sizing Adjustments: The Input Sizing controls are displayed on the right screen of the 
Center panel. These are similar to the mappings on the Transport panel, but the Center 
panel’s second row of knobs also exposes PITCH, YAW, H SIZE, and V SIZE controls, and 
there’s an additional MODIFY PAR button that lets you change the pixel aspect ratio of a clip.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

538

 >Output Sizing Adjustments: If you press OUTPUT soft key on the Center panel, the knobs 
and soft keys change to show the Output Sizing controls. Press BLANKING to expose all 
the preset aspect ratios on the Transport panel, along with the USER which allows you to 
expose user definable presets.

To save and recall user definable blanking aspect ratios:

1. Press SIZING on the T-bar panel.

2. Press the OUTPUT soft key on the Center panel.

3. Press the OUTPUT BLANKING soft key on the Transport panel, and then enter the blanking 
aspect ratio as a number (e.g., 2.4) using the number pad on the Transport panel to set your 
customized blanking.

4. Press the BLANKING soft key on the Center panel.

5. To apply the new ratio, press the BLANKING soft key on the Center panel, then press USER on 
the Transport panel, and press one of the USER 1-5 soft keys.

Tip: With the Input Sizing Adjustments controls exposed on the Center panel, you can set the 
Transport panel to display the Output Sizing controls, for simultaneous presentation of every sizing 
control that’s available.
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Stereo 3D Palette

This palette contains all the controls necessary for working on stereoscopic (colloquially known as 
3D) projects. It provides controls for choosing which eye to grade, adjusting convergence, swapping 
and copying grades and media between matching left- and right-eye clips in paired timelines, auto-
processing the color and geometry of left- and right-eye clips to match, stereo monitoring setup, 
and controls for floating windows.

Stereoscopic 3D palette

Your project must contain stereo 3D clips in order to open this palette. For more information 
on setting up a stereo 3D project, see the “Stereoscopic Workflows” section of Chapter 6, 
“Conforming Projects.”

Stereo Eye Selection

Most colorists work by grading one eye first (typically the left), and rippling their grades to the 
other eye, making separate adjustments to each eye’s clips when necessary to match undesirable 
variation between cameras.

The first three buttons in the Stereo 3D palette let you choose which eye to grade while you’re 
working, as well as whether or not to ripple each clip’s grade to the matching opposite-eye clip. 
Whenever you switch eyes, the 3D badge above each clip’s thumbnail changes color (blue for right, 
red for left) and the thumbnails themselves update to show that eye’s media.

The Left eye is master and ganged with the right

 > Left button: Displays the left eye image and grade.
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 > Ripple Link button: When enabled (orange), all changes you make to the grade of the 
currently selected eye are automatically copied to the correspondingly opposite eye. 
When disabled (gray), grades made to the currently selected eye are made independently.

 > Right button: Displays the right-eye image and grade.

Tip: You can also choose which eye you’re viewing and grading by right-clicking a clip’s thumbnail 
and choosing Stereo > Switch Eye or by choosing View > Switch Eye To > Left Eye or Right Eye.

Using Ripple Link When Grading Stereo 3D Clips

You would turn Ripple Link off to suspend rippling when you want to make an individual adjustment 
to the grade of one eye to obtain a better match between the two. When you’re finished matching 
the two clips, you can turn it back on to resume automatic grade rippling. 

Stereo 3D grade rippling is always relative, so differences between the grades that are applied to 
the left- and right-eye clips are preserved. In fact, when you add or remove nodes to or from one 
eye, the same nodes are automatically added to or removed from the corresponding clip it’s paired 
with, regardless of whether or not Ripple Linked is enabled.

Important: Regardless of whether or not Ripple Link is enabled, local versions created for one stereo 
3D-identified clip are automatically available to the paired timeline.

Stereo 3D Geometry Controls
The next group of parameters lets you adjust the geometry of stereo 3D clips. The Pan, Tilt, and 
Zoom controls are provided as a convenience, and simply mirror the same parameters found in the 
Transform palette’s Input mode. Convergence, Pitch, and Yaw are the three parameters that are 
unique to the Stereo 3D palette.

Stereoscopic 3D Geometry controls
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 > Convergence: Adjusts the disparity between the left and right eyes, to define the point of 
convergence (POC), or the region within the image where the left- and right-eye features 
are in perfect alignment. If necessary, Convergence can be animated using the Stereo 
Format parameter group in the Sizing track of the Keyframe Editor.

Features that overlap perfectly in both right- and left-eye clips are at zero parallax, putting 
that feature’s depth at the screen plane. Matching features that are divergent in the left- 
and right-eye clips have increasingly positive parallax, and appear to be farther away from 
the audience. Matching features that are divergent and reversed in the left- and right-eye 
clips have increasingly negative parallax, and appear to be closer to the audience than the 
screen plane.

 > Linked Zoom button: When enabled (orange), both the left- and right-eye clips are 
automatically zoomed whenever Convergence is adjusted so that both eyes always fill the 
screen. When disabled (gray), changes to Convergence will cause the opposing left and 
right edges of each eye’s clip to have blanking intrude. 

 > Pitch: Pivots the image around the horizontal center plane of the frame.

 > Yaw: Pivots the image around the vertical center plane of the frame.

Sizing Repositioning in Stereo 3D

Generally, you’ll want to reposition stereo 3D clips with Ripple Link turned on, but you may 
occasionally find yourself needing to make a manual adjustment to one eye in particular with Ripple 
Link disabled. As with color adjustments, Sizing adjustments made with Ripple Link disabled are 
only applied to the clip in the current timeline. When Ripple Link is turned on, all Sizing adjustments 
are automatically copied to the correspondingly numbered shot of the other stereo 3D timeline.

Warning: It is not advisable to use the Rotate parameter when transforming stereo 3D clips. 
Geometrically, rotation tilts a stereo pair of clips inappropriately, and ruins the “side-by-side” 
convergence that’s necessary to create the stereoscopic illusion.

Protecting Stereo Adjustments When Copying Grades

Each version of a grade has independent stereo adjustments stored along with the Sizing settings. 
To prevent accidental overwrite of convergence and alignment data when copying grades from 
one clip to another, you can right-click within the Gallery and choose one of the following options 
to turn them on:

 > Copy Grade: Preserve Convergence

 > Copy Grade: Preserve Floating Windows

 > Copy Grade: Preserve Auto Align
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When enabled, these options lets you overwrite a clip’s grade without overwriting specific Stereo 
3D parameters.

Tip: Stereo 3D and Sizing settings are processed before node-based corrections in the Resolve 
image processing pipeline.

Swap and Copy Controls

Another set of controls lets you swap and copy grades, and swap clips, in situations where you need 
to reverse what’s applied to a pair of left- and right-eye clips.

Swap and Copy grades between eyes

 > Swap Grade: Exchanges the grades that are applied to the left- and right-eye clips.

 > Swap Shot: A checkbox that, when enabled, switches the actual media used by two 
corresponding left- and right-eye clips. Useful in situations where the eyes of a stereo 3D 
clip were mislabeled, and you want to switch the clips without rebuilding both EDLs.

 > Copy Left to Right: Copies the left-clip grade to the corresponding right-eye clip.

 > Copy Right to Left: Copies the right-clip grade to the corresponding left-eye clip.

Batch Grade Management for Stereo 3D Projects

There are also a series of batch-processing commands that are useful for stereoscopic grading that 
are available when you right-click one or more selected clips in the Thumbnail Timeline: 

 > Stereo Batch Copy: Copies every grade from the left-eye clips to the right-eye clips. 

 > Stereo Batch Sync: Copies grades from one eye to the other only when their node graphs have 
the same number of nodes. This prevents you from accidentally overwriting a custom grade 
with a different node structure that was necessary to match two eyes for a problem shot.

The Copy Grade, Swap Grade, Swap Shots, Ripple Link, and Switch Eye commands are also available 
from the Stereo submenu of the Timeline contextual menu. 

Automatic Image Processing for Stereo 3D

It’s common during stereoscopic shoots for minor divergences in geometry and color to appear in 
the source footage. To make the process of grading stereo 3D media less onerous, DaVinci Resolve 
provides a set of auto-adjustment controls that gives you a starting point for matching left- and 
right-eye clips together.
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Auto align and color match buttons

Auto Process—Stereo Alignment

For the stereoscopic effect to work without causing headaches, it’s critical that both eyes are aligned. 
This can be tricky to adjust using manual controls, but is something that can be automatically 
analyzed. You can perform stereo 3D alignment to a single clip, or you can select a range of clips to 
align all of them automatically at once. There are two options. Which is more appropriate depends 
on the type of geometry issues you’re needing to address.

 > Transform Alignment: Analyzes the image and makes vertical and rotational adjustments to 
line up the left- and right-eye images as closely as possible.

 > Vertical Skew: Analyzes the images and makes a vertical-only adjustment to line up the 
left- and right-eye images.

To align one or more clips automatically:

1. Select one or more stereo clips in the Thumbnail Timeline of the Color or Format pages.

2. Do one of the following:

 > Open the Stereo 3D palette, and click either of the Stereo Alignment buttons. The button 
to the left is for Automatic Transform, while the button to the right is for Automatic 
Vertical Skew.

 > Right-click the thumbnail, and choose Transform Alignment or Vertical Skew from the 
contextual menu.

The Stereo Alignment window appears, and a progress bar shows the remaining time this 
operation will take.

Auto Process—Color Matching

Due to the design of different stereo 3D rigs, sometimes the color and contrast of one eye’s media 
doesn’t precisely match that of the corresponding eye. DaVinci Resolve provides two commands for 
quickly and automatically matching two eyes together.

 > Stereo Color Match (Primary Controls): Uses the Lift/Gamma/Gain controls to match one 
eye to the other. The result is a simple adjustment that’s easy to customize, but may not 
work as well as Custom Curves in some instances.

 > Stereo Color Match (Custom Curves): Uses the Custom Curves to create a multipoint 
adjustment to match one eye to the other. The result can be more effective with 
challenging shots.
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Tip: For the best results, it’s recommended to use automatic color matching in a separate node, 
independent of other corrections.

Stereo 3D color match works differently depending on whether or not one of the stereo 3D-paired 
clips has already been graded. The following procedure shows how to match a pair of left- and 
right-eye clips before you make any manual adjustments of any kind.

To match a pair of left- and right-eye clips automatically:

1. Select one or more clips in the Thumbnail Timeline of the Color page.

2. Do one of the following:

 >Open the Stereo 3D palette, and click one of the two Color Match controls.

 > Right-click one of the clips, and choose one of the two options from the Stereo Color Match 
submenu.

 The Color Matching window appears, and a progress bar shows the remaining time this 
operation will take. You can also use automatic color matching to match an ungraded clip to 
a paired clip that’s already been graded. This only works for grades consisting of one or more 
primary corrections; secondary corrections cannot be auto-matched.

To match an ungraded clip automatically to a paired stereo clip that’s graded:

1. To suspend stereo grade linking temporarily:

 >Open the Stereo 3D palette, and turn off the Ripple Link button

 > Right-click the Thumbnail Timeline, and choose Stereo > Ripple Link > Solo.

2. Make a primary adjustment to a clip in the left-eye timeline to create a simple base grade. 
The left-eye clip now has a grade, and the right-eye clip does not.

3. Do one of the following to switch eyes:

 > In the Stereo 3D palette, click Right.

 > Right-click the Thumbnail Timeline again, and choose Stereo > Switch Eye.

 > This procedure only works when you use the Stereo Color Match commands on the 
ungraded clip of a left- and right-eye stereo pair, to match it to the graded clip.

4. To make the match, do one of the following:

 > In the Stereo 3D palette, click one of the two color match controls.

 > Right-click one of the clips, and choose one of the two options from the Stereo Color 
Match submenu.

 > Both clips should match one another very closely.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

545

Stereo 3D Monitoring Controls

To output both eyes to a stereo 3D display, you need to click the Vision: Mono or Stereo radio 
button, and then choose a display mode from the Output pop-up menu.

Monitoring controls for Stereo 3D

 > Vision: Two radio buttons let you choose between Mono, where only one eye is monitored in 
the Viewer and your video output interface, and Stereo, where both eyes can be displayed in 
the Viewer and output to video in a variety of different formats. For more information about 
outputting Stereo 3D to an external display, see Chapter 4, “Stereoscopic Workflows.”

 >Output: A pop-up menu that provides different stereo viewing options for previewing 
stereo 3D signals in different ways. By default, this option is also linked to the Viewer display 
Internal Video Scope options. For detailed descriptions of each stereo 3D viewing mode, 
see the following section, “Output Options.”

 > Link Viewer to Waveform: When enabled (orange), the Viewer and internal video scopes 
both use the same option for stereo 3D viewing as specified in the Output pop-up menu. 
When disabled, you can choose different stereo 3D viewing options for the Viewer and 
internal video scopes.

 > Viewer: Lets you choose a stereo 3D viewing option for the Viewer.

 >WFM: Lets you choose a stereo 3D viewing option for the internal video scopes.

 > Cbd Size: If any stereo 3D viewing options are set to Checkerboard, this parameter becomes 
enabled, and lets you define the size of the checkerboard boxes, in pixels.

Dual 4:2:2 Y’CbCr stereoscopic video streams are output via HD-SDI on selected Blackmagic I/O 
devices when you turn on the ”Enable dual SDI 3D monitoring” checkbox on the Master Project 
Settings panel of the Project Settings. You can select either Side-by-Side or Line-by-Line output 
to be fed to your stereo-capable display, depending on your display’s compatibility. For more 
information, see the “Stereoscopic Workflows” section of Chapter 6, “Conforming Projects.”
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Output Options

Additionally, the Viewer and video scopes can be set to display both “eyes” in one of a variety of 
different modes.

 > Side by Side: Displays both images side by side. Each eye is squeezed anamorphically to fit 
both eyes into the same resolution as the GUI viewer.

 > Line by Line: An interlaced mode where each eye is displayed on alternating lines. The 
thickness of the lines as seen in the Viewer depends on how zoomed in you are.

 > Checkerboard: Displays both eyes via an alternating checkerboard pattern. This is an 
excellent mode for identifying regions of the image where there’s variation in color or 
geometry between the two eyes.

 > Anaglyph (B/W): Each eye is desaturated and superimposed via Red/Cyan anaglyph to 
show the disparity between both eyes in different regions of the image. Left-eye divergence 
is red, and right-eye divergence is cyan. Regions of alignment between both eyes appear 
grayscale. 

Anaglyph modes are useful for evaluating the geometric differences between both eyes, 
as well as for identifying the point of convergence (where both eyes align most perfectly) 
that places a region of the image at the screen plane. 

Red/cyan color coding also identifies the direction of parallax. For any given feature, disparity 
such that red is to the right and cyan is to the left indicates positive parallax (backward 
projection away from the audience). Red to the left and cyan to the right indicates negative 
parallax (forward projection towards the audience).

 > Anaglyph (Color): Similar to Anaglyph (B/W), except that regions of close alignment are 
shown in full color. Incidentally, both anaglyph modes can be previewed on ordinary 
displays using old-fashioned red/cyan anaglyph glasses, enabling stereo 3D monitoring on 
non-stereo 3D-capable displays.

 > Difference: Superimposes grayscale versions of both eyes using the difference composite 
mode. Corresponding left/right-eye pixels that are perfectly aligned appear black, while 
pixels with disparity appear white. This mode is extremely useful for evaluating geometric 
differences between both eyes, as well as for identifying the point of convergence, without 
the distraction of color that the anaglyph modes present.

 >None: Only displays the eye corresponding to the currently selected timeline in the Viewer. 
However, this option also works in conjunction with the “Enable dual SDI 3D monitoring” 
checkbox in the Master Project Settings of the Project Settings which, when turned on, outputs 
each eye to an individual HD-SDI output of your Blackmagic I/O card. For more information 
about outputting Stereo 3D to an external display, see Chapter 4, “Stereoscopic Workflows.”
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Floating Windows

Floating Windows are meant to correct for “Window violations,” where elements of the image with 
negative parallax, that project forward from the screen plane towards the audience, are cut off by 
the edge of the frame. In these instances, differences between the images being shown to the left 
and right eyes can result in a visual paradox that’s difficult for viewers to reconcile. Specifically, when 
a forward-projecting element is cut off by the left or right edge of the frame, one eye sees things 
that the other eye does not.

If the subject is moving quickly, this may not be an issue, but if the cut off (or occluded) element 
lingers onscreen, it causes problems for viewers that defeat the stereo 3D illusion. The viewer’s 
binocular vision (or stereopsis) is providing one depth cue, while occlusion is providing a completely 
different depth cue. 

To fix this, you can use Floating Windows to crop the cut off object from the eye on the side of the 
object that’s cut off, thus eliminating the portion of the stereo image that is unseen to the other eye 
that causes the problem.

The objective of using Floating Windows is to manipulate the illusion of the viewer’s “window into 
the scene.” In addition to fixing Window violations, it has been proposed that Floating Windows 
can be used as a creative tool by manipulating the geometry of this Window to alter subtly the 
viewer’s perception of the screen orientation.

 > By cropping the right-hand side of the right-eye frame, you also create the illusion that the 
right edge of the “window into the image” is tilted farther forward toward the viewer. 

 > By cropping the left-hand side of the left-eye frame, you create the illusion that the left 
edge of the Window is tilted toward the viewer. 

 > If you crop both the left-hand side of the left-eye frame and the right-hand side of the right-
eye frame, you create the illusion that the entire plane of the “virtual screen” is coming 
toward you. 

 > If you apply opposite-angled Windows to the left- and right-eye clips at one or both of the 
edges of the frame, it appears to “tilt” the screen toward or away from the viewer.

Tip: For more information about Floating Windows, see www.dashwood3d.com/help/stereo3d-
virtual-floating-windows/ and river-valley.tv/the-dynamic-floating-window-a-new-creative-tool-for-
3d-movies/.
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Animating Floating Windows

Floating Windows can be animated using the Float Window keyframing track, found within the 
Sizing track of the Keyframe Editor, to push the edge of the frame in as needed, and then pull it 
back out when the partially occluded subject has moved fully into the frame. For more information 
about animating keyframing tracks, see Chapter 6, “Keyframing.”

Floating Window controls

Floating Windows have the following controls and parameters.

 > L/R/T/B buttons: Lets you choose an edge to which to apply a Floating Window. Click the 
button corresponding to the edge you want to adjust. Each edge has its own position, 
rotate, and softness settings.

 > Position: Adds masking to the currently selected edge.

 > Rotate: Rotates the currently selected edge, letting you create an angled Window.

 > Softness: Feathers the edge of the currently selected edge, letting you create a soft 
Window that can be less noticeable to viewers.

To add a Floating Window to fix a Window violation:

1. Choose to which eye you want to add the Floating Window. 

 > To apply a Floating Window to eliminate a Window violation on the right-hand side of the 
screen, click the right eye view. 

 > To apply a Floating Window to eliminate a Window violation on the left-hand side of the 
screen, click the left eye view.

2. Choose which edge you want to adjust by clicking the L or R buttons.

 > To eliminate a Window violation on the right-hand side, click R.

 > To eliminate a Window violation on the left-hand side, click L.

3. Adjust the Position parameter as necessary to crop the portion along the edge of the selected 
eye that’s not visible in the other.

4. Optionally, if you feel that the Window adjustment you’ve just made is too obvious, increase 
the Softness parameter to make that edge less noticeable.
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Stereo Controls on the DaVinci Control Surface

If you’re doing convergence adjustments and stereographic work throughout a program, you can 
use many of the controls described in this section from the DaVinci control surface.

To show the Stereo Transform Controls page on the Transport panel:

1. Press the 3D soft key. The Transport panel’s knobs and soft keys are remapped with all available 
Stereoscopic commands.

2. When you’re finished, press MAIN.

To show the Floating Windows controls on the Center panel:

1. From the main page of the Center panel, press the 3D soft key. The Floating Windows, Auto 
Match, and Auto Align controls appear on the Center panel. 

2. Press the 3D OVERLAY soft key to expose the Stereoscopic sizing controls on the Transport 
panel. Press 3D OVERLAY again to return to the ordinary sizing controls.

3. When you’re finished, press the MAIN soft key to return exit the 3D control page.
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Data Burn In

The Data Burn In palette lets you display select metadata as a “window burn” that’s superimposed 
over the current image in the Viewer. This window burn is written into files that you render in the 
Deliver page, and it’s also output to video, for viewing on your external display, or for outputting 
to tape.

Data Burn-in palette

Window burns are useful as a reference when creating offline media that you need to keep track of 
later. It’s also useful for watermarking review files that you don’t want to be distributed accidentally, 
for adding logos or “bugs” to programs in preparation for broadcast, or for temporarily displaying 
timecode or clip names to refer to on your monitor when reviewing dailies with a client.

Tip: There’s also an Output Option checkbox on the Deliver page, “Burn in this text,” that lets you 
quickly enter a line of custom text to output as a window burn without using the Data Burn In palette.

Viewer displaying a logo, custom text, timecode and file path
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Project vs. Clip Mode

The Palette mode pop-up menu lets you choose whether you want to edit burned-in metadata on 
a clip-by-clip basis to be applied when rendering individual source clips, or one set of burned-in 
metadata that will be displayed for the entire duration of the Timeline, to be applied when rendering 
either individual source clips or as one single clip.

Setting Up Burned-In Metadata

Setting up different clip and project metadata to output as a window burn is easy.

To set up a window burn:

1.  Choose Project or Clip mode from the Palette mode pop-up menu.

2. Turn on the checkboxes of whatever items of metadata you want to display in the “Add to Video 
Output” column. More information about the available items appears later in this chapter.

 The first item of metadata is centered near the bottom of the frame, above Action Safe. Each 
additional item of metadata you turn on for display is added above whichever items are already 
displayed, regardless of their position in the “Add to Video Output” list.

3. Click any currently enabled item of metadata from the list to highlight it in orange, and edit 
that item’s Custom Output parameters at the right. More information about the available 
parameters appears later in this chapter.

To reset the current window burn setup:

 > Click the Options pop-up menu, and choose Reset to reset the current mode of the Data 
Burn In palette.

Saving and Loading Burn-In Presets

If there are common sets of metadata that you regularly use and switch among, you can save each 
set up as a preset for future use.

To save a burn-in preset:

1. Click the Preset name field, and type a name.

2. Click the Preset Options pop-up menu, and choose Add Preset. That preset is added to the 
list of saved presets.
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To delete a burn-in preset:

1. Choose a preset from the Preset menu.

2. Click the Preset Options pop-up menu, and choose Del Preset.

To modify a burn-in preset:

1. Choose a preset from the Preset menu.

2. Edit it however you like.

3. Click the Preset Options pop-up menu, and choose Update Preset.

Data Burn-In Options

The leftmost column in the Data Burn In palette contains a scrollable list of all the options that you 
can add to the video output as a window burn. Each option has a checkbox that lets you turn it on or 
off. You can also select in the Option pop-up if your would like the item name rendered as a prefix 
to the burn-in data. 

Note: If two clips overlap in the Timeline, the metadata that matches the currently visible clip in the 
Viewer is what will be displayed in the window burn.

 > Record Timecode: The timecode relative to the Timeline, as set in the Conform Options in 
the Master Project Settings of the Project Settings.

 > Record Frame Number: The number of frames from the first frame of the Timeline.

 > Source Timecode: Each clip’s individual timecode.

 > Record TC & Frame Num: Both metadata options combined in one line.

 > Source TC & Frame Num: Both metadata options combined in one line.

 > Source & Record TC: Both metadata options combined in one line.

 > Keycode: Also referred to as edge-code, the identification codes running along the edge 
of film stocks that provide an absolute reference for which digital frames correspond to 
which film frames.

 > Source File Name: The full file path, including file name, of the media file that’s linked to 
the current clip.

 > Record File Name: The file name as defined in the Render Settings list of the Deliver page.

 > Source Clip Name: The file name of the media file that’s linked to the current clip, without 
the file path.

 > Custom Text1: A line of text that you type into the Text field of the Custom Output 
parameters. You can use any characters you like.
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 > Custom Text2: A second line of text that you can customize.

 > Custom Text3: A third line of text that you can customize.

 > Logo1: Lets you superimpose a graphic over the image in a customizable location. 
Compatible graphics formats include PNG, TGA, TIF, BMP, and JPG. Alpha channels are 
supported for transparency in logos.

 > Logo2: Lets you superimpose a second graphic.

 > Logo3: Lets you superimpose a third graphic.

 > Reel Number: The currently defined reel number for the current clip.

 > Scene: Scene metadata, if it’s been written to the file by a camera, or entered into the 
Metadata Editor on the Media page.

 > Take: Take metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

 > Shot: Shot metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

 > Angle: Angle metadata, if it’s been written to the file by a camera, or entered into the 
Metadata Editor on the Media page.

 > Day: Day metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

 > Date: Date metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

 > Circled Take: Corresponds to Good Take metadata, if it’s been written to the file by a 
camera, or entered into the Metadata Editor on the Media page.

 > Camera: Corresponds to the Roll/Card metadata, if it’s been written to the file by a camera, 
or entered into the Metadata Editor on the Media page.

 > Roll/Card: Corresponds to the Roll/Card metadata, if it’s been written to the file by a 
camera, or entered into the Metadata Editor on the Media page.

Custom Output Options

The parameters in the Custom Output panel let you modify the look, position, and in some 
cases content, of the selected metadata item. Pan and Tilt are individually customizable for each  
metadata item.

You have the option of independently styling each item of metadata, depending on whether the 
Gang Render Text Styles option is checked in the Option pop-up. When turned on, all text metadata 
share the same font, size, color, background, justification, and opacity. When turned off, each item 
of metadata can have individual settings.
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Font: Defaults to Courier, but you can choose any font that’s installed on your system.

Size: Defaults to 48, but you can choose standard increments from 6 to 72.

Color: Defaults to white, but you can choose from a range of predefined colors in this 
pop–up menu.

Background: Defaults to black, although the apparent color is influenced by the Opacity 
setting. For a more garish look, you can choose from a range of predefined colors in this 
pop-up menu.

Justify Text: Defaults to Center. The only other option is Left.

Opacity: Defaults to 0.50. Lets you define the transparency of the burned-in metadata’s 
background color.

Pan: Lets you change the horizontal orientation of the current item of metadata. The default 
value is the center of the frame, relative to the current project’s frame size.

Tilt: Lets you change the vertical orientation of the current item of metadata. The first item 
of metadata is centered near the bottom of the frame, above Action Safe. Each subsequent 
item of metadata you turn on is automatically placed above the previous item of metadata, 
regardless of its order in the “Add to Video Output” list.

Show for first: Turning on this checkbox lets you specify a number of frames during which 
the current item of metadata will be displayed before dissolving away over one second. 
When enabled, the current item of metadata will cut onscreen with the beginning of each 
new clip, remain onscreen for the duration specified, and then dissolve away.

Show for last: Turning on this checkbox lets you specify a number of frames before the end 
of each clip during which the current item of metadata will appear onscreen after fading up 
over one second, before cutting away with the end of the clip.

Text: A text field that lets you enter custom text to display as one of three possible custom 
text items.

Logo: A field that displays the file path of any currently selected graphic that you’re displaying 
as one of the three possible Logo graphics. Compatible graphics formats include PNG, 
TGA, TIF, BMP, and JPG. Alpha channels are supported for transparency in logos.

Import File button: Lets you choose a graphics file to use as a logo.
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Node Editor Basics

By default, every clip has one node in the Node Editor that contains the first corrections you make 
to a clip. However, you also have the option of creating multiple nodes, where each node contains 
one or more corrections that affect the image.

Node Editor

The specific arrangement of nodes you create lets you exert precise control over the order of 
operations performed by your grade, which provides many advantages. This section covers different 
ways of creating, editing, and arranging node trees to harness the full power of DaVinci Resolve.

The Node Editor Interface

As you work within the Node Editor, you may find the need to zoom into or out of it to get a better 
look at the node tree, and to pan around the working area to deal with large collections of nodes.

To expand the size of the Node Editor’s working area:

 > Drag the border between the Node Editor and the Gallery to the left or right to make it 
wider or narrower.

 > Right-click anywhere within the Node Editor (except on a node) and choose Toggle Display 
Mode, which hides the Viewer and moves the Node Editor to the right of the Gallery, 
enlarging it considerably. Right-click and choose Toggle Display Node again to return to 
the default layout.

 > You can toggle Display mode using the DaVinci control surface by pressing SHIFT UP and 
the DISPLAY/CURSOR button above the fourth trackball on the Center panel.
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To zoom and pan within the Node Editor, do one of the following: 

 > Scroll up to zoom in, scroll down to zoom out.

 > Use the Node Editor’s zoom slider.

 > Click and drag the gray area of the Node Editor to pan around.

 > Right-click and choose Zoom In or Zoom Out.

 > Right-click and choose Zoom to Window to fit the node tree to the current size of the 
node graph.

 > Right-click and choose Original Size to return the node graph to the default size.

The Components of a Node Tree

Ambitious grades may require trees of multiple nodes to create the necessary effect. This section 
covers the mechanics of putting nodes together into the structures that are described in more 
detail later in this chapter.

Every serial and parallel node you add is a “corrector” node, which is capable of either primary 
or secondary correction, depending on whether or not you enable the Qualifier/Window/Matte 
controls. As a result, each Corrector node has two inputs and two outputs, which lets you separately 
manage the RGB image channel, and the Key channel. The Key channel can be used to define areas 
of isolation for image processing operations, or transparency for compositing.

A single node, the RGB and KEY inputs and outputs are clearly visible

Nodes are attached to one another via “connections,” seen as lines that connect one node to 
another. Image data flows from left to right, starting with the Source bar all the way at the left of 
the Node Editor, through each node in the tree, and ending at the Output bar at the right of the 
Node Editor.
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A simple serial arrangement of corrections

Here’s an explanation of the different components of a basic node tree, and how they fit together:

 > Source Bar: The source is the clip as processed by the Sizing and Source decode settings, 
ungraded. It’s represented by the gray bar to the center left of the node graph. The 
Source bar outputs RGB data, and is connected to the RGB input of the first node in your 
tree. You can connect the Source bar to more then one corrector node, creating multiple 
simultaneous streams of image processing that you can eventually recombine in different 
ways using the Parallel or Layer Mixer nodes.

 >Nodes: Each node in the node graph represents a collection of image processing 
operations that can be enabled or disabled separately from any other node in the graph. 
By separating operations into multiple nodes, you’re able to precisely control image 
processing operations to create many different corrections and effects. The RGB input and 
output of each node in the Node Editor must be connected for a grade to be enabled. 
Each node’s thumbnail image shows the state of the image at that particular stage of the 
grade, giving you a visual indication of what that node is doing.

 > RGB Inputs and Outputs: The yellow dots at the upper right and left of each node are used 
to connect the RGB image output from one node to the RGB input of the next node. For a 
Corrector node to have an effect, you must connect both its RGB Input and its RGB output 
to neighboring nodes in the tree.

 > Key Inputs and Outputs: The blue triangles at the bottom right and left of each node are 
used to route the key channel generated by a node’s Qualifier or Window controls, or 
imported via a Matte clip that you previously associated with a clip in the Media page. 
When you connect the Key output of one node to the Key input of another, you basically 
copy the first node’s key to the second node. You can also combine the Key outputs of 
multiple nodes in various ways using the Key Mixer node.
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Node Editor displaying parallel nodes

 >Output Bar: The RGB output of the last node in a tree must be connected to the Output 
bar, which “completes the circuit” of image processing, and passes that correction on 
to the next stage in the DaVinci Resolve image processing pipeline. If the output is not 
connected, the node tree has no effect on the clip. You can only connect one RGB output 
at a time to the Output bar.

 > Second Source Bar (for HDR): You can access the alternate highlight exposure of RED 
HDR media by exposing this optional second Source bar. For more information, see 
“Node Tree Structures.”

 > Alpha Output Bar: It’s possible to create regions of transparency for compositing directly 
in DaVinci Resolve by connecting a Key output to an optional Alpha Output bar. For more 
information, see later in this chapter, “Manipulating and Combining Keys.”

Selecting Nodes

The node that’s currently selected in the Node Editor is highlighted in orange, and is referred to 
as the current node. When you adjust any of the parameters or settings in the Color page, you’re 
adjusting parameters within the current node. You can only select one node at a time.

To select a node, making it the current node, do one of the following:

 > Double-click any node in the node graph.

 > Using the Transport panel of the DaVinci control surface, press the PREV NODE or 
NEXT NODE buttons.

 > Using the Transport panel of the DaVinci control surface, enter the number of the node you 
want to select using the keypad, and then press the SELECT NODE button.

When you select another clip in the Timeline, the default behavior is that the last node that was 
selected when you worked on that clip is the one that’s selected when you move to that clip again. 
However, a setting in the Project Settings window, “Switching clips,” lets you change this behavior. 
For more information on this option, see Chapter 3.
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Toggling Nodes On and Off

In the process of creating a node tree, it’s often useful to turn nodes off to disable their effect on 
your grade. It’s also useful to turn the entire node tree off and on in order to see “before and after” 
views of the current clip. Disabled nodes are not processed during rendering, and they remain 
disabled when you save that grade along with a still in the Gallery and then apply that grade to 
another shot.

To toggle individual nodes off and on:

 > Click the number of any node in the node graph to disable that node by itself. 

 > Select a node, and choose Nodes > Enable/Disable Current.

 > Press Control-D.

 >On the DaVinci control surface, press the Disable Current button (on the T-bar panel).

To turn every node off and on at once: 

 > Press Option-D to toggle all nodes off and on. 

 >On the DaVinci control surface, press SHIFT-DOWN and then the DISABLE CURRENT 
button (on the T-bar panel).

Important: When you turn every node off and then on again, every node is re-enabled, even nodes 
that had previously been individually disabled.

Resetting Nodes

If you’re dissatisfied with your current operations and want to start over, there are three ways you 
can reset nodes in the Node Editor. These are available as items in the Color menu, and buttons on 
the DaVinci control surface’s T-bar panel.

 > Reset Selected Node Grade: Resets the currently selected node, eliminating all keyframes, 
to the default parameter settings.

 > Reset Grades and Keep Nodes: Resets every node in the current node tree, without 
affecting the node tree’s structure; all nodes remain where they were. However, each node 
has been reset to the default parameter settings, and all keyframes have been eliminated.

 > Reset All grades and Nodes: Deletes every node and keyframe, and restores a single node 
set to the default parameter settings.
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Previewing and Restoring Node Trees

There are two other methods of quickly dealing with unwanted changes you’ve made to node trees, 
without needing to use undo.

 > Preview Memory: Lets you preview the effect of any saved grade on the current clip. To 
preview, choose Color > Preview Memory (Shift-Command-M), and then right-click any 
saved still in the Gallery (or Memory) and choose Add Correction. If you like the effect, 
then you can leave it be. If you don’t like the effect, then choosing Color > Preview Memory 
again reverts the clip to the original grade.

 >Original Memory: This command lets you quickly revert a clip’s grade to its original state 
when you first selected that clip. This is useful for getting immediately back to a clip’s original 
grade if you’ve made a series of changes that you then regret. Selecting another clip in the 
Timeline and then reselecting the clip you made changes to resets what is considered to 
be the current grade.

Editing Node Trees

There is no limit to the number of nodes you can create and connect to one another, and you can make 
as many or as few parameter adjustments as you like within each node. The following procedures 
describe the ways you can add nodes to the node graph as you build each grade’s node tree.

Adding Nodes

The simplest thing you can do to add to the complexity of a node tree is to add additional nodes, 
in order to add more adjustments to the current grade.

Basic methods of adding nodes to the tree:

 > To add a serial node after the currently selected node: Press Option-S key, choose Nodes 
> Add Serial from the menu, or press the ADD SERIAL button on the T-bar panel of the 
DaVinci Resolve control surface.

 > To append a serial node to the very end of the node tree: Press Option-A, choose Nodes 
> Append Node from the menu, or press the APPEND NODE button on the T-bar panel of 
the DaVinci Resolve control surface.

 > To add a serial node before the currently selected node: Press Option-Shift-S, or choose 
Nodes > Add Before Current, or press SHIFT DOWN and then ADD SERIAL on the T-bar 
panel of the DaVinci Resolve control surface.

 > To add nodes in parallel to the currently selected node: Press Option-P, choose Nodes > 
Add Parallel from the menu, or press the ADD PARALLEL button on the T-bar panel of the 
DaVinci Resolve control surface.

 > To layer nodes with the currently selected node: Press Option-L, choose Nodes > Add 
Layer from the menu, or press the ADD LAYER button on the T-bar panel of the DaVinci 
control surface.
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 > To add a disconnected node to the node graph: right-click anywhere within the node 
graph’s background, then choose Add Node > Corrector from the contextual menu. 
Disconnected nodes have no effect on a node tree until they’re connected.

Adding Nodes with Windows Turned On

There are also dedicated commands for adding serial nodes with Circular/Linear/Polygon/Curve 
windows automatically turned on, for convenience. 

To add a node to the tree with a Window automatically enabled:

Choose an item from the Nodes menu, or press the button on the T-bar panel of the DaVinci 
Resolve control surface that corresponds to the following:

 >Node + CPW: Circular Power Window (Shift-C)

 >Node + LPW: Linear Power Window (Shift-Q)

 >Node + PPW: Polygonal Power Window (Shift-G)

 >Node + PCW: Power Curve Window (Shift-B)

Whenever you add a node to a tree, it’s numbered consecutively to come after the next most recent 
node you’d added, regardless of the order in which it appears in the node tree. For example, if 
you’ve already added three nodes, and then you decide to add another node in between Nodes 1 
and 2, the new node will be Node 4, and the order of the nodes will be 1, 4, 2, and 3.

Labeling Nodes

Nodes can be labeled with up to 12 characters of text to identify a particular node’s function in your 
grade. This can make it easier to revise a grade months later. Node labels are also saved when you 
save a still, so labels can also make it easier to decipher a saved grade down the road.

To label a node:

1. Right click a node and choose Change Label.

2. Type a label into the Change Node Label dialog, and click OK.

 The label you entered appears above the node in the Node Editor.

Deleting Nodes

If there’s a node that you no longer need, you can choose to remove it completely from the node 
tree to remove its effect permanently.

To delete a node, do one of the following:

 > Select a node, then press the Forward-Delete key.

 > Right-click a node, and choose Delete Node.
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 > Using the DaVinci Resolve control surface, select any node, and press the DEL-CURRENT 
button (on the T-bar panel).

After you’ve deleted a node, the node to the left and right of the node you deleted are automatically 
connected so that the node tree is unbroken. Also, all the nodes in a tree are renumbered after the 
deletion of any node, so there’s no discontinuity in node order. For example, if you have three 
consecutively numbered nodes in a tree and you delete the second one, the node that was formerly 
number 3 is renumbered to be 2.

Disconnecting and Reconnecting Nodes

For a node tree to work, every node in the Node Editor must be connected into a working node 
tree, from the Source bar, through each node in the tree, to the Output bar. Any disconnected node 
will result in that clip’s grade being disabled. However, you may find the need to disconnect some 
parts of a node tree in order to reconnect them in different ways.

To disconnect two nodes:

 > Click a link to select it (selected links turn yellow), and then press the Forward-Delete key.

 > Right-click a link and choose Delete Link.

To connect two disconnected nodes:

 > Click-and-drag from the RGB or Key output of one node to the corresponding RGB or Key 
input of another, and when the dotted line turns solid, release the mouse button.

You can connect any node’s RGB or Key output to as many inputs as you want, but you can only have 
one connection going to a node’s input. The exception to this is a node with multiple inputs, designed 
to combine the output of multiple nodes. These include the Parallel, Mixer, and Key Mixer nodes.

To insert a disconnected node between two other nodes:

 >Drag a disconnected node onto the connection between any two other nodes in a node 
tree, and when a plus icon appears over the node you’re dragging, drop it to insert the node.

Rearranging Node Order

The order in which nodes are connected in your tree affects the result of a grade. For example, 
if you boost the highlights in the first node, and then you try to isolate a portion of the picture in 
a second node that you now realize has been clipped, you may to need to change your order of 
operations to optimize your corrections.

To reorder two or more nodes:

1. Delete every link that connects the nodes you want to rearrange.

2. Drag the nodes into the new order you want them in the node graph (it pays to be tidy), and 
then reconnect the RGB outputs and inputs until all nodes in your tree are reconnected in the 
order you want them.
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Keeping Node Trees Organized

It’s a good idea to keep the arrangement of your nodes in the node graph clean and neat. It’ll make 
it easier to read your tree if you need to revisit a grade later on, and it will also make it easier for other 
colorists working on the same project to figure out what you’re doing. The following procedures 
describe how to rearrange the nodes in your tree, and the node tree working area, to help you keep 
on top of your grades.

To move a node to another position in the grid:

 > Click a node with the pointer and drag it to a new position.

Another nice organizational feature of the Node Editor is an automatic tooltip that appears whenever 
you hover the pointer over a particular node, that shows you a concise list of all the operations 
applied to that particular node.

Copying Nodes and Node Settings

You may save time when assembling complicated node trees by recycling nodes or node settings 
from previous grades.

Copying Nodes From Other Clips

When constructing node trees, you may sometimes find it necessary to copy nodes from one clip’s 
grade to another. This can be accomplished by exposing the node tree of any still that’s saved in 
the Gallery, or any clip in the Thumbnail Timeline, and copying individual nodes from the exposed 
node tree to the Node Editor.

Hover over the node to see the tool tip
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To copy nodes from any still in the Gallery:

1. Right-click a still in the Gallery, and choose Display Node Graph. A Node Graph window 
appears displaying that still’s node tree.

2. Drag any node from the node tree directly over any connection line in the Node Editor. When 
a small plus icon appears over the corrector node icon you’re dragging, drop the node to 
insert it into that connection.

3. Click Exit when you’re finished.

To copy nodes from any clip in the Timeline:

1. Click the thumbnail in the Timeline of the clip to which you want to copy nodes.

2. Right-click the thumbnail of the clip you want to copy nodes from, and choose Display 
Node Graph.

 Note: The Display Node Graph command only appears in the contextual menu of a clip in the 
Thumbnail Timeline that is not currently selected.

3. Drag any node from the node tree directly over any connection line in the Node Editor. When 
a small plus icon appears over the corrector node icon you’re dragging, drop the node to 
insert it into that connection.

4. Click Exit when you’re finished.

Using this mechanism, you can also copy every node in the node tree using the Apply Color button, 
or copy just the Sizing (Pan/Tilt/Zoom/Rotate parameters) using the Apply Sizing button.

Copying Node Settings

You may also find yourself needing to copy one node’s settings to another node. In particular, this 
is the only way of copying tracking data or keyframes from one node to another, either within the 
same grade, or from one grade to another.

To copy a node’s settings to another node:

1. In the Node Editor, select the node with settings you want to copy, and choose Edit > Copy 
(Command-C).

2. Select the node you want to paste these settings to, and choose Edit > Paste (Command-V).
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There are several ways you can organize nodes in a tree. Each method lets you control a group of 
image processing operations in different ways to achieve specific results. This section covers how to 
use Serial nodes, Parallel nodes, and Layer nodes, as well as how to use LUTs, work with HDR media 
that lets you combine two different exposures using two different Source bars, and apply additional 
project-wide adjustments using the Track grade.

Serial Node Structures

The simplest, and most common node structure is a serial cascade of nodes, where a linear series 
of nodes is connected, one after another. 

Serial nodes, the output of one node goes into the next

Much of the time, this method of constructing a tree of multiple operations is all you need to do. It’s 
a simple and intuitive way of organizing your adjustments, similar in principle to the stacks of layers 
used in other grading and compositing applications to apply multiple operations to a clip.

Controlling What Feeds a Node’s RGB Input

When you create a grade using serially arranged nodes, each node’s output is used as the next 
node’s input, so the order in which the nodes are arranged determines the order of image 
processing operations. 

In the following screenshot, the node tree at the left shows a series of three operations that are 
applied to a log-exposed, low-contrast clip. The first node expands clip contrast and increases 
saturation. The second node isolates the face and adds targeted warmth. The third cools the overall 
color temperature. At right, you can see the result of this node tree.

Node two pulls a clean key from the image data fed it by node one

Node Tree Structures
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If, instead, we reversed the order of Nodes 2 and 3, the result will be different.

Because the secondary operation is sampling the cooled down image, rather than the source, the 

HSL Qualifier’s key is thrown off.

Parallel Node Structures

Another way to organize your corrections is to use a Parallel node structure, which lets you apply two or 
more overlapping adjustments at a single stage of a node tree. You can use the Parallel node structure 
for organizational reasons when there is a group of secondary corrections that you want to apply all at 
once. You can also use this structure for the unique way it blends overlapping image adjustments.

The Parallel Mixer node that makes this possible has multiple RGB inputs and a single RGB output. This 
lets the Parallel Mixer mix together multiple Corrector nodes, outputting a single image as a result.

When you add a Parallel node to an existing node, DaVinci Resolve automatically adds one Corrector 
node below the current node, and adds a Parallel Mixer node to its output.

Adding a serial node to follow node 1

Adding a Parallel node to Node 2 automatically adds the Parallel Mixer
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Tip: If you want to create a series of Parallel nodes that connect to the output of the currently 
selected node, create a Serial node before you create your first Parallel node.

If you’re manually connecting another node to a Parallel Mixer node, you must first create an 
additional input to connect it to.

To create an additional, unconnected input on a Parallel Mixer node:

 > Right-click a Parallel Mixer node and choose Add One Input.

Ordinarily, the RGB input of every Corrector node that’s connected to a Parallel node is connected 
to the output of the same node. This results in a stack of nodes that take the same state of the 
image as their input. This makes it easy to apply multiple secondary operations without worrying 
about whether or not a change to one will affect the keys of the others.

Further Parallel nodes can be added as you wish with each using a common source

If you add another node in parallel, the Parallel Mixer automatically adds another input. You can 
have as many nodes in parallel as you need. 
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The adjustments made by all nodes that are connected to a Parallel Mixer are combined equally, 
regardless of which nodes are highest. In the following example, a separate overlapping Window is 
applied by each of three nodes in parallel.

As you can see in the image at right, the three tints created by the overlapping Windows are all mixed 
together equally; the colors blend with one another as if they are optically mixed. Most of the time, 
this is exactly what you want when you’re blending overlapping naturalistic color adjustments.

Converting Parallel Mixers to Layer Mixers

On the other hand, if you need your overlapping color adjustments to have priority over one another, 
or if you want to combine multiple adjustments using composite modes, then you may want to use 
the Layer Mixer node instead. If you’ve created a Parallel Mixer structure and you want to convert it 
to a Layer Mixer, you can.

To change a Parallel Mixer node into a Layer Mixer node:

 > Right-click a Parallel Mixer node and choose Morph Into Layer Mixer Node.

Layer Mixer Node Structures

The Layer Mixer is structurally quite similar to the layout used by the Parallel Mixer. However, there 
are two key differences. First, the Layer Mixer node combines multiple adjustments with priority 
given to the image adjustment in the lowest overlapping node input. Second, you have the option 
of combining all of the Corrector nodes that are connected to a Layer Mixer using one of several 
different composite modes, to create a wide variety of visual effects.

Because of their similarities, layering nodes with the Layer Mixer works in much the same way as 
creating a Parallel node structure.

The top two images show the parallel mixer in operation
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Layer Mixer Prioritization

In the following example, the same node structure from the Parallel Mixer example is shown, this 
time with the three overlapping color adjustments mixed together using the Layer Mixer.

Now, instead of the three adjusted color tints being blended, you can see that the green tint, which 
is connected to the lowest input of the Layer Mixer, is dominant and covers the overlapping regions 
of the two other adjustments. Meanwhile, the blue tint, which is connected to the middle input 
of the Layer Mixer, covers the overlapping portion of the orange tint, which is connected to the 
highest input of the Layer Mixer.

Rearranging which connections are attached to which Layer Mixer inputs changes each node’s 
priority, and like the Parallel Mixer, you can add more inputs if you need to connect more nodes 
manually.

The Layer Mixer’s prioritization is most useful when you have an overlapping adjustment that you 
need to override any other adjustments happening on that stack. In the following example, two 
nodes are connected to the Layer Mixer node. Node 2 is applying a high-contrast, cool look to the 
entire clip. Node 3 isolates the skin tone, which is unflattering with the background stylization, and 
applies a different, more naturalistic adjustment.

The Layer mixer places a higher priority to subsequently added nodes
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Using the layer mixer, grades on Node 3 will have a greater priority over node 2

The final grade combines the high contrast from node two with the adjusted skin tone from node three

Because of the Layer Mixer’s prioritization, the adjustment made to the woman’s skin tone 
completely covers the adjustment made to the node that comes above it, providing the best of 
both worlds with one simple adjustment.

Tip: If you want to “solo” overlapping nodes that are connected to the Layer Mixer to see their 
individual adjustment, turn on Highlight (Shift-H, or the HILITE button on the Transport panel of the 
DaVinci control surface). This lets you view just that node’s effect, regardless of what other nodes 
adjustments are overlapping.
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Using Composite Modes With the Layer Mixer

You have the option of combining the adjustments made by all nodes connected to a Layer Mixer 
node using the same Composite modes that are available when compositing clips in the Timeline. 
This lets you combine different overlapping image adjustments using compositing math to achieve 
creative effects or utilitarian fixes.

The following simple example shows two overlapping Corrector nodes connected to a Layer 
Mixer node that’s set to the Add composite mode. Node 2 has no adjustment, but Node 4 has an 
extremely high-contrast curve adjustment applied, along with a push to orange in the highlights 
and a blur, that effectively isolates the highlights of the image and fires them up.

Combining two nodes using the Layer Mixer set to Add to create a glowing effect

By adding both treatments together, a hot glow has been created, blowing out the highlights of 
the image. Many, many other effects are possible using the different composite modes that are 
available. For more information on composite modes, see Chapter 4, “Editing and Audio Syncing.”
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Adjusting Layer Node Strength Using Key Output Gain

Whether you’re combining overlapping corrections, or mixing different adjustments using 
Composite modes, you’ll run into situations where you want to reduce the influence of one 
overlapping adjustment relative to the other nodes that are connected to the Layer Mixer node. 
This can be accomplished using each overlapping node’s Key Output Gain parameter, located in 
the Key palette.

Using the Output Gain parameter in the Key palette

Key Output Gain defaults to 1.00, but lowering this value reduces the strength of that node’s 
contribution to the Layer Mixer. Using the previous example, selecting Node 4 (the high-contrast 
image used to create the glow), opening the Key palette, and reducing the Key Output Gain 
parameter to 0.50 reduces the intensity of the glow effect by half.

The highlight glow is softened and your focus is back to the talent

You can use Key Output Gain to mix the proportion of any number of overlapping adjustments in 
order to create the perfect combination for your purposes.

Tip: You can also use the Key Output Gain parameter to mix the proportion of adjustments being 
combined using the Parallel Mixer node.
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Converting Layer Mixers to Parallel Mixers

You can easily convert a Layer Mixer to a Parallel Mixer should you discover that you need to mix 
your overlapping corrections evenly rather then combine them with priority. Keep in mind that you’ll 
lose the ability to use Composite modes.

To change a Layer Mixer node into a Parallel Mixer node:

 > Right-click a Parallel Mixer node and choose Morph Into Parallel Node.

Applying a LUT Within a Node

Look up tables (LUTs) are frequently used to create a starting point adjustment for media acquired 
with some sort of logarithmic (log) exposure. DPX log film scans, digital media using the ARRI 
ALEXA’s Log-C encoding, Sony’s S-Log exposure setting, or RED R3D media that is debayered using 
the REDFilmLog setting are all examples of media using a logarithmic exposure curve, designed 
to protect as much detail in the highlights and shadows of a digitally encoded image as possible. 
While log-encoded media retains a lot of image data, the picture is initially flat and unsuitable for 
use without grading. The exposure and color must be adjusted to “linearize” the media, making it 
look the way it’s supposed to, in order to start grading. You can do this manually, or, as a shortcut, 
you can use a LUT that’s tailored to your type of media and the exposures you’re using.

LUTs are also commonly used in onset workflows where dailies are managed with corresponding 
LUTs. These LUTs were used to monitor the media as it was being recorded, and define a baseline 
reference for how each scene is meant to look, at least so far as field monitoring is concerned.

In either instance, LUTs, when used in this way, are adjustments that are applied to affect the look 
of a clip, in much the same way as you’d make adjustments using any of the contrast or color 
controls in the Color page. While there’s an entire group of LUT controls in the Look Up Tables 
section of the Project Settings, those are designed to apply LUTs, in different parts of the image 
processing pipeline, to the entire timeline. This is useful when you want to apply a single color and 
contrast transformation to the entire program at once, but less so if you want to apply different 
LUTs on a per clip basis. (For more information on using the Look Up Table settings, see Chapter 2, 
“Project  Settings.”)

DaVinci Resolve lets you apply LUTs within a grade by connecting a LUT to a particular node in the 
Node Editor. 

To apply a LUT within a node:

 > Right-click any node, and choose a LUT from the 1D Input LUT, 1D Output LUT, or 3D LUT 
submenus.

LUTs that you apply using the 3D LUT or 1D Output LUT submenus impose their transformation after all 
other Color page adjustments applied by that node. This means that you can use Color and Contrast 
controls to trim whatever effect the selected node’s LUT is having on the image. For example, if the 
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contrast adjustment made by an applied LUT clips the highlights of the image too much, you can use 
that node’s Contrast controls to lower the highlights, restoring detail to the image.

The LUT submenus list whichever LUTs have been installed on your workstation. For more information 
on installing LUTs, see Chapter 2.

RED HDR Input Support

The RED EPIC and SCARLET cameras are capable of shooting in an HDR mode that effectively 
“brackets” two different exposures of each frame. The resulting image data stores two channels 
of image data: the regular exposure, and a “highlight exposure” that’s underexposed by a user-
selectable margin (+3, +4, +5, or +6 ƒ-stops difference).

By default, the Input bar in the node graph feeds the regular exposure to your grade’s node tree. 
To take advantage of the additional “highlight” exposure, you can add an additional Source input 
to the node graph that feeds a second stream of image data that you can mix with the regular 
exposure in different ways.

Note: You can also take advantage of the highlight exposure of RED HDR media by enabling and 
adjusting the Magic Motion controls in the Camera Raw palette.

To set up a node tree combining the normal and highlight HDR versions:

1. Using the first default node (Node 1), grade the image to see if you even need to use the 
alternate exposure that’s available. We’ll assume for this example that you do. In this example, 
the sky of the default exposure is pretty blown out, but there may be detail that can be 
retrieved using the highlight exposure.

Using HDRx images with the Layer Mixer
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2. Create a Layer Mixer node by choosing Nodes > Add Layer (Shift-L), or press the ADD LAYER 
button of your control surface.

 Two nodes are created, a Layer Mixer node that’s added after Node 1, and a third node (Node 3) 
that’s connected to a second RGB input of the Layer Mixer node in parallel to Node 1.

The Source currently supplies two input, but you can add a second source which is the short exposure in the HDR image

3. Right-click anywhere within the node graph (except on a node) and choose Add Source from 
the contextual menu.

 A second Source bar appears underneath the first, which outputs the highlight exposure of 
the image as a separate image stream.

A node tree that uses a Layer Mixer node to mix two Corrector nodes,  

each connected to separate outputs for the regular and highlight exposures.

4. Delete the connection between the top Source bar and Node 3, and then connect the bottom 
Source bar to the RGB input of Node 3.
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 Immediately, the image in the node thumbnail and Viewer updates to show the darker, 
underexposed version of the HDR image. This is because, by default, the Layer Mixer is mixing 
100% of Node 3 over Node 1.

5. Select Node 3 and use one of the following two procedures to create a useful combination of 
the two exposures:

 >  To create a mix of the two exposures, open the Key tab, and drag the Post Mixing Gain 
slider to the left to lower the contribution of Node 3 to the overall image (you can also 
do this using the DaVinci control panel by pressing the KEY MODE soft button, and then 
using the Post Mix Gain rotary control). Using dynamics (keyframing), this is a good way 
to animate a dissolve from the regular exposure to the highlight exposure if you’re going 
from a dark environment to a bright environment in the same take and you want to create 
a smooth transition between both exposures.

Dissolving between the regular and highlight exposures of RED HDR media using the  

Post Mixing Gain slider of a Corrector node connected to a Layer Mixer node.

Tip: You can also use the Blend Type and Blend Bias parameters in the Camera Raw palette to blend 
the two exposures without building a dedicated node tree.

 > To use the highlight exposure to selectively put detail back into the image (for example, to 
retrieve blown-out windows), use a Power Window, HSL Qualification, or a combination of 
the two to isolate the region you want to retrieve in Node 3. (Be careful if you’re using HSL 
Qualification to combine both exposures, as keyed edges can be tricky to blend.)

Isolating a region of the image to replace using the highlight exposure image of a RED HDR clip
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Final node display with isolations

A Note About RED HDR Media and Performance

Since RED HDR media records two complete streams of image data, DaVinci Resolve must 
simultaneously decode two separate tracks whenever you add a second Source bar. (If you don’t 
add the second Source bar, only the first stream is decoded.)

Because of this, whether you’re relying on your computer’s CPU to decode RED media, or you’re 
using a single RED ROCKET card, you’ll get half the performance when using the highlight stream 
of an HDR clip. 

To improve performance, you can set any RED HDR clip’s Render Cache Mode to “User” by choosing 
Color > Render Cache Mode, pressing Option-R, or pressing the CACHE MODE button on the T-bar 
panel of your control surface repeatedly until you toggle to User mode. DaVinci Resolve renders all 
cached clips in the background, so the next time you play a cached clip, it will play at full speed.

If you regularly use RED HDR media, two RED ROCKET cards are recommended for optimal 
decoding performance.
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Clip vs. Track Grading

The Node Editor has two modes. The default Clip mode lets you create individual grades for each 
clip or group in the Timeline. However, the Track mode lets you apply a single grade simultaneously 
to every clip in the Timeline. 

A paragon of sophisticated grading, the author applies an edge vignette to every clip in the project simultaneously  

using the Track grade.

There are a variety of reasons you might want to do this. For example, if you’re working on 
a commercial spot, you might elect to use Clip grades to do general correcting and scene-to-
scene balancing, and then use the Track grade to apply a single stylistic grade to the entire spot 
simultaneously. That way, any changes the client wants made to the style of the grade can be 
instantly applied to the whole spot.

Another example would be using the Track grade to apply corrections meant to address QC issues 
running throughout a program, desaturating highlights or selectively darkening a specific shade of 
red wherever it appears.

To switch between Clip and Track grading modes:

 > Choose the mode from the pop-up menu at the top right of the Node Editor.

Selecting Track mode in the Node Editor

Note: When you reset the Track grade using the Color > Reset All Grades and Nodes command, 
the Output Sizing parameters are reset as well.

Track Grades and Saved Stills

When you save a Gallery still, the Clip and Track grades are both saved. However, when you apply a 
grade from that still, you only apply either the Clip grade, or the Track grade, depending on which 
mode the Node Editor is in. For more information on saving and applying grades, see Chapter 7, 
“Copying and Managing Grades.”
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Each node’s key input and key output makes it possible to route key channel data from one node 
to another so you can apply isolated corrections. Furthermore, the Key Mixer lets you combine 
a variety of keys from different nodes to create more detailed keys with which to tackle complex 
operations. This section covers all the ways you can recombine key data, as well as how keys can 
be used in conjunction with the Alpha Output bar to create regions of transparency in a clip for 
compositing right within DaVinci Resolve.

Outside Nodes

Whenever you use a Power Window or HSL Qualifier to limit a correction within one node, a special 
node structure lets you automatically create a second node, called an Outside node, to apply 
additional adjustments to the inverse of the region you isolated in the previous node. Outside 
nodes make it easy to apply separate corrections to an isolated subject and its surroundings. 

In the following example, a woman’s face has been isolated using HSL Qualification, and an Outside 
node has been added to make an additional correction to everything else within the shot.

The outside node automatically has its key input inverted

To add an Outside node to a node, creating a secondary correction:

1. Select a node that has been limited using a Power Window or HSL Qualifier.

2. Do one of the following:

 > Choose Nodes > Add Outside

 > Press Shift-O

 > Press the ADD OUTSIDE button on the T-bar panel of the DaVinci control surface.

 A new node is created immediately after the selected node, with the RGB and key outputs of 
the first node automatically connected to those of the new node. 

When selecting the new node and opening the Key palette, you can see that the key input’s Invert 
control is on by default, which is what inverts the key from the previous node.

Manipulating and Combining Keys
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The Key Input’s Invert control is on by default for each node

If, instead of inverting the incoming key, you want to copy the existing key in order to perform 
another operation to the same isolated region, you can disable the key input’s Invert control.

Feeding Keys From One Node to Another

One of the most powerful aspects of the Node Editor is the ability to create keys based on a specific 
part of the node tree, and feed the result into a completely different correction somewhere else in 
the node tree. This is one of the reasons for the separate key input and output on every Corrector 
node.

The key that’s created whenever you use the HSL Qualifier, create one or more Windows, or use 
an external matte can be output from one node’s key output and fed to the key input of any other 
node in a tree. There are many reasons to do this, but the following example shows a common 
problem you can solve with this technique.

Using a key from one node to make an adjustment with a different node:

1. Use Node 1 to apply a basic primary correction, increasing contrast and balancing the color to 
achieve a pleasing ambient color temperature. 

2. Add a Serial node (Node 2), and stylize the correction by desaturating the image to create 
muted color.

 We have the pale color we were after, but the hands in the resulting image are too 
monochromatic, and you want to give them some differentiation. Simply adding another node 
and keying the skin tone to adjust to it won’t work because the low level of saturation will make 
a key difficult to pull. 

Serial nodes with a desat image

3. Right-click in the gray area of the Node Editor, and choose Add Node > Corrector to create 
an unattached node, Node 3, then do this again to create Node 4.



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

581

4. Drag Node 4 onto the connection between Node 2 and the output bar, then attach the RGB 
output from Node 1 to the RGB input of Node 3, and the key output from Node 3 to the key 
input of Node 4.

5. Use the HSL Qualifier in Node 3 to pull a good strong key based on the primary image. 
Given the way the node tree is now set up, that key is fed to Node 4, and will limit whatever 
adjustments you make. 

Adding another node but just connecting the key from node 3 to 4

 So now things are almost ready for an adjustment to be made to the hands, however the same 
automatic setting that makes it easy to create Outside nodes is inverting the key that Node 3 
is feeding to Node 4, which is the opposite of what is needed.

6. Select Node 4, open the Key palette, and click the Key Input Invert control so that Node 4’s key 
is identical to Node 3’s key.

Using the Key palette to control the key levels

7. Now, you can make your adjustment to Node 4’s grade, to increase the saturation of the 
hands. The background remains nicely desaturated, while the hands have the richer color we 
need for the shot.
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This example could have been handled in a variety of different ways, but the point is that you can add 
nodes that connect to the state of the image at any part of a node tree, and use them to generate 
keys to feed to any other node, regardless of what’s happening to the picture in between.

Using External Mattes

The External Matte node has evolved over the years. What was once purely a means for importing 
matte channels for defining opacity and limiting adjustments has expanded to become a way to 
import the RGB channels of a media file to be used for overlaying grain, texture, and stylized distress 
onto an image, and even as a way to use the channels of a clip itself as a matte.

Matte clips are added to your project in the Media page. You can add them by attaching them to a 
clip, so a particular matte is only available to a particular clip as part of a Clip Grade, or you can add 
unattached mattes that stand alone in the Media Pool, which are then available to any Track Grade. 
For more information about adding Matte clips in the Media page, see “Adding and Removing 
External Mattes” in Chapter 3, “Media Page.”

Adding another node but just connecting the key from Node 3 to 4
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Whether attached or unattached, mattes operate within a grade using EXT MATTE (external matte) 
nodes. EXT MATTE nodes have the following outputs: 

An external matte connected to the first node of a grade

 > RGBY Outputs: Four blue triangular key outputs let you output the Red, Green, Blue, and 
Luma channels of a matte clip as a key that you can attach to any other node’s key input. 
An interesting aspect of these four outputs is that each one is dedicated to individual R, 
G, B, and Y color channels. Ordinarily, External Matte clips are written with the matte data 
written simultaneously to all three RGB channels. However, you could also render separate 
mattes to each color channel, so that the Red channel has one matte, the Green channel 
another, and the Blue channels still another, thereby exporting three separate mattes within 
a single media file, for convenience. You can then use each one of these mattes individually 
by connecting the correct output of the Ext Matte node.

 > RGB Output: A round orange RGB output lets you connect the RGB image data of a matte 
clip to any other clip’s RGB input. This is especially useful when you’re combining a matte clip 
with the current clip using a Layer Mixer node, to create a textured composite of some kind.
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External Mattes to Limit Adjustments

Going back to the External Matte node’s original use, mattes are typically grayscale media files that 
represent image opacity, and are meant to be used either as alpha channels for creating opacity 
within a corresponding RGB clip, or as a matte for limiting effects. 

An example of a matte channel would be the key created by a green screen keyer. If you output just 
the key, that would be an external matte. If you receive an external matte along with an effects clip, 
you can attach the matte to its corresponding RGB clip in the Media page. Then, you can access 
that matte via an External Matte node in the Node Editor, so you can use the key it outputs to limit 
different kinds of corrections you want to apply. 

In the following example, the keyed matte of a green screen composite clip is used to apply different 
corrections to the inside and outside of a keyed composite, in order to make the subject match the 
background more convincingly.

A matte attached to clip 0016OA-2.mov, as seen in the Media Pool

To use an attached matte to limit an adjustment within a Clip Grade:

1. Right-click any node, and choose the attached matte you want to use from the Add Matte 
submenu of the contextual menu. 

2. Connect one of the EXT MATTE node’s triangular key outputs to the key input of a node you 
want it to limit.

Node Editor displaying the influence of the external matte on multiple nodes when the keys are linked 
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3. If necessary, use the Key palette controls to modify the incoming key, inverting or blurring it as 
necessary to create the isolation you need.

Before - An uncorrected composite.  

After - The external matte is used to apply separate grades to the foreground and background to match 

 Ideally, external mattes are exported so that they match the size and duration of the RGB clip 
they’re supposed to accompany. If they don’t match or if you’re using some other grayscale 
clip as an external matte to create some sort of effect, then there are parameters in the Key 
palette that you can use to retime or transform a matte so it works better in your grade.

To slip the sync of a matte relative to the clip it’s attached to:

1. Select the Ext Matte node you want to slip.

2. Open the Key palette, and raise or lower the Offset parameter until the matte is perfectly 
aligned with the clip it’s supposed to match.
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To transform a matte:

1. Select the Ext Matte you want to transform.

2. Open the Key palette, and turn off the Lock Matte checkbox.

3. Use the Pan, Tilt, Zoom, Rotate, Width, Height, HFlip, or VFlip parameters to adjust the matte 
so it has the correct geometry.

It’s worth mentioning that you can attach as many external mattes to a single clip in DaVinci Resolve 
as you like. For example, if a CGI shot has been delivered with a set of isolation mattes for each of 
three characters in the scene, you can import all three mattes and use them to isolate adjustments 
that you want to make in the Node Editor. 

External Mattes to Add Texture

You can also use external mattes as creative tools, to add grain and texture. For example, you might 
use a more abstract animated matte, or a grayscale film scan of dirt and dust, to apply correction 
for effect.

Light leak and dirt and dust images From Warren Eagles’ Scratch FX collection (FXPHD), designed to add texture to your grades

Once attached to a clip, external mattes can be exposed in the Node Editor, and their key output 
can be used just like any other key in a node tree. 

To use an attached matte to create texture a Clip or Track Grade:

1. For a Clip Grade, right-click any node, and choose the attached matte you want to use  
from the Add Matte submenu of the contextual menu. For a Track Grade, right-click any 
node, and choose either an attached or unattached matte in the Media Pool from the Add 
Matte submenu. 

2. Add a Layer Mixer to the end of the node tree.

3. Disconnect the bottom corrector node’s RGB input, and then connect it to the EXT MATTE 
node’s round RGB output.
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A node tree set up to feed an external matte’s RGB output to the input of a node connected to a Layer Mixer,  

in order to blend it with the grade using composite modes

4. Right-click the Layer Mixer node, and choose Overlay from the Composite Mode submenu to 
blend the Ext Matte node most effectively with the grade.

5. If necessary, you can use the grading controls of the corrector node you’ve attached the EXT 
MATTE node to change the characteristics of the texture clip, desaturating it for instance. You 
can also select the EXT MATTE node itself and use the Transform, Offset, Loop, or Freeze 
controls described later to change how the matte appears.

The resulting texture effect, graded for a warm orange look, blended with the grade using the Screen composite mode

 Tip: If you want the texture you create to be unaffected by blur operations within the grade, be 
sure to add it to the very end of the node tree
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External Mattes to Create Transparency

You can also use an EXT MATTE node to create transparency in a clip, for compositing with clips 
underneath it on the timeline.

To use an attached matte to create transparency in a clip:

1. Right-click any node, and choose the attached matte you want to use from the Add Matte 
submenu of the contextual menu.

 Adding an EXT MATTE node to a Clip Grade applies the effect to only that clip, whereas 
adding an EXT MATTE node to a Track Grade applies the effect to the entire timeline.

2. Right-click any empty area of the Node Editor, and choose Add Alpha Output to reveal the 
output bar on the right that lets you assign a key to be used to define clip transparency.

The node setup for using an external matte to composite two layer

4. Connect one of the EXT MATTE node’s triangular key outputs to the Alpha Output bar at the 
right of the Node Editor.

 The areas of the matte defined by the key are now rendered transparent.

The final composite created using the external matte node 
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Key Palette Controls for the External Matte Node

When you select an EXT MATTE node, the Key palette displays different parameters only for mattes.

Key Palette

 > Transform: Standard Pan, Tilt, Zoom, Rotate, Width, and Height parameters let you 
transform a matte to fit the image better.

 > Flip Image: Two buttons let you flip the matte clip horizontally or vertically.

 >Offset: Adjust this parameter to offset the start point of a matte clip.

 > Lock Matte: When turned on, locks the sizing of a matte to whatever changes are made to 
the Input Sizing of that clip, so the matte transforms to follow the clip.

 > Loop: Turning on this checkbox enables matte clips to loop endlessly, which lets shorter 
matte clips cover longer durations.

 > Freeze: Turning on this checkbox freezes the matte clip on a single frame. Adjust the Offset 
parameter to choose which frame to freeze on.

You can also use external mattes as creative tools. For example, you might use a more abstract 
animated matte, or a grayscale film scan of dirt and dust, to apply correction for effect.
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Using the Key Mixer

The Key Mixer node lets you mix keys output from multiple Corrector nodes, combining them in 
different ways to create a single key output. This makes it possible to build much more intricate 
keys than you can with a single Qualifier or set of four Windows. In particular, the Key Mixer node is 
the only way to combine multiple keys made using Qualifiers and Windows, adding, subtracting, or 
intersecting them to create a highly specific result.

In the following example, you’ll learn how to set up a Key Mixer to combine the keys output by 
two Corrector nodes in a node tree. Then you’ll learn how to change the way the input keys are 
combined using the Key palette.

To combine two or more keys using the Key Mixer:

1. Right-click anywhere on the gray area of the Node Editor, and choose Add Node > Key Mixer.

2. Create two Corrector nodes, then attach their RGB inputs to the RGB output from an 
appropriate node in the main part of the tree, and attach their key outputs to the key inputs of 
the Key Mixer.

3. Next, attach the key output of the Key Mixer node to the key input of the node you want to 
use to make the correction. Remember, the objective is to use the key that’s output by the Key 
Mixer to limit the adjustment being made using another node, in this case Node 5.

Setting up the node tree you’ll need to combine keys

 Keep in mind, especially since this is a significant reordering of nodes in the Node Editor, that 
every node needs to be connected properly for the overall grade to work.
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4. Now that the node structure is fully connected, use Windows, Qualifiers, or both to create keys 
in each of the nodes that you connected to the Key Mixer. In this example, Node 2 is isolating 
the main skin tone, and Node 3 is isolating the blue of his jeans.

 By default, all keys connected to the Key Mixer are added together, as you can see in the Key 
Mixer’s thumbnail. However, you can use the controls in the Key palette to change this, in 
order to isolate the intersection of two keys, or to subtract one key from another.

Combining multiple keys with the Key Mixer

5. To reveal the controls you’ll use to change how the key from Node 2 interacts with the key from 
Node 3, double-click the Key Mixer to select it, then click the line connecting Node 2 to the 
Key Mixer to select that input. Then, open the Key palette.

The connection from node 2 to the Key Mixer is selected
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 When you select the Key Mixer and open the Key palette, the Input Link parameters are labeled 
with the number of the connection line that you’ve selected. In this case, you’ve selected the 
connection for the Key Mixer’s second input, so the Key tab parameters are labeled INPUT 
LINK 1. In addition to adding keys together, you can also create the following interactions.

6. To limit the output key to the intersection of the keys in Node 2 and Node 3, turn the Key Input 
Matte button off.

7. To subtract the key in Node 3 from the key in Node 2, turn both the Key Input Matte button 
and the Key Input Invert button off.

8. Continuing with the current setup, selecting Node 5 and dropping the saturation to be very 
faint stylizes the entire background, while leaving the various hues of the man we’ve isolated 
alone.

As shown in the previous example, the way multiple keys are combined within the Key Mixer 
depends on the Key Input settings you select using the Key palette. Here is a concise explanation 
of how this works.

To change the Key Input settings for a node connected to a Key Mixer:

1. Double-click the Key Mixer to select it, and then click once on the line connecting the node 
you want to affect to the Key Mixer input to select it too.

2. Open the Key palette; the Input controls should be labeled with the number of the input 
attached to the selected connection.

3. Use the Key Input Invert and Matte buttons to control how that key interacts with the others in 
the Key Mixer.

 > To subtract the selected key from the other key: Turn off the Key Input Matte button.

 > To limit the output to the intersection of both keys: Turn off both the Key Input Matte 
button and the Key Input Invert button.

New Key Mixer nodes have two key inputs by default. If necessary, additional inputs can be added 
in order to combine even more keys with one another.

To add inputs to the Key Mixer:

 > Right-click a Key Mixer node, and choose Add One Input.

When combining three or more keys, the interaction of keys using the Key palette controls becomes 
even more complex, but the rules outlined above still apply.
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Final grade, the talent in color with a B&W background

Using the Key Palette

The Key palette contains parameters and controls that you can use to modify key channel data 
being fed into or routed out of the currently selected node. 

For example, the Key Input Invert control is always enabled, which is why the Outside node works 
automatically. Clicking this control results in keys that are fed into that node exactly mirroring the 
original key.

The controls that are available in the Key palette vary depending on what kind of node you have 
selected:

 > Corrector Nodes: Have three sets of parameters. Key Input parameters let you make 
adjustments to keys being fed through a node’s Key Input connection. Qualifier parameters 
let you make adjustments to the internal key created with the HSL Qualifier or Window 
controls. Finally, the Key Output parameters let you make adjustments to the key data 
being output by a node’s Key Output connection, and includes the incredibly powerful 
Offset Gain parameter that governs the strength of that node’s contribution to the overall 
grade. This functionality is covered more extensively in the next section.

 > Ext Mattes: Have two sets of parameters. Transform parameters let you make geometric 
transformations to a matte so it fits the clip it’s being applied to better. An Offset control 
lets you slip the sync between an external matte and the clip to which it’s applied. This 
functionality is covered in the section on External Mattes.
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 > Key Mixer Nodes: Have two sets of parameters that are dependent on which of the 
connections attached to a Key Mixer’s key inputs is selected. Input parameters let you 
adjust how much of a contribution a key makes to the total key mix, and whether the 
contribution is additive or subtractive.

Key palette shows controls that correspond to a selected corrector node

The Output parameters let you adjust the inversion and strength of the key that’s output 
by the Key Mixer. This functionality is described more extensively in the Key Mixer section.

Layer Mixer and Parallel Mixer nodes have no adjustable controls in the Key palette.

Corrector Node Key Input Controls
 > Input Invert: Inverts the key being fed into the key input. On by default, which is why Outside 
nodes work to automatically adjust everything outside of the secondary operation taking 
place in the node before.

 > Input Matte: Lets you switch the key input between Matte and Mask modes. In Matte mode 
(on by default) the key input combines via intersection with keys generated internally using the 
Qualifier or Windows palette. In Mask mode, the key input is added to the internal key instead.

 >Gain: Controls the strength of the key connected to the key input.

 >Offset: Controls the contrast of the key connected to the key input.

 > Blur Radius: Blurs the key connected to the key input

 > Blur H/V Ratio: Alters the horizontal/vertical ratio of the blur that’s being applied to the  
key input.
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Qualifier Controls
 >Qualifier invert: Inverts the key created by that node’s Qualifier palette.

 >Qualifier matte: Lets you switch the interaction of the keys generated by the Qualifier 
and Window palettes between Matte and Mask modes. In Matte mode (the default), the 
Qualifier and Windows palettes combine via intersection. In Mask mode, they’re added 
together instead.

 >Gain: Lets you raise or lower the strength of the key generated by the Qualifier palette.

 >Offset: Lets you adjust the contrast of the key generated by the Qualifier palette.

Key Output Controls
 >Output invert: Inverts the overall key.

 >Gain: Using the key output, this parameter governs the strength of that node’s contribution 
to the overall grade. Setting Gain to 0 results in that node having no effect at all, while the 
default setting of 1.00 applies the full strength of any adjustments made with that node. 
The maximum setting of 2.00 increases the intensity of any part of the key output that’s less 
than 100 percent white. You can also use this parameter to keyframe the key output to fade 
that node’s contribution in or out with one set of keyframes.

 >Offset: Lets you adjust the contrast of the Output key. This has no effect if the entire key is 
100 percent white (a solid key).
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The Many Uses of Key Output Gain

Several of the techniques discussed in here and in “Secondary Qualifiers,” can be further customized 
using the Key Output Gain parameter, which makes it easy to control the strength of a node’s effect 
on your grade with a single adjustment. In the following example, two simple Serial nodes are 
applied to a clip, with the first one expanding image contrast, and the second one using a variety of 
controls to add some extreme warmth to the highlights.

Before and after shots

If you decided that you want to reduce the amount of warmth added by the second node without 
readjusting the controls you used to create the effect, you could open the Key palette and lower the 
Key Output Gain parameter to fade the effect with a single adjustment.

Different key output gain can have a big influence

This principle also works for controlling the strength of individual nodes that are being combined in 
parallel, or that are combined using the Layer node.
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Isolating and Splitting Color Channels

Resolve provides two different methods of making channel-specific adjustments, depending 
on whether you need to apply an adjustment to just one channel within a single node, or apply 
separate adjustments to all three channels across several nodes.

Enabling and Disabling Individual Node Channels

Within the contextual menu of each node in the Node editor is a series of four options:

Disabling channels and switching color spaces

 > A Color Space submenu that lets you change the color space that node works in between RGB 
(the default red/green/blue), YUV (actually Y’/Cb/Cr), and HSL (Hue/Saturation/Lightness).

 > Three checked Enable Channel 1-3 options let you turn individual channels off or on, limiting 
which channels that node will affect.

In combination, these controls let you choose a color space for a node to work within, and then 
choose which channels of that color space you want to affect with that node’s adjustments. In the 
following example, you’ll see how to use these features to selectively sharpen just the Y’ (luma) of 
an image without affecting the chroma, which can be a more subtle effect than simply sharpening 
the entire image.
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To use channel disabling and color space conversion to sharpen luma only:

1. Add a node with which to apply the sharpening you want to the current clip.

2. Right-click the new node, and choose YUV from the Color Space submenu of the contextual 
menu.

3. Apply sharpening by doing one of the following:

 > Using that node’s contextual menu, uncheck Enable Channel 2 and Enable Channel 3, which 
correspond to the U (Cb) and V (Cr) channels, leaving only Channel 2 (Y) enabled. Then, 
open the Blur palette, and drag the ganged Radius sliders down to sharpen the Y channel.

 > You can also just open the Blur palette, ungang the Radius sliders, and drag the red 
slider down to sharpen the Y channel, since any control with three gangable sliders will 
automatically assign those sliders to whichever channels are used by the currently selected 
Color Space.

Before - The original image, After - Sharpening applied to only the Y’ channel of the image 

As you can see, while the Blur palette ordinarily provides separate R, G, and B controls that can be 
unganged from one another, the Color Space submenu lets you apply sharpening to the channel 
definitions of other colorspaces, providing many other corrective and creative possibilities with the 
same controls.

Splitter/Combiner

Another method of applying corrections to individual color channels is using the Splitter/Combiner 
nodes, which break the Red, Green, and Blue channels apart into separate node tree branches, 
each capable of accepting multiple serial and parallel nodes of image adjustment. There are two 
ways you can create a Splitter/Combiner node structure.

Methods of adding Splitter/Combiner nodes:

 > To add a pre-made Splitter/Combiner node structure: Choose Nodes > Add Splitter/
Combiner Nodes (Option-Y). A Splitter and Combiner node appear already connected to 
three corrector nodes, one for each color channel.
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 > To manually construct a Splitter/Combiner node structure: Right-click in any empty area 
of the Node Editor, and choose from the Add Node submenu to create a Splitter node, a 
Combiner node, and three Corrector nodes, wiring them together as necessary to create 
the desired effect.

The splitter combiner node structure

The Splitter node takes an incoming image and provides individual outputs for each color channel 
(top/red, middle/green, bottom/blue). When you connect each of these output to a corrector node, 
that color channel automatically connects to all three internal channels of that node, so that the 
default three nodes in a Splitter/Combiner structure are internally processing red/red/red, green/
green/green, blue/blue/blue. The Combiner then pulls the Red, Green, and Blue channels out of 
each node connected to its three inputs, and reassembles them into a single RGB image again. Of 
course, what happens in between the Splitter and Combiner is entirely up to you.

One of the simplest ways of showing the possibilities of this node structure is to combine it with 
Node Sizing in the Sizing palette. Using Node Sizing, you can correct for misaligned channels in older 
archived video, or create channel misalignments for creative looks. In the following example, a simple 
Node Sizing adjustment to a split Blue channel will create an interesting “prism vignette” effect.
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To use Node Sizing on individually split channels:

1. Choose Nodes > Add Splitter/Combiner Node (or press Option-Y) to add a pre-made Splitter/
Combiner node structure to the node editor.

2. Select the middle of the three corrector nodes appearing in between the Splitter and 
Combiner nodes (Node 5 in the following screenshot).

3. Open the Sizing palette, choose Node Sizing from the Mode pop-up, and then raise the zoom 
parameter by a small amount; this example uses 1.014. 

Zooming just one color channel using the splitter/combiner nodes

 As you can see in the screenshot, just the Green channel has been zoomed in on across the 
entire image. This is only possible using Node Sizing. This is cool, but not quite what you need.

4. Open the Window palette, add a Circular window, turn on its Invert control, and transform it to 
be a very soft, horizontally aligned vignette. This limits the individual scaling done to the Green 
channel to just the outer edge of the image, similar to a lens with excessive chromatic aberration.

The resulting channel split effect
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You could easily keep going, applying varying amounts of zoom with different window shapes to 
each of the other color channels, and perhaps adding some blur to enhance the effect, but this 
example should show the creative potential available when using this technique.

Compositing Using the Alpha Output

While DaVinci Resolve can use the alpha channel of imported media for compositing, the Alpha 
Output bar in the Node Editor is an optional output that you can turn on to create clip transparency 
using operations inside Resolve to create composites against other clips on lower video tracks.

There are many ways of using the Alpha Output, but this section will focus on two examples. In the 
first one, the Alpha Output will be used to composite a green screen clip with a background plate. 

In preparation for this composite, the background plate is on track V1 of the Timeline, and the green 
screen clip has been superimposed on track V2.

A green screen clip, ready for compositing

A superimposed green screen clip on track V2 of the Timeline, above a background plate on track V1, ready for compositing.
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To create a chroma-key composite:

1. Right-click anywhere within the gray area of the Node Editor and choose Add Alpha Output 
to add the Alpha Output bar at the left of the Node Graph.

 An Alpha Output bar appears underneath the Output bar at the right of the Node Editor.

The image Output bar with Alpha output bar below

2. Add a Serial node after Node 1 and connect its key output to the Alpha Output bar. This is a 
fast way to build this composite if you’re confident that the corrections you’ve made in Node 
1 won’t adversely affect the key (or if you know they’ll improve it by expanding the contrast of 
a flat-contrast source clip).

 Alternately, you could create a second processing branch by adding a disconnected node 
(Node 2), connecting the Source bar to its RGB input, and then connecting its key output to 
the Alpha Output bar you just added. Creating a second image processing branch from which 
to pull your key lets you key directly from the source, avoiding any problems that grading the 
first node could introduce to the key.

Node 1 grades the clip, expanding contrast to improve both the image, and its ability to be keyed.  

Node 2 uses Qualifier controls to pull the key.
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3. Use the Qualifier controls of Node 2 to key out the green background, and then turn on the 
Invert checkbox to create the proper composite. You can also use a Power Window to garbage 
matte out any elements you don’t want intruding into the shot.

4. If necessary, adjust the primary correction being applied in Node 1, and make whatever 
corrections are necessary to the background plate clip to make the composite blend more 
seamlessly.

If you’ve been provided with a separate Matte clip for defining clip transparency, you can use that 
Matte clip within the node tree of a superimposed clip to create a composite using the Alpha Output.

To create a composite using an external matte:

1. To associate an external matte with a clip, open the Media page, select the clip you want to 
add a matte to in the Media Pool, navigate to the matte file using the Library browser, and then 
right-click the matte file and choose Add as Matte. For more information on importing mattes, 
see Chapter 3, “Working in the Media Page.”

2. Open the Color page and select the foreground clip in the Thumbnail Timeline, then right-click 
Node 1 in the Node Editor and choose the matte you added from the Add Matte submenu.

 An EXT MATTE node appears underneath Node 1, with the first of its four key outputs 
connected to Node 1’s key input. (Working with external mattes is covered in more detail in a 
prior section of this chapter.)

The result, with a window garbage matte cropping out the equipment, ready for further refinement
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3. Now, right-click anywhere within the node graph (other then on a node) and choose Add 
Alpha Output from the contextual menu.

 An Alpha Output bar appears underneath the Output bar.

4. Drag a connection line from the second key output of the EXT MATTE node to the Alpha 
Output bar.

Using an external matte in the grade and to the Alpha output

 You should now see a successful composite, with the external matte creating a region of 
transparency in the foreground clip though which the background clip shows through.

Before and after the final composite, created by connecting an Ext Matte node to the Alpha Output in the node graph
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Keyframing

Whether it’s referred to as keyframing, dynamics, or marks, DaVinci Resolve provides an interface 
for automatically interpolating color adjustment parameters in various ways from one setting  
to another.

For example, if you have a clip with varying exposure settings, you can animate a series of contrast 
adjustments using Dynamic keyframes to make the changes in exposure less distracting. 

Keyframe palette

In another example, you can insert Static keyframes (marks) at the cut points of clips. These 
keyframes actually consist of multiple shots that are merged in a single piece of media to create 
individual adjustments for each shot, separated by a keyframe.

In both cases, you use the Keyframe Editor to create a series of keyframes with which to change 
parameters from one value to another. In this section, you’ll learn how to work with the Keyframe 
Editor to set up these kinds of animated changes.

White static keyframes on the Master and Node 1 track
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The Keyframe Editor Interface

The Keyframe Editor has all the controls necessary to create and modify keyframes for the currently 
selected clip.

Color page with a complex window and keyframe dynamics

The Keyframe Editor consists of the following components. 

 > The Timeline Ruler: Mirrors the record timecode of the currently selected clip; dragging 
within the Timeline Ruler moves the playhead, and a timecode display to the left shows the 
current frame.

 > The Keyframe Track Header: Each node in the current grade has a corresponding keyframe 
track, and the header contains controls you can use to manage the keyframing. 

Keyframe Track Header
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 > Track Disclosure Triangle: Exposes individually keyframable groups of parameters 
underneath the main keyframe track. 

 > Enable/Disable Button: A round orange button lets you enable or disable that track’s 
corresponding node. 

 > Lock Button: Lets you prevent any changes from being made to that track’s corresponding 
node.

 > Auto-Keyframe Button: Turn this button on to automatically create a Dynamic keyframe 
every time you adjust any parameter within that node.

 > Keyframe Tracks: To the right of the track header, the keyframe tracks are where you create 
and edit the keyframes that animate parameter changes. A topmost “master keyframe 
track” shows every keyframe applied on every keyframe track in the Keyframe Editor, even 
keyframes applied to a keyframing track hidden inside a track with a closed disclosure 
triangle.

 > Keyframes: Each keyframe appears as a small diamond for a Dynamic keyframe or as a 
circle for a Static keyframe. Dynamic keyframes are associated with dissolves while Static 
keyframes (marks) act instantly. Grades are linked to the preceding keyframe, which may be 
a default one on the first frame of the master clip. Keyframes can be selected by clicking on 
them, or moved by dragging them to another position in the keyframe track.

 > Sizing track: The Pan, Tilt, Zoom, Rotate, and Convergence (in Stereo 3D projects) parameter 
have an entirely separate track for creating animated pan and scan adjustments.

 > Track Selection Bar: A colored bar shows the currently selected scope of keyframing: all 
tracks at once, just the current correction node, or the Sizing settings. This will be covered 
in more detail later in this chapter.

Ordinarily, the Keyframe Editor takes up the rightmost bottom third of the Color page. However, you 
can make it wider to have more room to work if you have a scene requiring complex keyframing.

To expand and collapse the Keyframe Editor:

 > Click the Expand/Collapse button at the lower left-hand corner of the Keyframe Editor.  
The Keyframe Editor widens or narrows accordingly.

To zoom into and out of the Keyframe Tracks:

 > Use the zoom slider to zoom into or out of the Keyframe Editor.

 > Right-click any keyframe track and choose Maximum Zoom to zoom all the way in.

 > Right-click any keyframe track and choose Reset Zoom to fit the entire clip into the available 
width of the Keyframe Editor.
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All/Color/Sizing

Perhaps the most important control for keyframing, the Keyframe Timeline mode, lets you switch 
the scope of what tracks get keyframed when you use the Start Dynamic or Add Static Keyframe 
commands, either from the keyboard or via the buttons of your control surface. This command 
alternates among three modes:

 > All: The default mode. Adds keyframes to every track in the Keyframe Editor, keyframing 
every parameter in every node all at once, including the Sizing settings. In this mode, an 
orange bar appears highlighting the topmost “master keyframe track.”

 > Color: Only adds keyframes to the node currently selected in the Node Editor. In this mode, 
a green bar appears highlighting the keyframe track corresponding to the node currently 
selected.

 > Sizing: Only adds keyframes to the Sizing track, which is useful when you’re keyframing 
“pan and scan” style transforms. In this mode, a blue bar appears highlighting the Sizing 
track.

 > EXT MATTE: Only appears if there’s an External Matte node in the node tree. Lets you 
keyframe External Matte-specific parameters in the Key palette.

Even though All is the default setting, it may be to your advantage to switch to the Color or Sizing 
keyframing modes to avoid creating a lot of unnecessary keyframes. Even though keyframing 
everything all at once is a fast way to work, the extra keyframes may slow you down when you later 
need to make adjustments to nodes that didn’t need to be keyframed in the first place.

To change the keyframing mode, do one of the following:

 > Choose an option from the Mark > Keyframe Timeline Mode submenu.

 > Press the ALL/COLOR/Sizing button on the Transport panel of the DaVinci control surface 
repeatedly until you’ve chosen the mode you need.

Tip: This control has one other function. Choosing a mode also affects what gets copied when you 
use the various grade management tools in DaVinci Resolve. For example, if you choose Color, 
then you can copy a clip’s color grade without copying its sizing. If you choose Sizing, then you can 
copy the sizing without copying the color grade. For more information, see “Copying Grades” in 
Chapter 9.

Keyframing Methods

There are two different types of keyframes used by DaVinci Resolve to create automated changes. 
Each type of keyframe interpolates parameters differently.
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Dynamic Keyframes (Dynamics)

Dynamic keyframes are the most conventional type of keyframe you’ll use, and are the type of 
keyframe used for creating animated changes from one state to another. For example, if you need 
a grade to become brighter over time to compensate for a change in lighting conditions, you’ll use 
Dynamic keyframes.

Nearly every parameter and control in the Color page can be keyframed, but it’s important to 
understand that the Interface controls do not animate to match whatever dynamically keyframed 
changes are taking place. Instead, visible Interface controls that correspond to keyframed changes 
will jump from their initial position at one keyframe to their final position when the playhead reaches 
the next keyframe. 

This can be most confusing with Curves, which can be interpolated using Dynamic keyframes just 
like any other control or parameter. Just keep in mind that the actual settings are animating, even 
though the controls are not.

To animate a node using Dynamic keyframes:

1. Move the playhead in the Keyframe Editor’s Timeline ruler to the frame where you want to 
begin a change.

2. Do one of the following to place a Dynamic keyframe at that frame:

 >  Choose Mark > Make Dynamic Keyframe.

 >  Press the START DYNAMIC button on either the T-bar or Transport panels of the DaVinci 
control surface.

 Dynamic keyframes are green.

3. If necessary, adjust your clip at this first position of your animated change.

4. Now, move the playhead to the frame that is at the second position of the animated change 
you’re making, and create another Dynamic keyframe using the commands described in 
step 2.

5. After you’ve created this second keyframe, make whatever adjustments are necessary to the 
clip to create the final look you need.

 At this point, playing from the first keyframe to the second keyframe should show a smoothly 
animated change from the first adjustment to the second.
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Static Keyframes (Marks)

Static keyframes, or marks, are keyframes that are used to create abrupt, one frame changes from 
one state to another. They’re typically used to mark edit points separating one shot from another 
when multiple shots appear within a single clip. However, Static keyframes are also useful in any 
situation where you need a sudden change from one setting to another, such as when creating a 
lightning effect. 

To automate a node using Static keyframes:

1. Find the frame at which you want the abrupt change to take place, and place a keyframe at 
that frame by doing one of the following:

 >  Choose Mark > Make Static Keyframe.

 >  Press the MARK button on either the T-bar or Transport panels of the DaVinci control 
surface.

 Static keyframes (marks) are white.

2. Move the playhead to any frame before the keyframe to make changes to the entire segment 
of the clip leading up to the keyframe, or move the playhead to any frame after the keyframe 
to make changes to the entire segment of the clip appearing after the keyframe. The playhead 
does not need to be on top of the keyframe, but if it is, you’ll be adjusting the second portion 
of the clip.

Note: If you’re using Static keyframes to automate grading changes between multiple shots 
appearing within a single clip, keep in mind that you can’t add nodes from one keyframe to the next 
as you would if you had split the clip in the Edit page.

Dynamic keyframes are round
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Mixing and Converting Dynamic and Static Keyframes

Typically, if you’re creating multiple animated changes within a clip, you’ll want to use all Dynamic 
keyframes. Similarly, if you’re creating a series of abrupt changes, you’ll use all Static keyframes. 
However, you can mix Dynamic and Static keyframes together, so long as you keep in mind the 
following rules:

If you add a Dynamic keyframe to the right of a Static keyframe: There will be no interpolation from 
the Static keyframe to the Dynamic keyframe. However, if you add a Static keyframe to the right of 
a Dynamic keyframe, there will be interpolation.

If you accidentally create the wrong kind of keyframe, it’s easy to convert it into the type of keyframe 
you need.

To change one kind of keyframe into another:

1. Click the keyframe you want to convert to select it.

2. Right-click the selected keyframe, and choose either Change to Dynamic Keyframe or Change 
to Static Keyframe.

Try Creating Keyframed Changes in a Separate Node

One tip to keep in mind is that you don’t have to create keyframed changes within the same nodes 
you’re using to create other adjustments. If you want to create some automated changes without 
altering the nodes you’ve already adjusted, you can simply create a new node in which to make your 
keyframed changes. That way, if you don’t like the result, or you somehow find yourself hopelessly 
tangled up in a needlessly complicated set of keyframes, its easy to reset either just the keyframes 
or the entire node without affecting the rest of your grade.

No dynamic interpolation following the static keyframe
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Using Specific Keyframing Tracks

If you’re simply using the Color mode of the All/Color/Sizing command to do keyframing, then 
you’ll be adding keyframes to every parameter of the currently selected node whenever you apply 
a single keyframe. However, often that’s overkill in situations where you only need to keyframe a 
single setting or group of settings.

For example, you may find that you need to keyframe a color adjustment in order to change the 
color temperature and brightness when the camera pans across a window, but you don’t want to 
keyframe the Windows palette controls because you want to adjust them independently. This can 
be done by opening a Corrector track to expose the keyframing tracks within. 

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately from 
one another. For example, there’s one keyframing track for all the color adjustment parameters, and 
another keyframing track governing the parameters found within the Qualifier palette.

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately from 
one another. For example, there’s one keyframing track for all the color adjustment parameters, and 
another keyframing track governing the parameters found within the Qualifier palette.

To reveal a node’s keyframing tracks:

 > Click the disclosure triangle next to the number of the node you’re keyframing.

To keyframe an individual keyframing track manually:

1. Make whatever adjustments you need to the currently selected node, and click its disclosure 
triangle to reveal its keyframing tracks.

2. Move the playhead in the Keyframe Editor to where you want to add the first keyframe, then 
right-click within the keyframing track you want to animate, and choose Add Static Keyframe 
or Add Dynamic Keyframe (this example shows a Dynamic keyframe).

Individual keyframing tracks within a Color Corrector node
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 A keyframe appears at the position of the playhead in that keyframing track.

3. Move the playhead in the Keyframe Editor to where you want to add the next keyframe, then 
right-click within the keyframing track and again choose either Add Static Keyframe or Add 
Dynamic Keyframe (this example shows a Dynamic keyframe).

 Now, you can make whatever changes you need to the controls governed by the keyframing 
track you keyframed, in order to create the necessary animated effect.

Tip: You can also animate individual keyframing tracks using automatic keyframing, explained in 
more detail later in this chapter.

The Corrector Keyframing Tracks

All of the parameters governing the adjustment of color and contrast controls, as well as various 
effects, Power Windows, and other adjustments are sorted into various sub-tracks within the 
Corrector track.

 > Linear Win: Controls parameters corresponding to the Linear Window.

 > Circ Win: Controls parameters corresponding to the Circular Window.

 > Polygon Win: Controls parameters corresponding to the Polygon Window.

 > PowerCurve: Controls parameters corresponding to the PowerCurve Window.

 >Gradient Win: Controls parameters corresponding to the Gradient Window.

 > Color Corrector: Controls all parameters found in the Camera Raw, Color Wheels, Primary 
Controls, RGB Mixer, and Curves palettes.

 >Qualifier: Controls all parameters in the Qualifier palette.

 > Defocus: Controls all parameters in the Blur and Key palettes.

 >NR: Controls the Spatial and Temporal Noise Reduction and Motion Blur parameters found 
in the Motion Effects palette. 

Keyframing just the Circular Power Window using its individual keyframe track
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 >OFX: Controls all parameters of whichever OFX plugin is applied to the current node.

 >Node Format: Controls all parameters of the node sizing mode of the Sizing palette for the 
current node.

The Sizing Keyframing Tracks

The Sizing keyframing tracks govern sizing transforms and stereoscopic adjustments separately 
from the color controls.

 > Input Sizing: Controls the Input Sizing parameters found within the Sizing palette. 

 > Convergence: Controls the Convergence parameter in the Stereo 3D palette.

 > Float Window: Controls the Left, Right, Top, and Bottom Position/Rotate/Softness Floating 
Windows parameters.

 > Auto Align: Controls the Pitch and Yaw parameters in the Stereo 3D palette.

Tip: Output Sizing can only be keyframed when you choose Track mode in the Node Editor.

The Ext Matte Node’s Freeform Isolation Track

If your node tree has an External Matte, the EXT MATTE node exposes a Freeform Isolation track in 
the Keyframe Editor. This is useful for time offsets or Sizing repositioning of the Ext Matte image.

Automatic Keyframing

Every track in the Keyframe Editor has an Auto-Keyframing button that can be turned on or off. 
When auto-keyframing is enabled for a particular track, every change made to a parameter or 
control associated with that keyframe track automatically generates a keyframe.

Used with a keyframing track, auto-keyframing makes it simple to set up animated changes to 
specific adjustments within a node. This is a lot easier than manually placing keyframes one by one.

On the other hand, turning on auto-keyframing for the Corrector track correspondingly enables auto-
keyframing for every keyframing track belonging to that node. In this case, keyframes will automatically 
be placed on whatever keyframing track corresponds to the parameters or controls you adjust.

Auto-keyframing selected for Circular Window on Node 1
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When auto-keyframing is disabled, changes you make alter existing keyframes. How this alteration 
works depends on the location of the playhead, and the type of keyframes in the Keyframe Editor. 
For more information, see the next section.

Modifying Keyframes

Once you’ve started adding keyframes to animate changes to a grade, there are a variety of 
methods available to navigate and edit these keyframes to further customize these effects. This 
section covers the different ways you can navigate among, alter, and remove keyframes.

Navigating Among Keyframes

For many operations, it’s necessary to move the playhead directly on top of the keyframe you want 
to modify. While you can always use the transport controls or pointer to move the playhead, there 
are also commands for jumping to a specific keyframe.

To move the playhead among a series of keyframes, do one of the following:

 > Choose Playback > Next Keyframe (Option-Grave) or Playback > Previous Keyframe 
(Option-Semicolon).

 >On the Transport panel of the DaVinci control surface, press SHIFT then STEP REV to 
move the playhead to the previous keyframe, or press SHIFT then STEP FWD to move the 
playhead to the next keyframe.

Moving Keyframes

If you need to change the timing of a series of keyframes, you can move the position of any keyframe, 
along with whatever values that keyframe contains.

To move a keyframe using the on-screen interface:

 > Use the pointer to drag any keyframe to another location.

 > Drag keyframes in a Corrector or Sizing track to simultaneously move all other keyframes 
on the same frame within that corrector.

To move a keyframe using the DaVinci control surface LIFT MARK button:

1. Move the playhead to the keyframe you want to move. This procedure works for either Dynamic 
and Static keyframes.

2. Press LIFT MARK on either the T-bar or Transport panels.

3. Move the playhead to the frame you want to move that playhead to.

4. Press MARK on either the T-bar or Transport panels. 
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Changing Keyframe Values

Unlike many other applications, DaVinci Resolve lets you alter keyframe values when the playhead 
isn’t directly on an existing keyframe. How this works depends on the location of the playhead 
relative to the keyframes that are in the Keyframe Editor, and what kind of keyframes you’re editing.

 > If the playhead is to the left or on the first Dynamic keyframe: The Dynamic keyframe at or 
to the right of the playhead updates with the new adjusted values.

 > If the playhead is to the left or on the last Dynamic keyframe: The Dynamic keyframe at or 
to the left of the playhead updates with the new adjusted values.

 > If the playhead is between two Dynamic keyframes: The Dynamic keyframe to the left of 
the playhead updates with the new adjusted values, but the Dynamic keyframe to the right 
is unaffected.

 > If the playhead is between two Static keyframes (marks): Adjustments made between two 
Static keyframes always affect the keyframe to the left of the playhead. The entire segment 
of the clip between that keyframe and the next is affected equally.

Changing Dynamic Attributes

By default, the transition from one Dynamic keyframe to the next is linear. However, if you need to 
alter the acceleration of value interpolation from one Dynamic keyframe to the next, then you can 
change that keyframe’s Dynamic Attributes.

To change a keyframe’s Dynamic Attributes:

1. Right-click a keyframe in the Keyframe Editor, and choose Change Dynamic Attributes.

2. When the Dynamic Attributes window appears, do one or both of the following:

 > Choose a new outgoing acceleration curve using the Start slider, affecting the interpolation 
occurring to the right of that keyframe.

 > Choose a new incoming acceleration curve using the End slider, affecting the interpolation 
occurring to the left of that keyframe.
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 As you choose different acceleration curves, the display to the right shows the resulting  
curve graph.

3. When you’re happy with the curve, click OK.

By using different Start and End values, you can make animated adjustments “ease in” or “ease 
out” of a particular keyframe, to create a more gradual or abrupt transition.

Tip: The default dynamic profile start and end of each new keyframe can be set in the Editing and 
Ripple panel of the Project Settings.

Deleting Keyframes

You have the option to delete individual keyframes, or to delete all the keyframes within a particular 
grade at once.

To delete individual keyframes, do one of the following:

 >Move the playhead on top of the keyframe you want to delete, then choose Mark > Delete 
Keyframe. Every keyframe at the position of the playhead is deleted.

 > Using the DaVinci control surface, press DELETE on either the T-bar or Transport Panels. 
Every keyframe at the position of the playhead is deleted.

 > Using the pointer, click a keyframe in the Keyframe Editor to select it, then right-click that 
keyframe and choose Delete Selected Keyframe. Only the selected keyframe is deleted.

To delete every keyframe for the current clip:

 > Choose Mark > Delete All Keyframes.

Changing the dissolve profile



THE COLOR PAGE8

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

618

Copying Keyframes

It’s possible to copy a set of keyframes from one node to another, either within the current grade, 
or in another clip entirely.

To copy a set of keyframes from one node to another:

1. Select a node to copy keyframes from, and choose Edit > Copy (Command-C).

2. Select another node to paste keyframes to, and choose Edit > Paste (Command-V).

Tip: This procedure also works for tracking data that you want to copy from one node to another, 
either in the current clip, or another clip altogether.

Keyframes and Saved Stills

If you save a still from a clip using keyframes within the grade, the keyframes are not saved. However, 
the still and grade that are saved reflect whatever parameter values were at the position of the 
playhead. 

For example, if a clip has a dynamically keyframed transition from a saturation of 50 to a saturation 
of 0, and you place the playhead right in the middle of both keyframes when you save a still, the 
grade and still that are saved have a saturation of 25.

Adding EDL Marks

Just as clip grades are separate from the track grade that can be applied to the entire timeline, so 
clip keyframes are separate from track keyframes. Keyframes you apply to the track grade work 
exactly the same as clip keyframes. However, there is one extra option you have when keyframing 
the track grade.

If you find yourself wanting to adjust a track grade individually to take into account variations from 
one clip to the next, you can use the Add EDL Marks on Tracks command to add a Static keyframe 
(mark) to the Keyframe Editor at the position of every edit point in the entire Timeline.

To add EDL Marks:

1. Choose Track from the Node Editor’s mode pop-up menu.

2. If you want to keyframe a grade, then create whatever grade you need to apply to the entire 
Timeline. If you want to keyframe Sizing settings, you don’t need to do anything else.

3. Right-click the Corrector track or the Sizing track in the Keyframe Editor, and choose Add EDL 
Marks on Tracks.

 Marks appear at the frame of every edit point in the Timeline. You may want to widen the 
Keyframe Editor to make it easier to work with all these keyframes.
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After you’ve added EDL marks, you can delete them if you decide you don’t want them any more.

To delete EDL marks:

 > Right-click the Corrector track in the Keyframe Editor, and choose Add EDL Marks on 
Tracks.

If you’ve added your own keyframes in addition to the EDL marks, then the Delete EDL Marks on 
Tracks command only eliminates the EDL marks. Your custom marks are left alone.
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The interactive Dirt and Dust Removal tool provides an interface for dustbusting right from within 
DaVinci Resolve. This is a raster-based effect, and results in a duplicate set of “dustbusted” media 
being created within a hidden subdirectory. 

If, at any point, you’re unsatisfied with the adjustment you’ve made, you need only use the Undo 
command to return the clip you’re working on to its prior state.

Note: The Dirt and Dust Removal tool only works with DPX image sequences. Media in a raw, ProRes, 
or DNxHD format must first be converted to a DPX image sequence before it can be operated on 
with this tool.

To use the Dirt and Dust Removal tool:

 > Click the Onscreen Control pop-up menu at the bottom left of the Viewer, and choose  
Dust Removal.

Selecting the Dirt and Dust tool in the viewer OSD menu

To open the Dirt and Dust Removal tool setup options:

 > Right-click the Dirt and Dust Removal icon showing in the Onscreen Control pop-up to 
open the setup window.

Dirt & ROI Settings Parameters

In the Dirt & ROI Settings window, there are a number of parameters that you can use to optimize 
this tool for the particular problem you’re trying to solve.

 > Algorithm: The Algorithm pop-up menu lets you select the method of filtration to use when 
painting out dirt or dust. Different options provide different methods for replacing the 
problem pixels with image data copied from other frames in time, or from other regions of 
the current frame. You’ll want to choose an option that works best for the type of camera 
and subject motion happening within the clip you need to clean. For more information on 
the advantages of each algorithm, see the next section.

Dust Removal
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 > Aggression: Increase or decrease the Aggression and Blend sliders depending on the 
degree of correction you want to apply.

 > Blend: Sets the % of the original image to be feathered at the edges of the repair.

 >Optimize: Turning this option on provides better-looking results, at the expense of increased 
processing time.

 > ROI Mode: Determines whether a correction is applied with a single click, or via a paint 
stroke. There are three options.

 >Click and Clean: Applies a correction with one click, and is fast to use on small dust spots. 

 > Draw and Clean: Lets you “paint” over a larger dirty area with the mouse or a pen, with 
the correction being applied at the conclusion of your paint stroke.

 > Cnc Size: Defines the width of the “brush” that’s used to paint out dirt and dust.

Algorithms for Dirt and Dust Removal

There are six algorithms you can choose from that determine how the pixels you paint over are 
automatically replaced.

 > Auto-temporal –/+ 1: When an ROI is drawn, the previous frame, the next frame and the 
current frame will all be used for analysis. The best of these 3 will be automatically selected 
and used for removing the dirt in the current frame.

 > Auto-temporal –/+ 2: This is the same as the above, but the frames used instead are the 
current frame, previous-to-previous frame (i.e., 2 frames back), and next-to-next frame (i.e., 
2 frames forward). Therefore, if the ROI is drawn on frame 100, frame 98, frame 100 and 
frame 102 will be used for analysis. The best of these 3 will be used for removing the dirt 
in the current frame. The advantage of this selection is that it will avoid the appearance of 
frozen grain, which may be possible in case of dirt against a stationary background.

 > Temporal –/+ 1: if the ROI is drawn by dragging the mouse from left to right, the next frame 
will be used for motion-compensated dirt removal. If the ROI is drawn by dragging the 
mouse from right to left, the previous frame will be used.

 > Temporal –/+ 2: if the ROI is drawn by dragging the mouse from left to right, the next-
to-next frame will be used for motion-compensated dirt removal. If the ROI is drawn by 
dragging the mouse from right to left, the previous-to previous frame will be used.

 > Spatial: In case of fast or blurred motion, using the previous or next frames may give 
unsatisfactory results. In this case, the same frame itself can be used for removing the dirt. 
This will use surrounding information in the current frame to remove the dirt.

 >Median: The Median filter performs a blending of the pixels, smoothing out the region. Use 
this when other options do not replace the image, or when there is no support information 
in which to reconstruct the original. Using small boxes will produce better results.
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The Color page has another mode available to aid you in using DaVinci Resolve in on-set grading 
workflows. Turning the Resolve Live option on puts Resolve into a live grading mode, in which an 
incoming video signal from a camera can be monitored and graded during a shoot.

Resolve Live has been designed to let you use all of the features of DaVinci Resolve to grade these 
on-set video previews, in the process saving video snapshots that contain a captured image, your 
grade, and reference timecode from the camera. The idea is that, using Resolve Live, you can 
work with the cinematographer to develop looks and test lighting schemes on the footage being 
captured during the shoot, and then later you can use those looks to build dailies, and as a starting 
point for the final grade once the edit has been completed.

Additionally, you can use Resolve Live in conjunction with other Color page features such as the 
Alpha Output to build test composites to check green screen shots, comparing them against 
imported background images in order to aid camera positioning and lighting adjustments. The 
built-in video scopes can also be used to monitor the signal levels of incoming video. Finally, you 
can use 1D and 3D LUTs to monitor and grade log-encoded media coming off the camera.

Configuring Your System for Resolve Live

Setting up Resolve Live is straightforward. Whether you’re using a tower workstation or a laptop, 
any of the Blackmagic Design Decklink or UltraStudio video interfaces can be used to connect your 
DaVinci Resolve workstation to a camera and external video display. The important thing to keep in 
mind is that, if you want to connect to a live incoming signal and output that signal for monitoring at 
the same time, you need to either use two separate Decklink PCIe cards or UltraStudio ThunderBolt 
interfaces, or a single Decklink Duo or Decklink Studio card with multiple separate inputs and 
outputs on a single PCIe card.

The Preferences window has a Video I/O and GPU panel that provides two sets of options for 
configuring video interfaces connected to your computer, one for capture and playback, and one 
for Resolve Live input. If you only have a single video interface, you can only do one or the other. If 
you have two interfaces, then you can use these options to use one interface for playback, and the 
other interface for Resolve Live.

Resolve Live
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Screenshot of preferences

During the shoot, the digital cinema camera in use needs to be connected to your DaVinci Resolve 
workstation via HD-SDI, which must be configured to carry both the video image and timecode that 
mirrors the timecode being written to each recorded clip. Most cameras allow timecode output over 
HD-SDI, and both Decklink and UltraStudio interfaces can pass this timecode to Resolve. Without 
a proper timecode reference, you won’t be able to take the shortcut of automatically syncing your 
saved Snapshots to recorded camera original media using ColorTrace, although you can always 
apply grades manually.

If you’re shooting with any of the Blackmagic Design cameras, you also have the option of connecting 
the camera directly to your Resolve Live workstation using Thunderbolt, eliminating the need for a 
second video interface. In this configuration, Thunderbolt carries both video and timecode for easy 
capture by Resolve.

Grading Live

Once your camera and computer are appropriately connected and configured, using Resolve Live 
is straightforward. This section describes the live grading workflow as it was designed to be used. 
Once you’re familiar with the capabilities of Resolve Live, you may find your own ways of working 
that are more in tune to the needs of your particular project.
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Getting Started

When working with Resolve Live on a new shoot, you should begin with an empty project and a 
new empty timeline, since the live grading workflow involves capturing live graded snapshots to an 
otherwise unoccupied timeline. One recommended way of organizing the livegrades of a shoot is 
to create one new project per day of shooting. This way, snapshots captured during shoots using all 
24 hours of time-of-day timecode won’t conflict with one another. Also, separate projects can make 
it easier to use ColorTrace to copy grades from your live grade snapshots to the camera original 
media you’ll be creating dailies from, eventually.

Tip: Having an empty Media Pool and timeline doesn’t mean you can’t install useful LUTs and pre-
import reference stills and saved grades to the Gallery, as these can be valuable tools for expediting 
your on-set grading.

Once you’ve created your new project, you also need to choose the disk where all snapshots you 
take will be saved. By default, snapshots are saved on the scratch disk at the top of the Scratch Disks 
list in the Media Storage panel of the Preferences window. They’re automatically saved in a folder 
named identically to the current project.

Going Live

Once you’ve created your day’s project, you need to turn on Resolve Live to begin work.

To turn on Resolve Live:

1. Open the Color page.

2. Choose Color > Resolve Live On/Off (Command-R).

 A red Resolve Live badge at the top of the Viewer indicates that Resolve Live is turned on, and 
the transport controls are replaced by the Freeze and Snapshot buttons.

A red badge shows that Resolve Live is active
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At this point, the video from the connected camera should become visible within the viewer, 
the camera timecode should be displayed in the Viewer’s timecode window, and you can begin 
using all of the capabilities of the Color page to begin grading whatever is onscreen, including 
Gallery split-screens for matching and comparing. The current color adjustments in all palettes are 
automatically applied to both the image in the Viewer and the video output to an external display 
(if there is one). 

While Resolve Live is on, much of Resolve’s non-grading functionality is disabled, so when you’re 
finished, be sure to turn Resolve Live off.

To turn off Resolve Live, do one of the following:

 > Click the Exit button at the bottom left-hand corner of the Viewer.

 > Choose Color > Resolve Live On/Off (Command-R).

Using Freeze

In Resolve Live mode, the Freeze button (it looks like a snowflake) freezes the current incoming video 
frame, so you can grade it without being distracted by motion occurring during the shoot. When 
you’ve made the adjustment you need, you can unfreeze playback in preparation for grabbing a 
snapshot.

To freeze incoming video:

 > Click the Freeze button (that looks like a snowflake).

Using Snapshot

Once you’re happy with a grade, clicking the Snapshot button save a snapshot of the current still in 
the Viewer, the incoming timecode value, and your grade into the Timeline. Snapshots are simply 
one-frame clips. They use grades and versions just like any other clip. In fact, ultimately there’s no 
difference between the timeline created by a Resolve Live session and any other timeline, other 
then that the Resolve Live timeline only has a series of one frame clips, which appear in the timeline 
of the Edit page as s series of 1-frame stills.

To save a Snapshot, do one of the following:

 > Click the snapshot button (with a camera icon).

 > Choose Color > Resolve Live Snapshot (Command-Option-R).

For example, you may begin the process of building and refining a grade for a particular scene 
during an unrecorded run-through. Then, once shooting starts, you may take snapshots of each 
shot’s slate, and then of significant takes that follow, tweaking where necessary and in conjunction 
with the DP’s feedback once things get going. New camera setups may require further tweaks, 
which you’ll save as snapshots for those shots, and as you work in this way you’ll find yourself building 
up a timeline of snapshots that correspond to that day’s shoot.
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As you work, keep in mind that you must temporarily turn Resolve Live off in order to open a grade 
from a previous snapshot in the timeline, in order to use it as a starting point for another shot. You 
can also save grades into the Gallery.

Using Resolve Live Grades Later

Since each Snapshot you capture during a Resolve Live session contains timecode that was captured 
from the camera, grades from snapshots with timecode that overlaps recorded camera original 
media can be synced using ColorTrace when the time comes to start making dailies.

Keep in mind that snapshot grades correspond to the monitored output of the camera during the 
shoot. If you shot using a raw format, you’ll need to use whatever in-camera debayering settings 
were used for monitoring during the shoot if you want the grades from your snapshots to produce 
the same result.

For more information on using ColorTrace, see Chapter 6, “Conforming Projects.”

Using LUTs in Resolve Live Workflows

Many on-set workflows use Look Up Tables (LUTs) to calibrate displays, normalize log-encoded 
media for monitoring, and preview looks in the video village to test how the current lighting scheme 
will work with the intended grade. You can apply LUTs using the Look Up Table panel of the Settings 
window, or within a grade as part of a node tree.

However, you can also export LUTs, if necessary for monitor previewing, using an HDLink connected 
in-between the camera’s video output and a display, or using a display capable of loading LUTs 
internally.

If you’re exporting LUTs using the Generate 3D LUT command of the thumbnail timeline’s contextual 
menu, you should limit yourself to using only Primaries palette and Custom Curves palette controls 
within a single node. These are the only grading controls that can be mathematically converted 
into a LUT. For more information on exporting LUTs, see “Exporting Grades and LUTs” in Chapter 
9, “Gallery.”

Note: DaVinci Resolve exports LUTs in the .cube and .cube_shaperlut formats. Both are DaVinci-
developed LUT formats, with no relation to the Iridas SpeedGrade .cube format.


